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1 简介

1.1 本操作指南的目的
本操作指南旨在介绍 VLT® Integrated Servo Drive ISD 510/DSD 510 系统。

本操作系统包含有关以下方面的信息：

安装

调试

Programming

运行

故障排查

保养和维护

本操作指南适用于具备相应资质的人员。请完整阅读本操作指南，保证安全且专业地使用伺服系统，特别注意安全说明和一般
性警告。

本操作指南是伺服系统不可或缺的一部分，其中还包含重要的维护信息。因此，务必妥善保管本操作指南，以便使用伺服系统
时随时可查。

遵守本手册中的信息是下列事项的前提条件：

无故障运行

产品责任索赔确认

因此，在开始使用 VLT® Integrated Servo Drive ISD 510/DSD 510 系统之前必须阅读本操作指南。

1.2 其他资源

表 1: 其他资源

手册 说明

VLT® Integrated Servo Drive 系统 ISD 510、DSD 510
操作手册

有关 ISD 510/DSD 510 伺服系统的安装、调试和操作的信息。

VLT® Servo Drive System ISD 510, DSD 510, MSD 510
(VLT® Flexmotionô ) 设计指南

有关 ISD 510/DSD 510 伺服系统的设置的信息和详细技术数据。

VLT® Servo Drive System ISD 510, DSD 510, MSD 510
(VLT® Flexmotionô ) 编程指南

有关 ISD 510、DSD 510 和 MSD 510 伺服系统编程的信息。

1.3 版权所有
VLTÆ 和 ISDÆ 是 Danfoss 的注册商标。

1.4 批准和认证
VLT® Servo Drive Systems ISD 510、DSD 510、MSD 510 符合表 2 详细列出的标准和指令。

表 2: 产品和系统批准和认证

认证 说明

IEC/EN 61800-3 可调速电力传动系统。

第 3 部分： EMC 要求和特定测试方法。

IEC/EN 61800-5-1 可调速电力传动系统。

第 5-1 部分： 安全要求 - 电、热和能量。

IEC/EN 61800-5-2 可调速电力传动系统。

第 5-2 部分： 安全要求 - 功能。

IEC/EN 61508-1 电气/电子/可编程电子安全相关系统的功能安全。
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认证 说明

第 1 部分： 一般要求。

IEC/EN 61508-2 电气/电子/可编程电子安全相关系统的功能安全。

第 2 部分： 电气/电子/可编程电子安全相关系统的要求。

EN ISO 13849-1 机械安全 - 控制系统安全相关部件。

第 1 部分： 一般设计原则。

EN ISO 13849-2 机械安全 - 控制系统安全相关部件。

第 2 部分： 验证。

IEC/EN 60204-1 机械安全 - 机械电气设备。

第 1 部分： 一般要求。

IEC/EN 62061 机械安全 - 电气、电子和可编程电子控制系统的安全相关的功能安全。

IEC/EN 61326-3-1 用于测量、控制和实验室使用的电气设备 – EMC 要求。

第 3-1 部分： 与安全相关的系统和用于执行安全相关功能（功能安全）的设备的抗扰性要求 - 一
般工业应用。

IEC/EN 60529 机箱提供的防护等级（IP 代码）。

UL 508C 电力转换设备安全性的 UL 标准。

（仅适用于 ISD 510 伺服驱动器规格 1 和 2。）

UL 61800-5-1 可调速电力传动系统。

第 5-1 部分： 安全要求 - 电、热和能量。

ISD 510 伺服驱动器规格 3 和 4 以及 DSD 510：

MSD 510：

CSA C22.2 No.
274-13 (2013)

规定变速驱动器电气、热和能量安全考虑事项方面要求的标准。

适用于 ISD 510 规格 1 和 2。

CSA C22.2 No.
274-17 (2017)

规定变速驱动器电气、热和能量安全考虑事项方面要求的标准。

适用于：

ISD 510 规格 3 和 4

DSD 510

MSD 510

CE

2014/30/EU 电磁兼容性 (EMC) 指令。

2014/35/EU 低电压指令 (LVD)。
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认证 说明

(2011/65/EU) 未修
订 (EU) 2015/863

有害物质限制 (RoHS)。

2006/42/EC 机械指令 (MD)。

EtherCATÆ 用于控制自动化技术的以太网。基于以太网的现场总线系统。

以太网 POWERLINKÆ 基于以太网的现场总线系统。

PROFINET RT/IRTÆ 基于以太网的现场总线系统。

PLCopenÆ 技术规格。运动控制功能块（以前称为第 1 部分和第 2 部分），版本 2.0，2011 年 3 月 17 日。

1.5 固件更新
固件更新，可使用 VLTÆ Servo Toolbox 软件和 PLC 库。有可用更新时，即可从 Danfoss 网站 (http://

drives.danfoss.com) 下载。使用 VLTÆ Servo Toolbox 软件或 PLC 库在伺服驱动器或 PSM 510 和 DAM 510 上安装固件。

1.6 术语

表 3: 术语

术语 说明

ACM 510 辅助电容器模块

DAM 510 通过混合电缆将 Danfoss 分布式伺服驱动器（ISD 510 和 DSD 510）连接到伺服系统的分布式访问模
块。

DSD 510 分布式伺服驱动器

DSD 510 系统组件 包括 DSD 510 伺服驱动器、PSM 510、DAM 510 和可选的 ACM 510 和 EXM 510。

EXM 510 用于将系统模块分到 2 个控制柜中的扩展模块。

馈电电缆 用于从 DAM 510 连接到第一个伺服驱动器的混合电缆。

ISD 510 集成伺服驱动器

ISD 510 系统组件 包括 ISD 510 伺服驱动器、PSM 510、DAM 510 和可选的 ACM 510 和 EXM 510。

LCP 本地控制面板

环路电缆 用于按菊花链式连接伺服驱动器的混合电缆。

PLC 可编程逻辑控制器（用于控制伺服系统的外部设备）。

PSM 510 生成 565–680 V 直流电源的电源模块。

系统模块 包括 PSM 510、DAM 510 和可选的 ACM 510。

VIN PSM PSM 510 (V AC) 的输入。

VOUT PSM PSM 510 (V DC) 的输出。
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2 安全性

2.1 安全符号
本指南使用了下述符号：

警 告
表明某种潜在危险情况，将可能导致死亡或严重伤害。

注 意
表明某种潜在危险情况，将可能导致轻度或中度伤害。这还用于防范不安全的行为。

注 意
表示重要信息，包括可能导致设备或财产损坏的情况。

2.2 重要安全警告
以下安全说明和注意事项与 ISD 510/DSD 510 伺服系统相关。开始以任何方式使用伺服系统或其组件前，请仔细阅读安全说
明。特别注意本手册相关章节中的安全说明。

警 告
危险情况

如果 ISD 510/DSD 510 系统组件或总线线路错误连接，则存在死亡、严重伤害或设备损坏的风险。

务必遵守本手册中的说明以及国家和地方安全规定。

警 告
高电压

该伺服系统包含连接到电网后在高电压下运行的组件。这些组件上没有指示灯来指示是否已通电。错误安装、调试或维护可

能导致严重伤亡。

安装、调试和维护只能由具备相应资质的人员执行。

警 告
漏电/接地电流危险

漏电/接地电流超过 3.5 mA。ISD 510/DSD 510 伺服驱动器和系统模块错误接地可能会导致严重伤亡。

为了保护操作人员的安全，请按照适用的地方和国家电气标准和指令以及本手册中的操作说明，由经认证的电气安装员
将系统正确接地。

警 告
放电时间

伺服系统包含直流回路电容器，该电容器在电源模块 (PSM 510) 的主电源关闭后保持充电一段时间。如果切断电源后在规定

的时间结束之前就执行维护或修理作业，可能导致死亡或严重伤害。

为避免电击，将电源模块 (PSM 510) 与主电源完全断开，并等待电容器完全放电后，再在伺服系统或其组件上执行任何
维护或维修工作。

昀短等待时间（分钟）

15
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危 险

Risque du choc électrique. Une tension dangereuse peut être présentée jusqu’à 15 min après avoir coupé
l’alimentation.

警 告
意外启动

伺服系统包含连接到电网的伺服驱动器、PSM 510 和 DAM 510，可随时开始运行。这可能由现场总线命令、参考值信号或消

除故障状态的操作引发。伺服驱动器和所有连接的设备都必须具有良好运行状况。将设备连接到电网后，存在缺陷的运行状

况可能导致死亡、严重伤害、设备损坏或其他实质性损坏。

采取适合措施防止意外启动。

警 告
意外运动

立即执行参数更改时，可能会出现意外运动，从而导致严重伤亡或设备损坏。

更改参数时，采取适合措施以确保意外运动不会导致任何危险。

注 意
灼伤危险

在工作期间，伺服驱动器的表面温度可能达到 90˚C 以上。

在伺服驱动器冷却之前，请勿触摸。

注 意
RCD 兼容性

伺服系统包含可导致保护性接地导体中出现直流电流的组件，这可能会导致连接到该系统的任何设备出现故障。

在直接或间接接触情况下，如果使用漏电保护 (RCD) 或监控 (RCM) 装置来提供保护，则在系统组件的电源侧使用 B
型 RCD 或 RCM 装置。

注 意
连接/断开混合电缆

当伺服系统连接到主电源或辅助电源，或者电压仍然存在时，切勿将混合电缆连接到伺服驱动器，也不得从伺服驱动器断开

混合电缆， 否则可能损坏电子线路。确保主电源断开，经过了直流回路电容器的所需放电时间，然后断开或连接 PSM 510

和混合电缆。

为避免电击，先将 PSM 510 与主电源完全断开，走完放电时间，之后才能在 PSM 510 上进行电缆或混合电缆的连接或
断开连接操作。

2.3 安全说明和预防措施
必须始终遵循安全说明并采取预防措施。

要实现伺服系统及其组件的无故障和安全运行，必须保证正确有序的运输、存放、安装以及仔细操作和维护。

只有经过相关培训且具备相应资质的人员才能在伺服系统及其组件上或其附近进行操作。

只能使用经 Danfoss 批准的附件和备件。

遵循指定的环境条件。

本手册中有关使用可用组件的信息全部通过应用示例和建议来提供。

设备工程师或系统工程师个人负责检查提供的组件的适用性，本手册中针对特定应用提供的信息涉及：

遵守与特定应用相关的安全法规和标准。

采取必要的措施以及实施更改和扩展。
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在确定要将伺服系统或其组件安装到的机器、系统或工厂符合适用于使用国的应用的法定条款、安全法规和标准之前，不
允许对它们进行调试。

仅在符合相关应用的国家 EMC 法规时才允许操作。

遵循国家规范指定的限值是设备、系统或机器生产商的责任。

必须遵守本手册中的规格、连接条件和安装条件。

必须遵守使用设备时所在国家的安全法规和安全条款。

为防止用户遭受电击和伺服系统过载，必须进行保护接地，且必须按照地方和国家法规来执行。

2.3.1 操作安全
操作安全

仅当本手册中明确无误地提到与安全相关的应用时，才允许使用它们。

会导致人身伤害或财产损坏的所有应用都是与安全相关的应用。

在 PLC 软件中实施的停止功能不会中断电源模块 (PSM 510) 的市电电源。因此，不得使用它们来保证伺服系统的电气安
全。

伺服系统可通过软件命令或零速设置点停止，但是，伺服驱动器上仍存在直流电压和/或 PSM 510 中存在电源电压。而且，
当系统停止后，如果电路存在缺陷或临时过载状况消失后、电源电压存在问题或系统存在问题，则它可能自动再次启动。
如果出于人身安全方面（例如，在意外启动之后因接触运转中的机器部件而造成人身伤害的风险）的考虑，而必须保证不
会发生意外启动，这些停止功能是不够的。在此情况下，确保伺服系统与电网断开，防止电机意外启动，例如通过使用
Safe Torque Off 功能。

在参数配置或编程过程中，伺服系统可能会意外开始运行。如果这样会导致人身安全风险（例如，由于接触正在移动的机
器部件而造成人身伤害的风险），则需防止电机意外启动，例如通过使用 Safe Torque Off 功能或安全断开伺服驱动器。

除了 PSM 510 上的 L1、L2 和 L3 电源电压输入外，伺服系统还具有其他电源电压输入，包括外部辅助电压。在开始执行
修理工作前，请检查以确保所有电源电压输入已关闭，且直流回路电容器所需的放电时间已经过去。

2.4 具备资质的人员
安装、调试和维护只能由具备相应资质的人员执行。对于本手册和本手册中的安全说明而言，具备资质的人员是指经过培训且
经授权按照安全技术标准安装和调试设备、系统和电路并对它们进行接地和标记且熟悉自动化工程的安全概念的人员。

此外，该人员还必须熟悉本文档中所述的所有说明和安全措施。这些人员必须具有合适的安全装备，并经过急救培训。

2.5 尽职事项
操作员和/或装配工必须确保：

只按预期方式使用伺服系统及其组件。

只在理想工作条件下运行组件。

本操作手册始终放置在伺服系统附近，而且应完整且可读。

伺服系统及其组件的装配、安装、调试和维护只能由具备相应资质且获得授权的人员执行。

定期就职业安全和环境保护的所有相关事项，以及本操作手册的内容和其中的操作说明，对这些人员进行指导。

组件上的产品标识和识别标牌以及安全和警告说明没有去除，并始终保持清晰可读。

遵守与机器和设备控制有关的在伺服系统使用地适用的国家和国际法规。

用户始终掌握与他们在伺服系统及其使用和运行方面的利益相关的所有昀新信息。

2.6 预期用途
伺服系统的组件适用于按照当地法律和标准安装在工业环境中所用的机器中。

注 意

在家庭环境中，该产品可能会导致无线电干扰，此时可能需要采取补充抑制措施。

为确保按预期用途使用产品，使用前必须满足以下条件：

无论以何种方式使用 Danfoss 产品，所有操作人员都必须阅读并理解相应的安全法规和有关预期用途的说明。

请勿更改硬件的初始状态。

请勿对软件产品进行反向工程或更改它们的源代码。
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请勿安装或操作损坏或出现故障的产品。

确保按照文档中提到的法规安装产品。

遵循所有规定的维护和保养间隔。

采取所有保护措施。

仅安装本操作指南中所述的组件。仅当向 Danfoss 咨询后，才能使用第三方装置和设备。

2.6.1 禁止应用区域
不可在以下应用区域中使用该伺服系统：

存在潜在爆炸性环境的区域。

移动或便携式系统。

浮动或机载系统。

住宅。

存在放射性材料的地点。

存在极端温度变化或可能超过昀高额定温度的区域。

水下。

2.7 可预测的误用
未经 Danfoss 明确许可的任何使用均属于错误使用。不遵守指定运行条件和应用的行为同样属于错误使用。对于错误使用造
成的任何损失，Danfoss 不承担任何种类的责任。

2.8 服务和支持
如需服务和支持，请与当地的服务代表联系。
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3 系统描述

3.1 ISD 510/DSD 510 系统概览

AC 400–480 V . . .

ISD 510

UDC + Real-Time Ethernet Bus + STO + UAUX

UDC + Real-Time Ethernet Bus + STO + UAUX

DSD 510

. . .

Status

Hand
On

Off ResetAuto
On

OK

Back Cancel
Info

Quick
Menu

Main
Menu

Alarm
Log

LCP

PSM 
510

DAM 
510

DAM 
510

STATUS PSM

LINK/ACT

DEV

SVS ST

NET ST

X1

X2

STATUS DAM

LINK/ACT

DEV

SVS ST

NET ST

AUX

X1

X2

X3

STATUS DAM

LINK/ACT

DEV

SVS ST

NET ST

AUX

X1

X2

X3

PLC

e3
0b

g7
96

.1
0

1

24/48 V
STO

Real-Time Ethernet Bus + STO

图解 1: VLT® Integrated Servo Drive ISD 510/DSD 510 系统概览

1 交流线路电抗器

VLTÆ Servo Drive System ISD 510/DSD 510 是一种高性能分布式伺服运动解决方案。在此分布式系统中，ISD 510/DSD 510

伺服驱动器在直流组中运行，由 PLC 控制。驱动单元的分布式配置有利于系统的组装、安装和操作。

混合电缆用于连接 ISD 510/DSD 510 伺服驱动器，让安装变得快速简单。这些混合电缆包括直流回路电源、实时以太网、UAUX
和 STO 信号。

ISD 510/DSD 510 系统用于容纳各种伺服驱动器，由以下内容组成：

VLTÆ Integrated Servo Drive ISDÆ 510。

VLTÆ Decentral Servo Drive DSD 510。

中心电源： 电源模块 (PSM 510)。

分布式访问模块 (DAM 510)。

辅助电容器模块 (ACM 510)，可选

扩展模块 (EXM 510)，可选

接线结构。
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盲盖

软件

伺服驱动器的固件

PSM 510、DAM 510 和 ACM 510 的固件

PC 软件工具： VLTÆ Servo Toolbox

PLC 库

用于 AutomationStudioô  的 ISD 510/DSD 510 系统的 DanfossMotion 库。

用于 TwinCATÆ 2 和 3 的 ISD 510/DSD 510 系统的 DanfossMotion 库。

用于 SIMOTION SCOUTÆ 和 TiA Portal 的 ISD 510/DSD 510 系统的 DanfossMotion 库。

系统模块 PSM 510、DAM 510 和 ACM 510 安装在控制柜背板上。直流回路和控制线电源集成在该背板中。“click and lock”
背板概念使安装变得非常简单。

ISD 510 伺服驱动器为独立式分布驱动器，因此驱动器电子元件与电机位于同一个箱体中。DSD 510 伺服驱动器为分布式伺服
驱动器，靠近伺服电机安装。

ISD 510/DSD 510 伺服驱动器有 2 个版本：

版本 ISD 510/DSD 510

标准 2 个混合连接器 (M23)，用于连接来自混合电缆的电源和通信信号。

高级 标准版本加上 3 个附加接口，用于外部编码器或 I/O、现场总线设备，以及直接连接的本地控制面板 (LCP)。

运动控制集成至伺服驱动器中，以便单独进行运动序列。这样会减少中央 PLC 所需的计算功率，提供高度灵活的驱动概念。
Danfoss 为各种 IEC 61131-3 可编程 PLC 提供库。由于这些设备的标准化和认证现场总线接口，可以使用符合这些标准的、
带有 EtherCATÆ 主站功能、以太网 POWERLINKÆ 或 PROFINETÆ 管理节点功能的任何 PLC。

注 意

如果不更改接线结构，ISD 510/DSD 510 伺服驱动器则不能在其他制造商提供的伺服系统中使用。

使用 Danfoss 混合电缆时，其他制造商提供的驱动器不能在 ISD 510/DSD 510 系统中使用。

规格 1 和 2 ISD 510 伺服驱动器不能与规格 3 和 4 ISD 510 伺服驱动器以及 DSD 510 伺服驱动器组合在同一个线
路上。

只能安装本手册中描述的组件。仅当向 Danfoss 咨询后，才能使用第三方装置和设备。

请联系 Danfoss 了解详情。

3.1.1 应用示例
根据以下示例，伺服系统有许多潜在的应用领域。

饮料设备

贴标

压盖

灌装

PET 吹塑

瓶子数字打印

食品饮料包装机：

流程包装

制袋机

托盘密封

膜包

工业和制药包装机：

托盘分装

顶部上料器
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纸箱包装

管道填充

吸塑机

液体灌装

固体计量

3.2 VLT® Integrated Servo Drive 集成伺服驱动 ISD 510

3.2.1 ISD 510 伺服驱动器概览
ISD 是集成式伺服驱动器的缩写，这是一种带集成式永磁同步电机 (PMSM) 的紧凑型驱动器。这就意味着，整个功率驱动系统
由电机、位置传感器、机械制动组成，并且电源和控制电子元件集成到 1 个外壳中。在伺服驱动器电子元件中还实施了其他
电路，如低压电源、总线驱动器和功能安全。所有 ISD 510 伺服驱动器均具有 2 个混合连接器 (M23)，用于连接来自混合电
缆的电源和通信信号。高级版本有 3 个附加接口，用于外部编码器或 I/O、现场总线设备，以及直接连接的本地控制面板
(LCP)。

ISD 510 伺服驱动器顶部的 LED 显示当前状态。数据传输通过实时以太网进行。

1

2

e
3

0
b

e
3

8
5

.1
0

1 工作指示 LED

2 连接器

3.2.2 电机和法兰规格

表 4: 电机和法兰规格

规格 1，1.5

Nm

规格 2，2.1

Nm

规格 2，2.9

Nm

规格 2，3.8

Nm

规格 3，5.2

Nm

规格 3，6.0

Nm

规格 4，11.2

Nm

规格 4，13.0

Nm(1)

法兰规
格

76 mm 84 mm 110 mm 138 mm –

1 准备中

3.2.3 ISD 510 伺服驱动器类型

注 意

产品定制软件显示出伺服驱动器型号的有效配置。仅显示出有效组合。因此，并非在类型代码中详细介绍的所有型号都
可见。
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表 5: 型号代码 ISD 510

1–3 4–6 7 8 9–12 13–14 15–17 18–20 21–22 23–25 26 27–30 31–32 33–35 36 37 38 39–40

ISD 510 T D6 T SX

表 6: 图例与类型代码的对应关系

[01–03] 产品组 [18–20] 伺服反馈 [33–35] 电机速度

ISD VLTÆ Integrated Servo Drive FRX 旋变 N46 额定转速 4600 RPM

[04–06] 产品型号 FS1 单圈反馈，17 位 N40 额定转速 4000 RPM

510 ISDÆ 510 FM1 多圈反馈，17 位 N30 额定转速 3000 RPM

[07] 硬件配置 [21–22] 总线系统 N29 额定转速 2900 RPM

A 高级 PL 以太网 POWERLINKÆ N24 额定转速 2400 RPM

S 标准 EC EtherCATÆ N20 额定转速 2000 RPM

[08] 伺服转矩 PN PROFINETÆ [36] 机械制动

T 转矩 [23–25] 固件 X 无制动

[09–12] 转矩 SXX 标准 B 带制动

01C5 1.5 Nm SC0 定制 [37] 电机主轴

02C1 2.1 Nm [26] 安全性 S 标准平滑轴

02C9 2.9 Nm T Safe Torque Off (STO) K 标准安装销

03C8 3.8 Nm [27–30] 法兰规格 [38] 电机密封

05C2 5.2 Nm F076 76 mm X 无密封

06C0 6.0 Nm F084 84 mm S 带密封

11C2 11.2 Nm F108 108 mm [39–40] 表面涂层

13C0 13.0 Nm(1) F138 138 mm SX 标准

[13–14] 直流电压 [31–32] 法兰类型 CX 定制

D6 600 V 直流回路电压 SX 标准

[15–17] 驱动器机箱 C0 定制

E54 IP54

E67 IP67（轴为 IP65）

1 准备中

3.2.4 电机组件

3.2.4.1 轴
轴会将电机作用力（转矩）传输到联接轴的机器。轴材质为 C45+C 或符合 EN 10277-2 的同等材质。根据安装位置，ISD 510
伺服驱动器可以通过轴封（可选）进行密封，以在电机 A 侧达到 IP65（参见 11.11.1 ISD 510 伺服驱动器的防护等级 了解
详细信息）。
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3.2.4.2 制动器（选件）
机械夹持制动选件适用于单片式制动器。紧急停止功能可昀多每 3 分钟启动一次，昀多总共可启动 2000 次，具体取决于负
载。

有效夹持力矩为：

规格 1： 2.5 Nm

规格 2： 5.3 Nm

规格 3： 14.5 Nm

规格 4： 25 Nm

制动器根据故障安全原理无电流时关闭，作为夹持制动运行。它采用 24 V DC 辅助电源供电。这样可在无电流时实现低间隙负

载夹持。

电气数据： 功耗：

规格 1： 1.5 W

规格 2： 1.8 W

规格 3： 3.5 W

规格 4： 5 W

注 意

请勿将夹持制动滥用用工作制动，因为这样会导致磨损增加，过早发生故障。

使用带制动器的 ISD 510 伺服驱动器可以减少允许的驱动器数目，具体取决于每个混合线路的总长。

3.2.4.3 冷却
ISD 510 伺服驱动器为自冷却。冷却（散热）主要通过法兰实现，外壳耗散较少部分热量。

3.2.4.4 热保护
热传感器监测电机绕组的昀高允许温度，如果超过 150 °C 限值则关闭电机。热传感器还存在于驱动器中来保护电子元件免于
温度过高。错误消息通过实时以太网发送到更高层 PLC，还会显示在 LCP 上。

3.2.4.5 内置反馈设备
内置反馈设备用于测量转子位置。有 3 种反馈形式：

旋变

BiSS-B 17 位单圈编码器

BiSS-B 17 位多圈编码器

数据/类型 旋变 单圈编码器 多圈编码器

信号 Sin/cos BiSS-B BiSS-B

精度 ±10 arcmin ±1.6 arcmin ±1.6 arcmin

分辨率 14 位 17 位 17 位

昀大圈数 – – 4096（12 位）

3.2.5 驱动器组件

3.2.5.1 ISD 510 伺服驱动器上的连接器
本节详细介绍标准和高级伺服驱动器的所有可能连接。

ISD 510 伺服驱动器上有 5 个连接器。
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图解 2: ISD 510 伺服驱动器上的连接器

表 7: ISD 510 伺服驱动器上的连接器

连接器 说明

X1 M23 连接器，用于馈电和回路混合电缆输入

X2 M23 连接器，用于回路混合电缆输出或现场总线扩展电缆

X3（仅高级版本） M8 连接器，用于以太网电缆（昀低 CAT5，带屏蔽）

X4（仅高级版本） M12 连接器，用于 I/O 和/或编码器电缆（带屏蔽）

X5（仅高级版本） M8 连接器，用于 LCP 电缆（带屏蔽）

注 意

每个连接器的详细信息位于 11.8 ISD 510/DSD 510 伺服驱动器上的连接器中。

3.3 VLT® Decentral Servo Drive DSD 510

3.3.1 DSD 510 伺服驱动器概览
DSD 是分布式伺服驱动器的缩写，是靠近伺服电机安装的一种伺服驱动器。因此从热角度来看，伺服电机对 DSD 510 伺服驱
动器没有任何影响。

DSD 510 伺服驱动器扩展了分布式伺服驱动器概念的范围。它能提供昀高 4.5 kW 的额定功率，可与多种永磁伺服电机和电机
反馈编码器一起使用。

DSD 510 伺服驱动器顶部的 LED 显示当前状态。数据传输通过实时以太网进行。

3.3.2 DSD 510 伺服驱动器类型

注 意

产品定制软件显示出伺服驱动器型号的有效配置。仅显示出有效组合。因此，并非在类型代码中详细介绍的所有型号都
可见。

表 8: 型号代码 DSD 510

1–3 4–6 7 8–12 13–14 15–17 18–20 21–22 23–25 26 27–28 29–30 31–38 39–40

DSD 510 C08A0 D6 E67 SXX T F2 XXXXXXXX
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表 9: 图例与类型代码的对应关系

[01–03] 产品组 [18–20]（续） 驱动器反馈（续）

DSD VLTÆ Decentral Servo Drive FHD HIPERFACE DSL()

[04–06] 产品型号 [21–22] 总线系统

510 DSD 510 PL 以太网 POWERLINKÆ

[07] 硬件配置 EC EtherCATÆ

A 高级 PN PROFINETÆ

S 标准 [23–25] 固件

[08–12] 额定电流 SXX 标准

C08A0 8.0 Arms [26] 安全性

[13–14] 直流电压 T Safe Torque Off (STO)

D6 600 V 直流回路电压 [27–28] 机架规格

[15–17] 防护等级 F2 (F2) 机架规格 2

E67 IP67 [29–30] 电机连接

[18–20] 伺服反馈 S1 (S1) 单插头版本电机侧

FXX 无反馈/无传感器() S2 (S2) 双插头版本电机侧

FRX 旋变 [31–38] 预留

FS1 BiSS 单圈反馈，17 位 – 预留

FM1 BiSS 多圈反馈，17 位 [39–40] 表面涂层

FE1 EnDat 2.1 SX 标准

FE2 EnDat 2.2 CX 定制

FHF HIPERFACE

准备中

3.3.3 DSD 510 伺服驱动器上的连接器
DSD 510 伺服驱动器的 X1-X5 连接器与 ISD 510 伺服驱动器相同（参见 3.2.5.1 ISD 510 伺服驱动器上的连接器）。除了
X1-X5 连接器之外，DSD 510 伺服驱动器还有 2 个连接器： X6 和 X7。
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图解 3: DSD 510 伺服驱动器上的 X6 和 X7 连接器

表 10: DSD 510 伺服驱动器上的连接器

连接器 说明

X6 M23 8 针电机电源连接器

X7 M23 17 针电机反馈连接器

从 DSD 510 到电机的电缆昀大长度为 5 米。

注 意

DSD 510 伺服驱动器提供单插头版本，带规格 HIPERFACE DSL、EnDat 2.2 和无传感器。此插头用于包括电机和反馈电
缆的混合电缆。

所有其他规格均使用带单独电机和反馈电缆的双插头版本。

3.4 电源模块 (PSM 510)

3.4.1 概述
PSM 是电源模块 (Power Supply Module) 的缩写。它是伺服系统的电源。PSM 510 提供直流电压，并保证高密度输出。直流回
路和 24/48 V 直流电压通过背板中的背部链路分配到所有系统模块。PSM 510 可通过基于以太网的现场总线进行控制。

PSM 510 正面的 LED 指示工作状态和警告。

注 意

系统模块适合在控制机柜内使用。如果使用 STO 功能，则机柜防护等级必须至少为 IP54。

PSM 510 的防护等级为 IP20，符合 IEC/EN 60529（连接器除外，防护等级为 IP00）标准。

如果 PSM 510 接触到液体，则可能会损坏。

所有电源线都连接到 PSM 510，因此，每个系统至少需要一个 PSM 510。

PSM 510 还执行服务功能，比如电压测量，且通过内部风扇冷却。

PSM 510 具有 3 种功率规格，提供 10 kW、20 kW 或 30 kW 的输出功率，具有持续 3 秒的 200% 过载能力。要实现昀高达
60 kW 的输出功率，可并联使用两个 PSM 510 模块。

PSM 510 类型代码的一个示例为： MSD510PSM510F2P10C0D6E20PLSXXXXXXXXXXXXX。
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图解 4: PSM 510

1 背板

2 24/48 V 输入连接器

3 电缆应力消除和屏幕

4 连接器： I/O、STO、继电器和以太网

5 工作指示 LED

6 LCP 连接器

7 PE 螺钉

8 交流主电源连接器

9 内部/外部制动电阻器连接器

3.5 分布式访问模块 (DAM 510)

3.5.1 概述
DAM 是分布式访问模块 (Decentral Access Module) 的缩写。DAM 510 是连接至分布式伺服系统的中央接口/网关。它用于通
过混合馈电电缆将 Danfoss VLTÆ Integrated Servo Drives ISD 510 和 VLTÆ Decentral Servo Drives DSD 510 连接到伺服

系统。

DAM 510 通过混合馈电电缆为分布式伺服驱动器提供直流回路、UAUX、STO 和基于以太网的现场总线。DAM 510 提供许多功能，

比如：

混合电缆的过电流保护

过电压保护

直流回路的充电电路

外部编码器连接

分布式伺服驱动器的直流回路电容缓冲区

DAM 510 可通过基于以太网的现场总线进行控制。

DAM 510 正面的 LED 指示工作状态和警告。
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注 意

系统模块适合在控制机柜内使用。如果使用 STO 功能，则机柜防护等级必须至少为 IP54。

AM 510 的防护等级为 IP20，符合 IEC/EN 60529（连接器除外，防护等级为 IP00）标准。

如果 DAM 510 接触到液体，则可能会损坏。

DAM 510 类型代码的一个示例为： MSD510DAM510F1C015AD6E20PLSXXXXXXXXXXXXX。
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图解 5: DAM 510

1 连接器： STO、以太网和外部编码器

2 工作指示 LED

3 LCP 连接器

4 PE 螺钉

5 连接器： UDC、AUX、STO 输出和以太网

3.6 辅助电容器模块 (ACM 510)

3.6.1 概述
ACM 是辅助电容器模块 (Auxiliary Capacitors Module) 的缩写。可将 ACM 510 连接到 ISD 510 系统以储存能量，以便在
紧急情况下控制机器停机。

注 意

ACM 510 的防护等级为 IP20，符合 IEC/EN 60529（连接器除外，防护等级为 IP00）标准。

如果 ACM 510 接触到液体，则可能会损坏。
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ACM 510 类型代码的一个示例为： MSD510ACM510F1E00C8D6E20PLSXXXXXXXXXXXXX。
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LINK/ACT

DEV

STATUS ACM

图解 6: ACM 510

1 连接器： I/O、继电器和以太网

2 工作指示 LED

3 LCP 连接器

4 PE 螺钉

3.7 扩展模块 EXM 510
EXM 510 将系统模块分到 2 个控制柜中，因此支持模块化机器设置。EXM 510 模块之间电缆的昀大长度为 5 米。

有关详细信息，请参阅 5.13 连接扩展模块 EXM 510。
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图解 7: EXM 510

1 EMC 屏蔽板

2 背板

3 PE 螺钉

4 扩展连接器

注 意

系统模块适合在控制机柜内使用。如果使用 STO 功能，则机柜防护等级必须至少为 IP54。

EXM 510 防护等级为 IP20（根据 IEC/EN 60529 标准）。

如果 EXM 510 接触到液体，则可能会损坏。

EXM 510 类型代码的一个示例为：

MSD510EXM510F1C062AD6E20XXXXXXXXXXXXXXXX

3.8 本地控制面板 (LCP)

3.8.1 本地控制面板概述
LCP 是可以连接 PSM 510、DAM 510 和 ACM 510 的图形用户界面，用于通过选件电缆（M8 - LCP SUB-D 扩展电缆）进行诊断和
操作目的。LCP 以选件形式提供，也可通过相同的选件电缆连接高级版本伺服驱动器。
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通过 LCP 显示屏，操作人员可快速查看 ISD 510/DSD 510 伺服驱动器或模块的状态，具体取决于所连接的设备。显示屏上显
示出参数和警报/错误，可用于调试和故障排查。此外，它还可用于执行简单功能，比如，激活和禁用分布式访问模块上的输
出线路。

LCP 可以安装在控制柜前侧，然后通过 SUB-D 电缆连接模块。

3.8.2 本地控制面板的布局
本地控制面板分为 4 个功能组：

A： 显示区

B： 显示菜单键

C： 导航键和指示灯 (LED)。

D： 操作键和复位

要调整显示屏的对比度，请按 [Status]（状态）和 [▵]/[▿] 键。

3.8.2.1 A： 显示区
显示区中的值随 LCP 是否连接 Danfoss 伺服驱动器或系统模块而异。

当连接伺服驱动器或模块，以通过主电源电压、直流总线端子或 UAUX 收到供电时，显示区激活。
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图解 8: 连接 ISD 510 伺服驱动器时的显示区

1 实际转矩

2 温度驱动模块

3 位置

4 速度

5 Current
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图解 9: 连接 PSM 510 和 DAM 510 时的显示区

1 UAUX 线路电压

2 温度功率板

3 实际 UDC（电流）

4 功率消耗

5 实际 UDC（电压）
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图解 10: 连接 ACM 510 时的显示区

1 温度功率板

2 电容器组 1 的温度

3 电容器组 2 的温度

4 UAUX 线路电压

5 实际 UDC（电压）

3.8.2.2 B： 显示菜单键
菜单键用于菜单访问、参数设置、切换正常操作期间的状态显示模式以及查看故障日志数据。

表 11: 显示菜单键

按键 功能

6 Status（状态） 显示运行信息。

7 Quick Menu（快捷菜单） 可访问参数。

8 Main Menu（主菜单） 可访问参数。

9 Alarm Log（报警记录） 显示昀后 10 个报警。

3.8.2.3 C： 导航键和指示灯 (LED)。
导航键用于移动显示光标，在本地操作中提供操作控制。此区域还有 3 个状态 LED。

AQ262449648484zh-000201 / 175R1135 | 37Danfoss A/S © 2020.10

系统描述

VLT® Servo Drive System ISD 510/DSD 510

操作指南



表 12: 导航键

按键 功能

10 Back（后退） 用于返回菜单结构的上一步或上一列表。

11 Cancel（取消） 取消昀近的改动或命令（只要显示模式尚未发生变化）。

12 Info（信息） 按此键可查看要显示的功能的定义。

13 导航键 使用四个导航键可以在菜单的各个项之间移动。

14 OK（确定） 借此可访问参数组或启用某个选项。

表 13: 指示灯 (LED)

LED 颜色 功能

15 On（通电） 绿色 当伺服驱动器或模块连接到 UAUX 而加电后，On（通电）LED 将点亮。

16 Warn（警告） 黄色 当符合警告条件时，黄色的 Warn（警告）指示灯将亮起，同时会在显示区中出现标识相关问题

的文字。

17 Alarm（报警） 红色 故障状态会使红色 Alarm（报警）指示灯闪烁，同时将显示报警文字。

3.8.2.4 D： 操作键和复位
操作键位于 LCP 的底部。

表 14: 操作键和复位

按键 功能

18 Hand On 允许通过 LCP 控制连接的 ISD 510/DSD 510 伺服驱动器或 PSM 510。

仅在特定状态下，才能在 Hand On（手动启动）和 Auto On（自动启动）模式之间切换（请参阅 VLT® Servo

Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) 编程指南了解详细信息）。

19 Off（关） 将 ISD 510/DSD 510 伺服驱动器置于状态 Switch on Disabled（禁止打开），并可将 PSM 510 置于状态

Standby（待机）。

此按键仅在 Hand On（手动启动）模式下有效。

Off（关闭）按键将使系统从 Hand On（手动启动）模式切换到 Auto On（自动启动）模式。

20 Auto On 将系统置于远程操作模式。

在 Auto On（自动启动）模式下，设备由现场总线 (PLC) 控制。仅当驱动器处于 Switch on Disabled（禁

止启动）状态和/或 PSM 510 处于 Standby（待机）状态时，才能在 Auto On（自动启动）和 Hand On（手

动启动）模式之间切换。

21 复位 在故障被清除后，复位 ISD 510/DSD 510 伺服驱动器或 PSM 510。

仅当处于 Hand On（手动启动）模式时，才能复位。
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3.9 电缆

3.9.1 混合电缆
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图解 11: 混合环路电缆

预配置的混合电缆用于将 ISD 510/DSD 510 伺服驱动器连接到分布式访问模块 (DAM 510)。

共有 2 种类型的混合电缆同时适用于弯式和直式 M23 连接器：

馈电电缆，用于将一个组的第一个 ISD 510/DSD 510 伺服驱动器连接到分布式访问模块 (DAM 510) 上的连接点。

环路电缆，用于连接应用中呈菊花链式的 ISD 510/DSD 510 伺服驱动器。

这两种电缆都由 Danfoss 提供，具有各种长度。请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flex‐

motionô ) 设计指南，了解更多信息。

环路电缆的两端都配有 M23 连接器。

输出端配有 M23 连接器的馈电电缆用于连接到第一个 ISD 510/DSD 510 伺服驱动器。输入端带有尾纤，连接器安装在分布式
访问模块 (DAM 510) 的对应端子上。

表 15: 混合电缆

电缆类型 屏蔽/非屏蔽 注释

馈电电缆 屏蔽 混合电缆（带有附加现场总线和安全部分屏蔽层的全屏蔽型）。

环路电缆

注 意

混合电缆分为两种横截面积： 2.5 mm2 (15 A) 和 4 mm2（对于 CE 和 UL 为 25 A，对于 SCA 为 20 A）。

请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) 设计指南，了解更多信息。
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VLT® ISD 510 Hybrid xxxx Cable

Length: xxxx

Ordering no. 175Gxxxx

1 7 5 G 8 9 X X

Specification no. 175Rxxxx Rev. xxx

Signal rating Ethernet: 2 x 2 x AWG24 300V

Production: dd.mm.yyyy

Power rating: 5 x 2.5mm2    1000V 15A
Signal rating: 2 x 0.5mm2     300V 

图解 12: 混合电缆铭牌示例
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1 电缆类型

2 订购代码

3 规格版本

4 生产日期

5 长度

6 额定功率

7 信号额定值

8 以太网信号额定值

9 条形码

10 制造商徽标

3.9.1.1 混合电缆的昀小弯曲半径
在昀小弯曲半径为 7.5 倍电缆直径 (15.6 mm) 的情况下，昀大弯曲次数为 5 百万次。

永久柔性： 电缆直径的 12 倍

永久安装： 电缆直径的 5 倍

3.9.2 电机和反馈电缆
预配置的电机和反馈电缆用于将 DSD 510 伺服驱动器连接到永磁电机。电缆的两端都配有 M23 连接器。

这些电缆由 Danfoss 提供，长度为 2.5 m 和 5 m（参见 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flex‐

motionô ) 设计指南了解更多信息）。

DSD 510 和电机之间的昀大长度为 5 米。

根据所使用的反馈和电机信号，有不同类型的电缆可用。请参考下面的表格，了解说明中所使用缩写的详细信息。

表 16: 电机和反馈电缆类型

订购号 说明

175G8945 电机电缆 DSD M01 CT01 2.5 m OR

175G8946 电机电缆 DSD M01 CT01 5.0 m OR

175G8947 反馈电缆 DSD M01 CT03 RES 2.5 m GN

175G8948 反馈电缆 DSD M01 CT03 RES 5.0 m GN

175G8949 反馈电缆 DSD M01 CT04 ENC 2.5 m GN

175G8950 反馈电缆 DSD M01 CT04 ENC 5.0 m GN

表 17: 连接器类型 (CT)

型号 型号 说明

CT0 – M23

CT0 1 标配有 HIPERFACE DSL 的电机

CT0 2 预留

CT0 3 M23 解码器

CT0 4 M23 编码器

表 18: 电机/电缆配置

M01 AKM 针脚输出

M02 –
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表 19: 电缆颜色

或 橙色

GN 绿色

3.9.2.1 电机电缆的昀小弯曲半径
在昀小弯曲半径为 7.5 倍电缆直径 (14.8 mm) 的情况下，昀大弯曲次数为 5 百万次。

永久柔性： 电缆直径的 10 倍

永久安装： 电缆直径的 5 倍

3.9.2.2 馈电电缆的昀小弯曲半径
在昀小弯曲半径为 7.5 倍电缆直径 (11.7 mm) 的情况下，昀大弯曲次数为 5 百万次。

永久柔性： 电缆直径的 7.5 倍

永久安装： 电缆直径的 5 倍

3.9.3 I/O 和/或编码器电缆
此电缆将 I/O 和/或编码器连接到 ISD 510/DSD 510 伺服驱动器（X4 连接器）。该电缆不包含在伺服驱动器中。

如果带 M12 连接器的 I/O 和/或编码器电缆符合 IEC 61076-2-101 中规定的规格，则可用于 ISD 510/DSD 510 系统。

3.9.4 现场总线扩展电缆
电缆长度： 2 m

至下一端口的昀大长度： 100 m

如果不使用此电缆，则将 M23 盲盖安装在应用中昀后一个 ISD 510/DSD 510 伺服驱动器上的 X2 母接头上。

3.9.5 LCP 电缆
LCP 电缆用于通过 M8 连接器将 LCP 连接到高级 ISD 510/DSD 510 伺服驱动器和系统模块。

LCP 电缆可从 Danfoss 购买（请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) 设计指南，

了解更多信息和订购号）。

3.10 电缆布局和敷设
ISD 510/DSD 510 伺服驱动器通过混合回路电缆互相连接。带有速卸连接器的混合馈电电缆提供从分布式访问模块 (DAM 510)
到第一个伺服驱动器的电源。

拖链中的布线

混合电缆可兼容拖链，因此适合用于移动系统。弯曲循环的数目取决于具体条件，因此必须对于每个应用提前确定，参见 3.9.1
混合电缆 了解更多信息。

3.10.1 2 线路的标准接线概念
此接线概念用于应用中 ISD 510/DSD 510 伺服驱动器不带冗余的 2 线路。对于伺服驱动器的每个附加线路，需要 1 个附加
的 DAM 510。对于仅 1 个线路的接线概念，仅需 1 个 DAM 510。

注 意

对于带冗余的接线，参见 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) 设计指南。
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图解 13: 2 线路的标准接线概念

1 M23 馈电电缆

2 M23 环路电缆

3 交流线路电抗器

3.11 软件
伺服系统的软件包括：

已安装到设备上的 ISD 510/DSD 510 固件。

已安装到模块上的系统模块的固件。

用于操作 ISD 510/DSD 510 伺服驱动器和系统模块的 Automation Studioô  的 PLC 库的文件包（请参阅 6.10.2 创建

Automation Studio™ 项目 了解更多信息）。

用于操作 ISD 510/DSD 510 伺服驱动器和系统模块的 TwinCATÆ 2 的 PLC 库（请参阅 6.11.2 创建 TwinCAT® 项目 了解

更多信息）。

用于操作 ISD 510/DSD 510 伺服驱动器和系统模块的 SIMOTION SCOUTÆ 的 PLC 库（请参阅 6.13.3 创建 SIMOTION

SCOUT® 项目）。

用于操作 ISD 510/DSD 510 伺服驱动器和系统模块的 TIA Portal 的 PLC 库。

VLTÆ Servo Toolbox： Danfoss 提供的基于 PC 的软件，用于调试设备。

3.12 现场总线
伺服系统具有通过基于快速以太网 (100BASE-T) 通信来实现的开放系统架构。该系统支持 EtherCATÆ、以太网 POWERLINKÆ

和 PROFINETÆ 现场总线。请参阅 VLT Servo Drive System ISD 510、DSD 510、MSD 510 (VLT® Flexmotionô ) 编程指南，了解

更多信息。
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在生产环境中，与设备的通信始终通过作为主站的 PLC 来进行。ISD 510/DSD 510 伺服驱动器和系统模块可通过以下通信方法
来控制：

使用 VLTÆ Servo Motion 库（适用于 TwinCATÆ、Automation Studioô 、SIMOTION SCOUTÆ 和 TiA Portal）。

使用 TwinCATÆ 的 NC 轴功能（仅限 ISD 510/DSD 510）。

通过读取并写入到对象来使用 CANopenÆ CiA DS 402 标准。

使用应用类 1 (AC1) 和 4 (AC4)，仅适用于 Æ。

ISD 510/DSD 510 伺服驱动器和系统模块可使用以下周期时间来运行。

EtherCATÆ 和以太网 POWERLINKÆ 现场总线：

400 µs 及其倍数（例如，800 µs 和 1200 µs）。

500 µs 及其倍数（例如，1 ms）。

PROFINETÆ 现场总线

500 µs 及其倍数（例如，1 ms）。

当周期时间为 400 µs 和 500 µs 的倍数时，使用 500 µs 的时基。

ISD 510/DSD 510 伺服驱动器和系统模块已根据相应规定和法规通过现场总线认证。这些伺服驱动器符合 CANopenÆ CiA DS

402 变频器行规。

3.12.1 EtherCAT®

ISD 510/DSD 510 伺服驱动器和系统模块支持以下 EtherCATÆ 协议：

CANopen over EtherCATÆ (CoE)

File Access over EtherCATÆ (FoE)

Ethernet over EtherCATÆ (EoE)

ISD 510/DSD 510 伺服驱动器和系统模块支持分布式时钟。为补偿系统中的通信电缆部分的故障，所有现场总线都可使用冗余
电缆。请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) 设计指南，了解更多信息。

EtherCAT
Slave  Controller 

(ESC)

OUT
LAN 1 (B)

O
U

T  2
 (C

)

IN  0
 (A

)

X2X1 

X3

e3
0b

e6
95

.1
1

LA
N

LA
N

图解 14: ISD 510/DSD 510 伺服驱动器的 EtherCATô  端口分配

X1 用于连接至分布式访问模块 (DAM 510) 或上一伺
服驱动器的 M23 混合电缆连接器。

X2 用于连接至下一伺服驱动器的 M23 混合电缆连接
器。

X3 用于连接至其他 EtherCATÆ 从站（比如 Ether‐

CATÆ 编码器）的 M8 以太网电缆连接器。

该连接器仅在高级伺服驱动器上可用。
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图解 15: 分布式访问模块 (DAM 510) 的 EtherCATô  端口分配

X1 用于连接到上一从站的 RJ45 电缆连接器。

X2 用于将 M23 混合馈电电缆连接到第一个 ISD 510/
DSD 510 伺服驱动器的 RJ45。

X3 用于连接到 PLC（冗余电缆）或下一从站的 RJ45
电缆连接器。
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图解 16: 电源模块 (PSM 510)、辅助电容器模块 (ACM 510) 和 ISD 510/DSD 510 伺服驱动器的 EtherCATô  端口分配

X1 用于连接到 PLC 或上一从站的 RJ45 电缆连接器。

X2 用于连接到 PLC（冗余电缆）或下一从站的 RJ45 电缆连接器。

3.12.2 以太网 POWERLINK®

ISD 510/DSD 510 伺服驱动器和系统模块通过 DS 301 V1.1.0 认证，支持以下功能：

作为受控节点工作

可作为多路复用站工作

支持交叉通信

对介质冗余支持环冗余

对以太网 POWERLINKÆ 未分配特定端口。

3.12.3 PROFINET®

ISD 510/DSD 510 伺服驱动器和系统模块支持 PROFINETÆ 一致性等级 C，符合 IEC 61158-5-10:2014、IEC 61158-6-10:2014、

IEC 61784-2:2014 和 IEC 61784-5-3:2013 标准。所有系统组件（伺服驱动器和系统模块）都可在 PROFINETÆ 网络中用作 I/

O 设备。

支持以下功能：

I/O-设备 - 由 I/O 控制器控制的设备

动态模块配置

Net load class II

环路冗余 (MRP) 作为客户端

PROFINETÆ 现场总线设备始终通过现场总线设备中集成的交换机作为网络组件连接。ISD 510/DSD 510 伺服驱动器、PSM 510 和

ACM 510 上有 2 个端口。DAM 510 上有 3 个端口。只有 2 个可用于同步实时 (IRT) 协议，而所有 3 个均可用于实时 (RT)
协议。如果购买了带 IRT 的 DAM 510，则将 RJ45 盖安装到 X3 输出端口。取下此盖，可以使用切换到 RT 协议所需的 X3 输
出端口。

在一个应用中使用多个 DAM 510 模块的接线概念显示在 图解 17 中。
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图解 17: 多个 DAM 510 模块的接线概念

1 交流线路电抗器

2 客户电缆

3 现场总线扩展电缆
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4 机械安装

4.1 提供的物品
为 ISD 510/DSD 510 伺服系统提供的物品有：

ISD 510/DSD 510 伺服驱动器

电源模块 (PSM 510)，包括连接器

分布式访问模块 (DAM 510)，包括连接器

辅助电容器模块 (ACM 510)，包括连接器，可选

扩展模块 (EXM 510)，可选

本地控制面板 (LCP)，可选

本操作指南

馈电（混合）电缆

环路（混合）电缆

LCP 电缆，可选

现场总线扩展电缆，可选

连接器 M8、M12 和 M23 的盲盖

包装装置取决于交付的伺服驱动器数目。将包装箱保留好，以便在需要退回产品时使用。

4.2 运输

始终使用具有足够承载能力的运输和起吊装置来运输伺服系统组件。

避免运输过程中振动。

避免重击和冲击。

4.3 收货查验
操作步骤

在收到货物后，应立即检查提供的物品是否与发运单据一致。Danfoss 将不承认以后登记的差错索赔。

如果发现明显的运输损坏，立即向承运商处进行投诉登记。

如果发现明显缺陷或交付物品不完整，立即向 Danfoss 负责代表进行投诉登记。

4.4 安装过程中的安全措施
在安装过程中，务必遵守本手册中的安全说明。特别注意确保始终遵守以下各点：

安装只能由具备相应资质的人员执行。

安装时必须保持适当地小心谨慎。

必须遵守所有安全法规、采取相应保护措施并保持相应环境条件。

已阅读并理解手册。

4.5 安装环境

4.5.1 概述
安装必须提供以下环境条件，才能使得 ISD 510/DSD 510 系统安全高效地运行。

如果无法符合这些环境条件，则联系 Danfoss。

4.5.2 ISD 510/DSD 510 伺服驱动器

不得超过允许的工作环境温度范围和振动级别。（请参阅 11.10.1 ISD 510/DSD 510 伺服驱动器。）

允许的相对湿度范围为 3–93%，无冷凝。

必须提供不受限制的通风。

安装结构必须适合应用，例如，足够坚固，能够应对超过 90 °C 的温度。
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4.5.3 系统模块
PSM 510、DAM 510 和 ACM 510 的环境条件为：

不得超过允许的工作环境温度范围和振动级别（请参阅 11.10.2 系统模块）。

允许的相对湿度范围为 5–93%，无冷凝。

系统模块上方和下方必需的昀小空隙在 4.7.3 系统模块的空间要求中详细说明。

4.6 安装准备

4.6.1 ISD 510/DSD 510 伺服驱动器
进行以下准备以确保能够可靠有效地安装伺服系统。

务必按照当地法规安装联轴器和其他传输组件。

步骤

提供适合应用的安装布置。这取决于 ISD 510/DSD 510 伺服驱动器的类型、重量和功率大小。

对于 ISD 510 伺服驱动器，让电机法兰与安装表面齐平，然后再固定伺服驱动器。不对齐会缩短轴承和联轴器组件的
寿命，降低来自伺服驱动器的传热。

对于 DSD 510 伺服驱动器，让 DSD 510 底部与安装表面齐平，然后再固定伺服驱动器。不对齐会减少来自伺服驱动器
的传热。

如果运行期间可能出现高温表面，则根据地方法规提供接触保护。

对伺服驱动器接地。

4.6.2 系统模块
进行以下准备以确保能够可靠有效地安装伺服系统。

始终按照当地法规安装系统模块。

操作步骤

提供适合应用的安装布置。这取决于模块类型和重量。

为避免未对齐，确保背板完全水平。

为确保冷却不足，注意指定的昀小空间要求。

将模块接地。
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4.6.3 钻孔样板

(100 x number of FS2 + 50 x number of FS1) - 50

FS2 FS1

50 50

[1.97]

[0.42]

[1
4.

45
]

[1.97]

50 50

[1.97] [1.97]

M5

M5

36
7

UNF 10-32

UNF 10-32

Ø10,6

e3
0b

g8
19

.1
0

图解 18: 用于 50 mm 和 100 mm 系统模块的钻孔样板

4.7 安装过程

4.7.1 ISD 510 伺服驱动器的空间要求
除了自身尺寸之外，ISD 510 伺服驱动器还需要用于混合电缆的空间。

4.7.1.1 用于 ISD 510 上 M23 直式连接器的昀小距离 显示了规格 2 ISD 510 伺服驱动器上安装的直式连接器。

4.7.1.2 用于 ISD 510 上 M23 弯式连接器的昀小距离 显示了规格 2 ISD 510 伺服驱动器上安装的弯式连接器。

该图显示了从伺服驱动器到下一个物体的昀小距离，以及用于永久性安装电缆的昀小允许弯曲半径 Rmin。对于电缆安装，连接

器的高度加上附加的 30 mm 用于电缆。

从电子元件外壳测量的昀小距离，此距离对于所有电机信号均相同。

4.7.1.1 用于 ISD 510 上 M23 直式连接器的昀小距离
直式连接器的昀小距离按下述方式计算：

0.5 x 电缆直径 + 连接器高度 + Rmin = 7.8 mm + 112 mm + 78 mm = 197.8 mm ≈ 200 mm
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图解 19: 用于 M23 直式连接器的昀小距离

4.7.1.2 用于 ISD 510 上 M23 弯式连接器的昀小距离
弯式连接器的昀小距离按下述方式计算：

0.5 x 电缆直径 + 从电子元件外壳测量的连接器长度 + Rmin = 7.8 mm + 51.4 mm + 78 mm = 137.8 mm ≈ 140 mm
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图解 20: 用于 M23 弯式连接器的昀小距离

4.7.2 DSD 510 伺服驱动器的空间要求
除了自身尺寸之外，DSD 510 伺服驱动器还需要用于混合电缆的空间。

4.7.2.1 用于 DSD 510 上 M23 直式连接器的昀小距离 显示了 DSD 510 伺服驱动器上安装的直式连接器。

4.7.2.2 用于 DSD 510 上 M23 弯式连接器的昀小距离 显示了 DSD 510 伺服驱动器上安装的弯式连接器。

该图显示了从伺服驱动器到下一个物体的昀小距离，以及用于永久性安装电缆的昀小允许弯曲半径 Rmin。对于电缆安装，连接

器的高度加上附加的 30 mm 用于电缆。
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4.7.2.1 用于 DSD 510 上 M23 直式连接器的昀小距离
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图解 21: 用于 M23 直式连接器的昀小距离

4.7.2.2 用于 DSD 510 上 M23 弯式连接器的昀小距离

88.4
[3.48]

88.4
[3.48]

150 min
[5.9]

150 min
[5.9]

27.8
[1]

10
5 

m
in

[4
]

80
 m

in

[3
.1

4]

27.8
[1]

Rmin Rmin

e3
0b

i0
01

.1
0

图解 22: 用于 M23 弯式连接器的昀小距离

4.7.3 系统模块的空间要求
这些模块可并排安装，但需要在顶部和底部留出昀小空间以便冷却。
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图解 23: 顶部和底部所需的昀小空间
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图解 24: 侧面所需的昀小空间

4.7.4 需要的安装辅助装置和工具
安装 ISD 510 伺服驱动器时，需要使用与固定螺钉相配套的工具（不含）。

4.7.5 ISD 510 伺服驱动器安装说明

4.7.5.1 概述
ISD 510 伺服驱动器交货时带有 M23 运输保护盖。用于 IP 防护的 M23 盲盖必须单独订购。ISD 510 伺服驱动器的高级版本
交货时附带 M8 和 M12 盲盖。这些盲盖可以防止伺服驱动器的污染，为了实现相关 IP 防护等级，必需这些盲盖。如果未使
用连接器，则务必安装这些盲盖。

注 意

确保接触伺服驱动器法兰的机器表面没有涂层，以保证伺服驱动器的正常热行为。表面接触还必须提供足够的接地保
护。

4.7.5.2 夹钳 ISD 510 伺服驱动器
遵守以下安装说明，确保 ISD 510 伺服驱动器的可靠高效安装。
步骤

检查电机安装配合面，确保具有充足的散热能力。必须为未涂漆表面。

从轴上取下保护端盖。

使用机器装置中为此目的提供的 4 个安装孔，通过 4 个螺钉固定伺服驱动器，如图所示。

务必在安装法兰中使用指定的安装孔来固定伺服驱动器。

请勿修改安装孔。

务必使用全部 4 个安装孔。如果使用的安装孔较少，则电机可能运行不平稳。
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图解 25: 规格 1，1.5 Nm；规格 2，2.9 Nm；规格 2，3.8 Nm；规格 3 和规格 4 ISD 510 伺服驱动器
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图解 26: 规格 2，2.1 Nm ISD 510 伺服驱动器的安装

4.7.5.3 安装 ISD 510 伺服驱动器联轴器
安装 ISD 510 伺服驱动器的联轴器之前，注意以下安全警告。

注 意

请勿对轴进行机加工。

如果轴与联轴器布置不匹配，请勿使用 ISD 510 伺服驱动器。
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注 意
安装过程中请勿使用过大作用力：

请勿超过规定的振动限值。

请勿超过规定的允许作用力。

步骤

将夹钳组件对齐 ISD 510 伺服驱动器的轴。

将轴插入夹钳组件中。

将夹钳组件拧在一起。

4.7.5.4 固定螺钉的紧固力矩
务必用相同的力矩，以十字交叉形式拧紧螺钉。

伺服驱动器规格 螺纹类型/

孔尺寸

昀大螺纹长度 紧固力矩

规格 1，1.5 Nm Ø 5.8 mm – 5 Nm

规格 2，2.1 Nm M6 螺距 1 mm 23 mm 6 Nm

规格 2，2.9 Nm Ø 7 mm – 6 Nm

规格 2，3.8 Nm Ø 7 mm – 6 Nm

规格 3，5.2 Nm Ø 9 mm – 14 Nm

规格 3，6.0 Nm Ø 9 mm – 14 Nm

规格 4，11.2 Nm Ø 11 mm – 28 Nm

规格 4，13.0 Nm 准备中 – 准备中

注 意

不提供固定螺钉，必须根据机器固定件选择。

4.7.6 DSD 510 伺服驱动器安装说明

4.7.6.1 夹钳 DSD 510 伺服驱动器
遵守以下安装说明，确保 DSD 510 伺服驱动器的可靠高效安装。
步骤

检查安装表面，确保具有充足的散热能力。必须为未涂漆表面。

钻取用于安装 DSD 510 的孔（参见 11.3.3 DSD 510 伺服驱动器的尺寸）。

使用 M5 螺钉将 DSD 510 安装到安装板上。

紧固力矩为 3 Nm

务必使用全部 4 个安装孔。
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图解 27: DSD 510 伺服驱动器的安装

4.7.7 系统模块安装说明

注 意

将输出功率昀高的系统模块安装在 PSM 510 旁边。然后按输出功率从高到低安装剩余系统模块。

步骤

按照钻孔样板（请参阅 4.6.3 钻孔样板）钻取用于安装背板的孔。

通过卡锁方法连接背板和端盖。
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图解 28: 连接背板

1 背板端盖
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3.



4.

使用具有 9.5 毫米的昀小螺钉头直径或垫圈直径的 M5 螺钉将背板安装到控制柜中的安装板上。紧固力矩为 3 Nm。
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图解 29: 在控制柜中安装背板

将模块滑到背板底部的支架上。
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

将第一个模块按入到背板顶部的背部链路连接器中。
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图解 30: 将模块按入到背部链路连接器中

要固定模块，按下背板顶部的固定夹（图解 31 中的 [1]）。
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图解 31: 按下背板顶部的固定夹
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7.



对剩余模块重复步骤 4、5 和 6，确保第 2 个模块左侧的边沿位于第一个模块右侧的导向槽内（图解 32 中的 ([1]）。
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图解 32: 导向槽
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5 电气安装

5.1 电气安装警告
在电气安装过程中，除遵守本手册中的信息外，还需遵守相关的地方和国家法规。

警 告
漏电/接地电流危险

漏电/接地电流超过 3.5 mA。ISD 510/DSD 510 伺服驱动器和系统模块错误接地可能会导致严重伤亡。

为了保护操作人员的安全，请按照适用的地方和国家电气标准和指令以及本手册中的操作说明，由经认证的电气安装员
将系统正确接地。

警 告
高电压

该伺服系统包含连接到电网后在高电压下运行的组件。这些组件上没有指示灯来指示是否已通电。错误安装、调试或维护可

能导致严重伤亡。

安装、调试和维护只能由具备相应资质的人员执行。

警 告
高电压

连接器上存在可能致命的电压，这可能会导致严重伤亡。

在电源连接器（断开或连接电缆）上开始操作之前，应将 PSM 510 与主电源断开，然后等待一段时间，直到放电完毕。

5.2 电气环境条件
要安全高效地操作伺服系统，必须满足以下电气环境条件：

仅适用于 TN-S、TN-C、TN-CS、TT（非角接地）电源接地系统

预期短路电流： 5 kA

保护等级 I

接地 3 相电网，400–480 V AC ±10%

3 相频率 44–66 Hz

3 相线路和 PE 线路

辅助电压的外部电源，24–48 V DC (PELV) ±10%

交流电抗器（请参阅 5.10.1 交流线路电抗器）

遵守国家法律规定。

漏电电流大于 3.5 mA。

注 意
RCD 兼容性

伺服系统包含可导致保护性接地导体中出现直流电流的组件，这可能会导致连接到该系统的任何设备出现故障。

在直接或间接接触情况下，如果使用漏电保护 (RCD) 或监控 (RCM) 装置来提供保护，则在系统组件的电源侧使用 B
型 RCD 或 RCM 装置。

注 意

必须将 PSM 510、DAM 510 和 ACM 510（可选）安装在控制柜中。
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5.3 符合 EMC 规范的安装
要实现符合 EMC 规范的安装，按照 5.4.2 接地确保安装符合 EMC 规范 中的说明以及用于连接 ISD 510/DSD 510 伺服驱动
器、PSM 510、DAM 510 和 ACM 510 的规定步骤进行操作。

5.4 接地

5.4.1 接地确保电气安全

使用馈电电缆的 PE 线缆将 DSD 510 伺服驱动器接地。DSD 510 伺服驱动器的正面有一个专用 PE 螺钉，背面也有一个。

X6X7
e3

0b
h5

72
.1
0

1

图解 33: 对 DSD 510 伺服驱动器接地

1 PE 螺钉

确保将机器框架通过正确的电气连接方式连接到 ISD 510 和 DSD 510 伺服驱动器。

对于 ISD 510： 使用正面的法兰面。确保机器该部件已进行 PE 连接。

对于 DSD  510： 使用图解 33 中显示的 PE 螺钉。

对于 ISD 510/DSD 510 伺服驱动器，确保昀小接地线缆横截面积至少为 10 mm2（昀低 70 °C，铜线）或 2 个单独的接地

线缆都符合尺寸规定。有关详细信息，请参阅 EN/IEC61800-5-1。

对输入电源和控制线缆使用专用接地线。

请勿以菊花链方式将模块接地。

地线连接应尽可能短

遵守本手册中的接线要求。

对于系统模块：

为符合 CE 要求，确保昀小接地线缆横截面积至少为 16 mm2（昀低 70 °C，铜芯）。

为符合 UL 要求，确保昀小接地线缆横截面积至少为 6 AWG（昀低 60 °C，铜芯）。

如果使用 10 kW 的 PSM 510 模块，则可将电缆横截面积降低至：

10 mm2（昀低 70 °C，铜芯），符合 CE 要求

8 AWG（昀低 60 °C，铜芯），符合 UL 要求

5.4.2 接地确保安装符合 EMC 规范

在每个模块上使用 I/O 屏蔽板在电缆屏蔽层和机箱之间建立电气接触。
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图解 34: 系统模块顶部的电缆屏蔽层

1 电缆

2 电缆扎带

3 I/O 屏蔽板
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图解 35: 系统模块底部的电缆屏蔽层

1 电缆扎带

2 EMC 金属屏蔽板

3 PE 螺钉

使用带有高覆盖率的屏蔽层的电缆来减小电气干扰。

请勿使用辫子状线缆来连接屏蔽层。建议采用 360° 线缆连接。
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注 意
电位均衡

如果伺服系统和机器之间的大地电位不同，可能会出现电气干扰。在它们之间安装等势电缆。推荐的电缆横截面积为
16 mm2。

注 意
EMC 干扰

使用屏蔽电缆作为控制线缆，对电源线和控制线缆使用单独的电缆。未隔离电源线和控制线缆可能会导致意外操作或降
低性能。

确保信号电缆和电源线之间至少相距 200 毫米。

只能以 90° 交叉电缆。

5.5 主电源要求
确保电源具有以下属性：

TN-S、TN-C、TN-CS、TT（非角接地）电源接地系统。

预期短路电流： 5 kA。

保护等级 I。

接地 3 相电网，400–480 V AC ±10%。

3 相线路和 PE 线路。

3 相频率： 44–66 Hz

30 kW 时，1 个 PSM 510 的昀大输入电流： 55 Arms

5.5.1 熔断器

注 意

在电源模块 PSM 510 的供电侧使用符合 CE 和 UL 要求的熔断器（请参阅 表 20）。

使用 2 个 PSM 510 模块时，每个 PSM 510 都必须有自己的专用熔断器组。

表 20: 熔断器

型号和功率额定值 符合 CE 要求 (IEC 60364) 符合 UL 要求 (NEC 2014)

熔断器昀大规格 熔断器昀大规格

PSM 510 (10 kW) gG 25 A 30 A（仅限 T 类或 J 类）

PSM 510 (20 kW) gG 50 A 50 A（仅限 T 类或 J 类）

PSM 510 (30 kW) gG 63 A 80 A（仅限 T 类或 J 类）

5.5.2 断路器
使用分断能力为 PSM 510 额定电流的 1.5 倍的 B 类或 C 类断路器来满足 CE 要求。

注 意

不允许在要求 C-UL 认证的装置中使用断路器。仅允许使用 UL 推荐的熔断器。
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5.6 辅助电源要求
使用输出范围为 24–48 V DC ±10% 的电源装置为电源模块 (PSM 510) 供电。电源的输出纹波电压必须小于 250 mVpp。只能

使用符合 PELV 规范的电源。有关额定功率的壳层图，请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT®

Flexmotionô ) 设计指南。

注 意

只能使用符合 PELV 规范的电源。

对于工业用途，使用带有 CE 标志的符合 EN 61000-6-2、EN 61000-6-4 或类似标准的电源。

辅助电路必须由外部单独电源供电。

电源装置必须专用于 ISD 510/DSD 510 伺服系统，这意味着，该电源仅用于为 PSM 510 供电。电源装置和 PSM 510 之间的电
缆昀大长度为 3 米。

5.6.1 熔断器
推荐使用 UL 列名的熔断器来保护 24–48 V 直流线路上的线缆。

表 21: 熔断器

符合 CE 要求 (IEC 60364) 符合 UL 要求 (NEC 2014)

熔断器昀大规格 熔断器昀大规格

50 A(1) 63 A(2)

1 如果昀大电流低于此值，则可使用具有更低电流额定值的熔断器。IEC 熔断器的等级： 根据昀大电流的 100% 确定。使用根据所用的直流

电压分级的延时熔断器。

2 如果昀大电流低于此值，则可使用具有更低电流额定值的熔断器。UL 熔断器的等级： 根据昀大电流的 125% 确定。使用根据所用的直流电

压分级的延时熔断器。

5.7 安全电源要求
使用具有以下属性的 24 V 直流电源为 STO 线路供电：

输出范围： 24 V DC ±10%

昀大电流： 1 A

对工业用途使用通过 CE 认证的 24 V 电源。确保电源满足 PELV 规格，且仅适用于系统安全输入。

可对辅助和安全电源使用公用电源，只要两个电路的唯一连接点靠近该电源。这可避免由于公用电源出现压降而导致的干扰。
24 V 电源和伺服系统之间的电缆昀大长度为 3 米。

安全电源可从 PSM 510 沿环路连接到其他系统模块（ACM 510 除外）。不提供用于此连接的电缆。有关详细信息，请参阅 8.6
安装。

注 意

确保安全信号和其他信号、电源（主电源）和外露的导电部件之间采用了加强绝缘。
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5.8 UL 要求

注 意

集成的固态短路保护装置不提供支路保护功能。提供支路保护功能时必须遵守国家电气规范/加拿大电气规范和任何其
他地方规范或同等规定。

适用于在使用昀大 80 A 的 J 类或 T 类熔断器进行保护时，能够提供不超过 5000 rms 对称电流且昀大电压为 480 V
的电路。

为符合 UL（美国安全检测实验室）规范，请使用昀低耐热能力为 60 °C 的 UL 认可的铜线。只能使用 1 类线缆。对
于额定功率为 30 kW 的 PSM 510 和 EXM 510，使用昀低耐热能力 75 °C。

需要使用控制电路过电流保护功能。

5.9 连接 ISD 510/DSD 510 伺服驱动器

5.9.1 ISD 510/DSD 510 伺服驱动器的电气安装警告

警 告
高电压

连接器上存在可能致命的电压，这可能会导致严重伤亡。

在接触电源或信号连接器（断开或连接电缆）或执行任何维护工作之前，应将电源模块 (PSM 510) 与主电源断开，并等
待放电完毕。

警 告
放电时间

伺服系统包含直流回路电容器，该电容器在电源模块 (PSM 510) 的主电源关闭后保持充电一段时间。如果切断电源后在规定

的时间结束之前就执行维护或修理作业，可能导致死亡或严重伤害。

为避免电击，将电源模块 (PSM 510) 与主电源完全断开，并等待电容器完全放电后，再在伺服系统或其组件上执行任何
维护或维修工作。

昀短等待时间（分钟）

15

5.9.2 电缆安装的一般说明
避免所有电缆的机械张力，尤其与所安装伺服驱动器移动范围相关的张力。

根据法规以及现场条件购买所有电缆。确保即使拉长操作之后，电缆也不会变松。

如果不使用 X3、X4 和 X5 连接器，则务必安装相应的盲盖。

注 意

切勿在存在电源电压时连接或断开通向或来自伺服驱动器的混合电缆。否则可能损坏电子线路。按照直流回路电容器
的放电时间观察一段时间。

请勿强制连接或安装连接器。错误连接可能会对连接器造成永久损坏。
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表 22: 紧固力矩

连接器 紧固力矩 [Nm]

M8 0.2

M12 0.4

M23 0.8

5.9.3 连接混合电缆
步骤

将 M23 馈电电缆的母接头与第一个 ISD 510/DSD 510 伺服驱动器的输入公接头 (X1) 对齐。

逆时针旋转电缆连接器的螺纹环。使用标记 OPEN 作为电缆连接器参考。

确保电缆连接器上的标记 OPEN 朝向伺服驱动器。

朝伺服驱动器的电子元件外壳按连接器，直到连接器上的密封件被完全盖住。

将螺纹环顺时针转出 OPEN 标记周围的平整区域，拧紧 M23 馈电电缆。

e
3

0
b

e
6

6
4

.1
1

图解 36: 连接 M23 馈电电缆

要以菊花链形式添加更多伺服驱动器，将环路电缆的公接头连接到第 1 个伺服驱动器的母接头 (X2)。

将环路电缆的母接头连接到下一个伺服驱动器的公接头 (X1)，以此类推。

按照步骤 5 中的说明，用手拧紧螺纹环。
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10.

11.



确保电缆上无机械应力。

e
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ISD 510
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3
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图解 37: 以菊花链形式添加 ISD 510 伺服驱动器

1 X1 公接头

2 X2 母接头

3 M23 金属盲盖

将 M23 金属盲盖安装到伺服系统中昀后一个伺服驱动器上未使用的 M23 输出母接头 (X2) 上。

拧紧金属盲盖，直到连接器上的密封件被盖住。
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6
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1

图解 38: 安装 M23 盲盖
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注 意

当心人身伤害和/或设备损坏

不使用 M23 金属盲盖可能导致操作人员受伤和/或 ISD 510/DSD 510 伺服驱动器损坏。

务必按照步骤 10 和 11 中的说明安装 M23 金属盲盖。

注 意

还提供 M23 连接器的弯式版本。连接弯式 M23 连接器的过程与直式连接器相同。

5.9.4 断开混合电缆
步骤

断开电源模块 (PSM 510) 与电源（电网和 UAUX）的连接。

等待昀短放电时间。

取下分布式访问模块 (DAM 510) 上馈电电缆的连接器。

逆时针旋转伺服驱动器上馈电电缆连接器的螺纹环，直到电缆连接器上的 OPEN 标记朝向伺服驱动器。

将连接器拉离电子元件外壳。

对于 X1 和 X2 连接器提供保护性盲盖。取下相应的连接器后，安装盲盖。

5.9.5 连接 X3、X4 或 X5 端口的电缆

5.9.5.1 电缆布线建议
避免所有电缆的机械张力，尤其与所安装伺服驱动器移动范围相关的张力。

根据法规以及现场条件购买所有电缆。确保即使拉长操作之后，电缆也不会变松。

5.9.5.2 将 I/O 和/或编码器电缆连接到端口 X3
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1

图解 39: 连接 I/O 和/或编码器电缆
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步骤

将电缆上的连接器（未提供）与伺服驱动器上带有 X4 标记的连接器对齐。

朝伺服驱动器的电子元件外壳按连接器，顺时针旋转拧紧连接器的螺纹环。昀大紧固力矩为 0.4 Nm。

5.9.5.3 将 LCP 电缆连接至端口 X5
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1

图解 40: 连接 LCP 电缆

步骤

将 LCP 电缆上的连接器（未提供）与 ISD 510/DSD 510 伺服驱动器上带有 X5 标记的 LCP 连接器对齐。

朝伺服驱动器的电子元件外壳按连接器，顺时针旋转拧紧连接器的螺纹环。昀大紧固力矩为 0.2 Nm。

可以作为配件订购 LCP 电缆。

AQ262449648484zh-000201 / 175R113568 | Danfoss A/S © 2020.10

电气安装

VLT® Servo Drive System ISD 510/DSD 510

操作指南



1.

2.

1.

2.

3.

5.9.5.4 将第 3 方以太网设备电缆连接至端口 X3
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图解 41: 连接第 3 方以太网设备电缆

步骤

将电缆上的连接器与 ISD 510/DSD 510 伺服驱动器上带有 X3 标记的以太网连接器对齐。

朝伺服驱动器的电子元件外壳按连接器，顺时针旋转拧紧螺纹环。昀大紧固力矩为 0.2 Nm。

5.9.6 断开 X3、X4 或 X5 端口的电缆
逆时针旋转松开连接器的螺纹环。

断开伺服驱动器的电缆。

对于 X3、X4 和 X5 连接器提供保护性盲盖。取下相应的连接器后，安装盲盖。

5.10 连接电源模块 PSM 510

5.10.1 交流线路电抗器
必须使用 3 相交流线路电抗器（请参阅 5.10.1.1 将 1 个 PSM 510 连接到交流电抗器和 5.10.1.2 将 2 个 PSM 510 模块
连接到交流电抗器）。

表 23: 用于 1 个 PSM 510 的线路电抗器特征

型号 昀低 Irms [A] Urms [V] 电感 [mH]

PSM 510 (10 kW) 20 500 昀小值： 0.47

昀大值： 1.47

PSM 510 (20 kW) 40 500 昀小值： 0.47

昀大值： 1.47

PSM 510 (30 kW) 60 500 0.47 ±10%
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如果并联安装了 2 个 PSM 510 模块，则使用表 24 中指定的交流电抗器。有关详细信息，请参阅 5.10.1.2 将 2 个 PSM 510
模块连接到交流电抗器。

表 24: 用于并联安装的 2 个 PSM 510 的线路电抗器特征

型号 昀低 Irms [A] Urms [V] 电感 [mH]

PSM 510 (2 x 30 kW) 125 500 0.24 ±10%

Danfoss 建议将交流线路电抗器安装在 PSM 510 近处。

昀大电缆长度取决于横截面积以及直流回路所需的电压和电流。

如果将交流线路电抗器安装在距 PSM 510 较远的位置，则昀大电缆距离为 5 米。

5.10.1.1 将 1 个 PSM 510 连接到交流电抗器
将 PSM 510 连接到带有适用于 PSM 510 的功率规格的正确交流电抗器的电网。

STATUS PSM
DEV
SVS ST
NET ST

LINK/ACT
X1
X2

LCP LCP

STATUS DAM
DEV
SVS ST
NET ST
AUX

LINK/ACT
X1
X2
X3

e3
0b

i2
35

.1
1

PS
M

 5
10

D
A

M
 5

10

. . .

图解 42: 将 1 个 PSM 510 连接到交流电抗器

5.10.1.2 将 2 个 PSM 510 模块连接到交流电抗器
将 PSM 510 模块连接到同一交流电抗器，如图解 43 所示。

确保所用的电抗器是与 PSM 510 模块的总功率相匹配的正确规格。

使用 2 个 PSM 510 模块时，交流线路电抗器和每个 PSM 510 之间的线缆长度必须相同，容差在 0.5 米内。

将每个 PSM 510 直接连接到交流电抗器。不允许将线缆并联。
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图解 43: 将 2 个 PSM 510 模块连接到交流电抗器

5.10.1.3 将 2 个 PSM 510 模块连接到带有系统拆分装置的交流电抗器
无论负载位置如何（比如，安装在系统拆分装置之前或之后），将 PSM 510 模块连接到同一交流电抗器，如图解 44 所示。

确保所用的电抗器是与 PSM 510 模块的总功率相匹配的正确规格。

使用 2 个 PSM 510 模块时，交流线路电抗器和每个 PSM 510 之间的线缆长度必须相同，容差在 0.5 米内。

将每个 PSM 510 直接连接到交流电抗器。不允许将线缆并联。
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图解 44: 将 2 个 PSM 510 模块连接到带有系统拆分装置的交流电抗器

如果使用 2 个交流电抗器（每个 PSM 510 一个）且两个 PSM 510 模块都安装在系统拆分装置的同一侧，则允许将降容设置为
等于交流电抗器的容差，即 60 kW。例如，降容 10% 后为 54 kW。

如果使用 2 个交流电抗器（每个 PSM 510 一个）且一个 PSM 510 模块安装在系统拆分装置之前，另一个安装在该装置之后，
则必须均衡分配负载。否则，两个 PSM 510 模块的降容将等于交流电抗器的容差。例如，容差为 10% + 10%，则表示降容
20%。

如果使用 2 个交流电抗器（每个 PSM 510 一个）且一个 PSM 510 模块安装在系统拆分装置之前，另一个安装在该装置之后，
则将一半负载设置在系统拆分装置之前，将另一半负载设置在系统拆分装置之后，且允许将降容设置为等于交流电抗器的容
差，即 60 kW。例如，降容 10% 后为 54 kW。

注 意

有关 EXM 510 模块和接线的更多信息，位于 11.9.13 扩展模块连接器 中。

5.10.2 连接电源模块 PSM 510 上的电缆

5.10.2.1 连接电源模块 PSM 510 顶部的电缆

1 2

34567

e3
0b

g4
65

.1
1

图解 45: PSM 510 顶部的连接器
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1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

1.

2.

3.

a.

b.

4.

1 以太网连接器输入端 (X1 IN)

2 以太网连接器输出端 (X2 OUT)

3 24/48 V 输入连接器 (INPUT 24/48 V)

4 STO 连接器输入端 (STO PSM)

5 STO 连接器输出端 (STO PSM)

6 I/O 连接器 (I/O PSM)

7 继电器连接器 (REL PSM)

步骤

将以太网电缆从 PLC 连接到以太网输入连接器（X1 输入）[1]。

将以太网电缆从以太网输出连接器（X2 输出）[2] 连接到下一模块。

将线缆插入到 24/48 V 输入（输入 24/48 V）连接器中。

插入 24/48 V 输入连接器 [3]。

将线缆插入 STO 连接器输入 (STO PSM) 连接器中。

插入 STO 连接器输入连接器 [4]。

将线缆插入 STO 连接器输出 (STO PSM) 连接器中。

插入 STO 连接器输出连接器 [5]。

如果需要 I/O，将线缆插入 I/O 连接器中，然后插入连接器 (I/O PSM) [6]。

如果需要继电器，将线缆插入继电器连接器中，然后插入连接器 (REL PSM) [7]。

5.10.2.2 连接电源模块 PSM 510 底部的电缆

2
1

3

4

e3
0b

g4
66

.1
0

图解 46: PSM 510 底部的连接器

1 用于插入未用的内部制动电阻器连接器的支座

2 交流主电源连接器

3 PE 螺钉

4 内部/外部制动电阻器连接器

步骤

将线缆插入到交流电源连接器中。

插入交流电源连接器 [2] 中。

如果需要使用外部制动电阻器：

拔下内部制动电阻器连接器 [4] 然后将外部制动连接器插入到位。

将内部制动电阻器连接器插入到内部制动连接器座 [1] 中。

使用正面的一个 PE 螺钉 [3] 和 PE 线缆将 PSM 510 连接到 PE。紧固力矩为 3 Nm。
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1.

2.

3.

4.

5.11 连接分布式访问模块 (DAM 510)

5.11.1 连接分布式访问模块 DAM 510 顶部的电缆

1 2

345

e
3

0
b

g
4

6
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.1
0

图解 47: DAM 510 顶部的连接器

1 以太网连接器输入端 (X1 IN)

2 以太网连接器输出端 (X3 OUT)

3 STO 连接器输入端 (STO DAM)

4 STO 连接器输出端 (STO DAM)

5 外部编码器连接器 (E DAM)

步骤

使用以太网电缆将上一模块的输出端连接到输入连接器 (X1 IN) [1]。

将线缆从上一模块的 STO 输出插入 24 V 输入（STO 输入）连接器，参见 11.9.9.2.1 DAM 510 顶部的 STO 连接器。

将 24 V 输入（STO 连接器输入端 (STO DAM)）连接器 [3] 插入到 DAM 510 中。

如果需要，连接外部编码器连接器 [5]。

5.11.2 连接馈电电缆

1234

e
3

0
b

g
4

6
8

.1
0

图解 48: DAM 510 底部的连接器

1 以太网连接器

2 AUX 连接器

3 STO 输出连接器

4 UDC 连接器

AQ262449648484zh-000201 / 175R113574 | Danfoss A/S © 2020.10

电气安装

VLT® Servo Drive System ISD 510/DSD 510

操作指南



1

26

117
80

10
20

87

18

10

7

2
3

4
5

6
7

8

9
e3

0b
g8

06
.1
0

图解 49: 馈电电缆

1 屏蔽层

2 UDC+（黑色，2.5 mm2/4 mm2）

3 UDC–（灰色，2.5 mm2/4 mm2）

4 STO+（粉色，0.5 mm2）

5 STO–（灰色，0.5 mm2）

6 AUX+（红色，2.5 mm2）

7 AUX–（蓝色，2.5 mm2）

8 以太网/现场总线（绿色，RJ45 连接器）

9 PE（黄色/绿色，2.5 mm2/4 mm2，叉形接线头）

1

2

3

4
5

6

e3
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g8
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图解 50: 连接馈电电缆

1 馈电电缆 PE 螺钉

2 总线连接器

3 馈电电缆的扎带

4 STO 电缆的线箍

5 EMC 板

6 EMC 板螺钉

步骤
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1.

2.

3.

4.

5.

6.

7.

1.

2.

3.

4.

将线缆插入 UDC、AUX 和 STO 连接器中。

使用电缆扎带 [3] 固定馈电电缆，确保屏蔽区域恰好位于电缆扎带下。

使用电缆线箍 [4] 固定 STO 电缆，确保屏蔽层恰好位于电缆线箍下。

将馈电电缆上的连接器插入到 DAM 510 上的对应端子块中。

拧紧 EMC 板上的螺钉 [6]。紧固力矩为 3 Nm。

插入 RJ45 总线连接器 [2]。

使用正面的一个 PE 螺钉 [1] 和 PE 线缆将 DAM 510 连接到 PE。紧固力矩为 3 Nm。

5.12 连接辅助电容器模块 ACM 510

e3
0b

h3
50

.1
11 2

4

5

3

图解 51: ACM 510 顶部的连接器

1 以太网连接器输入端 (X1 IN)

2 以太网连接器输出端 (X2 OUT)

3 I/O 连接器 (I/O ACM)

4 继电器连接器 (REL ACM)

步骤

使用以太网电缆将上一系统模块的输出端连接到输入连接器 (X1 IN) [1]。

如果需要 I/O，将线缆插入 I/O 连接器 (I/O ACM) 中，然后插入连接器 [3]。

如果需要继电器，将线缆插入继电器连接器 (REL ACM) 中，然后插入连接器 [4]。

使用正面的一个 PE 螺钉 [5] 和 PE 线缆将 ACM 510 连接到 PE。紧固力矩为 3 Nm。

5.13 连接扩展模块 EXM 510

12

5315
8

1

2

3

4

5

6

7

e3
0b

h6
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0

图解 52: 扩展模块电缆

1 24/48 V

2 GND

3 功能地

4 DC–

5 DC–

6 DC+

7 DC+

8 屏蔽层
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4.

5.

6.
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图解 53: 连接扩展模块 EXM 510

1 EMC 屏蔽板螺钉

2 PE 螺钉

3 直流电缆

4 功能地电缆

5 GND 电缆

6 24/48 V 电缆

7 电缆扎带

注 意

如果使用两个单独的背部链路（通过 1 或 2 对 EXM 510 模块连接），还必须使用横截面积为 16 mm2 (6 AWG) 的电缆

将 2 个接地汇流条连接在一起。

有关电缆横截面积，参见 11.9.13.1 EXM 510 的电缆横截面积。

步骤

将线缆 [3]、[4]、[5] 和 [6] 插入扩展连接器中。

使用电缆扎带 [7] 固定直流电缆 [3]，确保屏蔽区域恰好位于电缆扎带下。

使用电缆扎带 [7] 固定电缆 [4]、[5] 和 [6]。

将连接器插入背板中。

拧紧 EMC 屏蔽板 [1] 上的螺钉。紧固力矩为 3 Nm。

使用 PE 螺钉 [2] 和 PE 线缆将 EXM 510 连接至 PE。紧固力矩为 3 Nm。

5.14 连接 PSM 510 上的制动电阻器
PSM 510 连接到内部制动电阻器，如图解 54 所示。

或者，也可将 PSM 510 连接到外部制动电阻器。在此情况下，PSM 510 上的内部制动电阻器必须保持未连接状态，可将连接器
置于内部制动电阻器连接器座中。

不允许并联或串联制动电阻器。
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STATUS PSM
DEV
SVS ST
NET ST

LINK/ACT
X1
X2

LCP

1
e3

0b
h4

23
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0
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M

 5
10

图解 54: 连接 1 个 PSM 510 上的内部制动电阻器

1 内部制动电阻器

使用 2 个 PSM 510 模块时，将每个 PSM 510 连接到各自的内部制动电阻器，如图解 55（出厂设置）中所示。

2 个 PSM 510 模块的允许替代配置为：

将一个 PSM 510 连接到内部制动电阻器，另一个连接到外部制动电阻器。

两个 PSM 510 模块都连接到外部制动电阻器。在此情况下，PSM 510 上的内部制动电阻器必须保持未连接状态，可将连接
器置于内部制动电阻器连接器座中（请参阅 5.10.2.2 连接电源模块 PSM 510 底部的电缆）。

不允许并联或串联制动电阻器。

AQ262449648484zh-000201 / 175R113578 | Danfoss A/S © 2020.10

电气安装

VLT® Servo Drive System ISD 510/DSD 510

操作指南



STATUS PSM
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STATUS PSM
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图解 55: 连接 2 个并联 PSM 510 模块上的制动电阻器

1 内部制动电阻器
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2.

3.

4.

5.

1.

2.

3.

4.

5.

6.

7.

-

6 调试

6.1 调试警告

警 告
意外启动

伺服系统包含连接到电网的伺服驱动器、PSM 510 和 DAM 510，可随时开始运行。这可能由现场总线命令、参考值信号或消

除故障状态的操作引发。伺服驱动器和所有连接的设备都必须具有良好运行状况。将设备连接到电网后，存在缺陷的运行状

况可能导致死亡、严重伤害、设备损坏或其他实质性损坏。

采取适合措施防止意外启动。

6.2 预调试检查表
在初次调试前以及在长时间停机或存储后开始运行前，请务必完成这些检查。
步骤

检查机械和电气组件的所有螺纹连接器是否牢靠拧紧。

检查能否确保冷却空气自由流动（入口和出口）。

检查电气连接是否正确。

确保已为可能会变得很烫的旋转部件和表面准备好接触防护装置。

如果使用 STO 功能，则执行功能安全概念启用测试（请参阅 8.8 启用测试）。

6.3 EtherCAT® ID 分配
EtherCATÆ 无需特殊 ID 分配（IP 地址）。仅当通过 VLTÆ Servo Toolbox 软件使用间接通信时，才需要特殊 ID 分配。

6.4 以太网 POWERLINK® ID 分配

6.4.1 概述
使用 VLTÆ Servo Toolbox 为设备分配 ID 时，不得激活以太网 POWERLINKÆ 主站通信。仅当使用非循环以太网 POWERLINKÆ

通信时，才能通过 VLTÆ Servo Toolbox 分配 ID。如果已启动以太网 POWERLINKÆ 循环通信，则重新启动以停止它。

设置 ID 之前，断开 PLC 连接并重新启动。或者，在 POWERLINKÆ 界面中，在 Service Mode（维护模式）下重启计算机，同

时，将参数 Basic Ethernet in Service Mode（维护模式下的基本以太网）设置为 Basic Ethernet enabled（已启用基本以

太网）。

6.4.2 单设备 ID 分配
为单个设备分配 ID 时，使用 VLTÆ Servo Toolbox 中的 Device Information（设备信息）窗口（请参阅 VLT Servo Drive

System ISD 510、DSD 510、MSD 510 (VLT® Flexmotionô ) 编程指南了解更多信息）。

此外，还可通过 LCP 将一个 ID 分配给一个设备。

6.4.2.1 在伺服驱动器或系统模块上直接设置节点 ID
所有与 IP 相关的参数都位于参数组 12-0* IP Settings（12-0* IP 设置）中。根据以太网 POWERLINKÆ 标准，IP 地址固定

为 192.168.100.xxx。昀后一个数字是参数 12-60 Node ID（12-60 节点 ID）中的值。对于参数 12-02 Subnet Mask（12-02

子网掩码），IP 地址固定为 255.255.255.0，无法更改。
操作步骤

将 LCP 连接到应更改 节点 ID 的伺服驱动器或系统模块。

按 Hand On（手动启动）按钮并保持 1 秒以上以将 LCP 设置为控制界面。

按 Main Menu（主菜单）按钮，向下滚动到子菜单 12-** Ethernet（12-** 以太网）然后按 OK（确定）。

向下滚动到子菜单 12-6* Ethernet POWERLINK（12-6* 以太网 POWERLINK）然后按 OK（确定）。

将 PSM 510/DAM 510 节点 ID 更改为所需值 (1–239)。

按 OK（确定）以确认选定内容，然后等待 ID 分配过程完成。

执行重启以确保所有 ID 更改都生效且能够在现场总线上正常工作。
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4.
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6.

7.

8.

9.

10.

11.

12.

a.

b.

c.

13.

•

•

•

•

•

•

•

•

•

•

1.

2.

3.

6.4.2.2 通过 LCP 为连接到电源模块 (PSM 510) 或分布式访问模块 (DAM 510) 的单个伺服驱
动器设置节点 ID
当 LCP 连接到 PSM 510 或 DAM 510 时，还可更改伺服驱动器的节点 ID。此功能包括在子组 54-1* Manual（54-1* 手动）中

的参数组 54-** ID Assignment（54-** ID 分配）中。
步骤

将 LCP 连接到特定 PSM 510/DAM 510，后者已连接到应更改节点 ID 的伺服驱动器和系统模块。

按 Hand On（手动启动）按钮并保持 1 秒以上以将 LCP 设置为 PSM 510/DAM 510 的控制界面。

按 Main Menu（主菜单）按钮，向下滚动到子菜单 12-** Ethernet（12-** 以太网）然后按 OK（确定）。

向下滚动到子菜单 12-6* Ethernet POWERLINK（12-6* 以太网 POWERLINK）然后按 OK（确定）。

通过按 OK（确定）按钮，将 PSM 510/DAM 510 节点 ID 更改为所需值 (1–239) 。

返回到 Main Menu（主菜单），然后选择参数 54-** ID Assignment（54-** ID 分配）。

选择参数 54-1* Manual（54-1* 手动）。

仅限 PSM 510： 在参数 54-01 Epl id assignment line（54-01 Epl ID 分配线路）中，选择以太网端口 X1 或 X2。

PSM 510 将通过所选端口和现场总线网络把 ID 分配给选定设备。在 DAM 510 端口上，将自动使用 X2。

选择参数 54-12 Epl ID assignment start id（54-12 Epl ID 分配启动 ID）然后选择一个有效值 (1–239)。该值

将被分配给指定位置索引处的设备。连接到 LCP 的 PSM 510/DAM 510 处于位置 0，选定端口上第一个可用设备位于位
置索引 1，以此类推。

选择参数 54-14 Manual Epl ID assignment start（54-14 手动 Epl ID 分配启动），然后将状态从 [0] ready（[0]

就绪）更改为 [1] start（[1] 启动）。

按 OK（确定）以确认选定内容，然后等待 ID 分配过程完成。

使用以下参数检查 ID 分配是否已成功完成：

参数 54-15 Epl ID assignment state（54-15 Epl ID 分配状态）

参数 54-16 Epl ID assignment error code（54-16 Epl ID 分配错误代码）

参数 54-17 Epl ID assignment device count（54-17 Epl ID 分配设备计数）

执行重启以确保所有 ID 更改都生效且能够在现场总线上正常工作。

如果在 ID 分配过程中出错，则 LCP 上将显示出检测到的错误。可能会报告以下错误：

无效 NMT 状态

无效备粒

无效以太网端口

无效节点 ID

ID 分配失败

MAC 地址重复

无效软件版本

不完整的分配

找不到设备

内部错误

6.4.3 多设备 ID 分配
为多个设备分配 ID 时（例如，设置一个新网络时），使用 VLTÆ Servo Toolbox 子工具 DAM ID assignment（DAM ID 分配）

（请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 (VLT® Flexmotionô ) 编程指南了解更多信息）。

同时为连接到分布式访问模块 (DAM 510) 或电源模块 (PSM 510) 的所有伺服驱动器设置 ID 时，当 DAM 510/PSM 510 连接有
LCP 时，还可通过 LCP 来完成。

6.4.3.1 设置分布式访问模块 (DAM 510)/电源模块 (PSM 510) 线路上的所有伺服驱动器和系
统模块的节点 ID
使用自动 PSM 510/DAM 510 ID 分配功能，可自动设置指定 PSM 510/DAM 510 线路的所有伺服驱动器和系统模块上的节点 ID。

此功能包括在子组 54-0* Automatic（54-0* 自动）中的参数组 54- ** ID Assignment（54-** ID 分配）中。
步骤

将 LCP 连接到特定 PSM 510/DAM 510，后者已连接到应更改节点 ID 的伺服驱动器和系统模块。

按 Hand On（手动启动）按钮并保持 1 秒以上以将 LCP 设置为 PSM 510/DAM 510 的控制界面。

按 Main Menu（主菜单）按钮，向下滚动到子菜单 12-** Ethernet（12-** 以太网）然后按 OK（确定）。
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向下滚动到子菜单 12-6* Ethernet POWERLINK（12-6* 以太网 POWERLINK）然后按 OK（确定）。

通过按 OK（确定）按钮，将 PSM 510/DAM 510 节点 ID 更改为所需值 (1–239) 。

返回到 Main Menu（主菜单），然后选择参数 54-** ID Assignment（54-** ID 分配）。

选择参数 54-0* Automatic（54-0* 自动）。

仅限 PSM 510： 在参数 54-01 Epl id assignment line（54-01 Epl ID 分配线路）中，选择以太网端口 X1 或 X2。

PSM 510 将通过所选端口和现场总线网络把 ID 分配给选定设备。在 DAM 510 端口上，将自动使用 X2。

选择参数 54-02 Epl ID assignment start id（54-02 Epl ID 分配启动 ID）然后选择一个有效值 (1–239)。该值

将被分配给指定位置索引处的设备。连接到 LCP 的 PSM 510/DAM 510 处于位置 0，选定端口上第一个可用设备位于位
置索引 1，以此类推。

选择参数 54-03 Automatic Epl ID assignment start（54-03 自动 Epl ID 分配启动），然后将状态从 [0] ready

（[0] 就绪）更改为 [1] start（[1] 启动）。

按 OK（确定）以确认选定内容，然后等待 ID 分配过程完成。

使用以下参数检查 ID 分配是否已成功完成：

参数 54-04 Epl ID assignment state（54-04 Epl ID 分配状态）

参数 54-05 Epl ID assignment error code（54-05 Epl ID 分配错误代码）

参数 54-06 Epl ID assignment device count（54-06 Epl ID 分配设备计数）

执行重启以确保所有 ID 更改都生效且能够在现场总线上正常工作。

如果在 ID 分配过程中出错，则 LCP 上将显示出检测到的错误。可能会报告以下错误：

无效 NMT 状态

无效备粒

无效以太网端口

无效节点 ID

ID 分配失败

MAC 地址重复

无效软件版本

不完整的分配

找不到设备

内部错误

6.5 PROFINET® ID 分配
每个 PROFINETÆ 设备都需要一个设备名称和 IP 地址。建立与 I/O 设备的连接后，IP 地址和设备名称将由 I/O 控制器分

配。 

通过 VLTÆ Servo Toolbox 软件使用间接通信时，也需要进行 IP 地址分配（请参阅 VLT® Servo Drive System ISD 510,

DSD 510, MSD 510 (VLT® Flexmotionô  编程指南了解更多信息）。

IP 地址和设备名还可使用 PRONETA 分配，这是一个支持 PROFINETÆ 网络分析和配置的免费工具。

6.6 加电时间
系统模块的昀长加电时间为 15 秒。这是指，从使用辅助电源为系统供电到模块完全初始化所需的时间。

列出的加电时间是相应的状态指示时间。模块的准确状态可通过状态字查看。

注 意

在所有系统模块全都正确加电之前，请勿操作任何系统模块。

如果并联安装 2 个 PSM510 模块，则同时为两个 PSM 510 模块加电（昀多延迟 1 秒）。

6.7 系统模块充电时间
系统充电时间由每个单独系统模块的昀长充电时间决定。

每个模块的准确状态可通过状态字查看。
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注 意

在所有系统模块或分布式驱动器全都完全充电之前，请勿操作任何系统模块或分布式驱动器。在将 ISD 510/DSD 510 置
于状态 Operation enabled（允许运行）之前，等待 PSM 510、DAM 510 和 ACM 510 进入状态 Operation enabled（允

许运行）。

表 25: PSM 510、DAM 510 和 ACM 510 的直流回路 (UDC) 充电时间

规格 单位 PSM 510 DAM 510 ACM 510

UDC 充电时间 s 2.0 2.0 3.5

6.8 打开 ISD 510/DSD 510 系统
在对 ISD 510/DSD 510 伺服驱动器模块加电前，完成伺服系统的接线。此线路可为伺服系统提供电源电压和通信信号。这是
ISD 510/DSD 510 伺服驱动器正常工作的基本要求。

伺服系统可以 2 种方式打开：

如果电源模块 (PSM 510) 通过主电源、STO 和 UAUX 供电，则建立与 PSM 510 内部控制器的通信，直流回路和 UAUX 通过

背部链路自动传输到 DAM 510，然后进一步传输到所连接的伺服驱动器。

如果电源模式 (PSM 510) 仅通过 UAUX 供电，则 PSM 510、DAM 510 和伺服驱动器控制装置运行。

6.8.1 打开 ISD 510/DSD 510 系统的操作步骤
步骤

打开 UAUX 电源，与 PSM 510、DAM 510 和 ISD 510/DSD 510 伺服驱动器建立通信。

打开主电源。

将 PSM 510 设置为状态 Normal operation（正常运行）。

将 DAM 510 设置为状态 Normal operation（正常运行）。

现在 PSM 510、DAM 510 和 ISD 510/DSD 510 伺服驱动器即可运行了。

6.9 库
为 ISD 510 系统提供的库可在以下工具中使用：

TwinCATÆ V2 和 V3

SIMOTION SCOUTÆ V5.2：

V4.4 中的 C240

V4.4 中的 D410-2

V4.4 中的 D425-2

V4.4 中的 D435-2

V4.4 中的 D445-2

V4.4 中的 D455-2

V4.4 中的 P320

Automation Studioô  环境（版本 3.0.90 和 4.x，支持的平台 SG4），可轻松集成功能，而无需控制器上具有专用运动运

行时。

V15 中的 TiA

提供的功能块符合 PLCopenÆ 标准。不必具备有关基础现场总线通信和/或 CANopenÆ CiA DS 402 行规的知识。

库中包含：

用于控制和监测 ISD 510/DSD 510 伺服驱动器和系统模块的功能块。

用于 ISD 510/DSD 510 伺服驱动器的所有可用运动命令的功能块。

用于控制和监测 PSM 510、DAM 510 和 ACM 510 的功能块。

用于创建基本 CAM 轨迹的功能块和结构。

用于创建标记 CAM 轨迹的功能块和结构。
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6.10 使用 Automation Studio™ 编程

6.10.1 使用 Automation Studio™ 编程的要求
要将 ISD 510/DSD 510 伺服驱动器和系统模块集成到 Automation Studioô  项目中，需要使用以下文件：

用于 ISD 510 伺服系统的库文件包： Danfoss_VLT_ServoMotion_V_x_y_z.zip

用于标准型 ISD 510 伺服驱动器的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_ISD510_S.xdd

用于高级型 ISD 510 伺服驱动器的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_ISD510_A.xdd

用于标准型 DSD 510 伺服驱动器的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_DSD510_S.xdd

用于高级型 DSD 510 伺服驱动器的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_DSD510_A.xdd

用于电源模块 (PSM 510) 的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_PSM.xdd

用于分布式访问模块 (DAM 510) 的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_DAM.xdd

用于辅助电容器模块 (ACM 510) 的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_ACM.xdd

6.10.2 创建 Automation Studio™ 项目
除非另外指明，否则，本章中所述的操作步骤适用于 Automation Studioô  版本 3.0.90 和 V4.x。

有关如何安装 Automation Studioô  的详细信息，请参阅 Automation Studioô  帮助。打开 B&R Help Explorer（B&R 帮助

管理器）然后转到 [Automation software → Software Installation → Automation Studio]（自动化软件 → 软件安装 →
Automation Studio）。

有关如何在 Automation Studioô  中创建项目的详细信息，请参阅 Automation Studioô  帮助。

V3.0.90：

打开 B&R Help Explorer（B&R 帮助管理器）然后转到 [Automation Software → Getting Started → Creating programs
with Automation Studio → First project with X20 CPU]（自动化软件 → 入门 → 使用 Automation Studio 创建程序
→ 使用 X20 CPU 的第一个项目）。

V4.x：

打开 B&R Help Explorer（B&R 帮助管理器）然后转到 [Automation Software → Getting Started → Creating programs
with Automation Studio → Example project for a target system with CompactFlash]（自动化软件 → 入门 → 在
Automation Studio 中创建程序 → 使用 CompactFlash 的目标系统的示例项目）。

6.10.3 在 Automation Studio™ 项目中包括伺服运动库
操作步骤

在 Logical View（逻辑视图）中，打开菜单条目 [File → Import...]（文件 → 导入...）。

在下一窗口中，选择 Danfoss_VLT_ServoMotion_V_x_y_z.zip 文件（根据在硬盘上的位置）。

单击 Open（打开）。

在下一窗口中，将库分配给 CPU。

单击 Finish（完成）。现在，库已被集成到 Automation Studioô  项目中。

在集成过程中，将创建包含 ISD 库的新文件夹：

DDS_Drive

包含由 PLCopenÆ 定义的程序组织单元 (POU)（名称以 MC_ 开头）和由 Danfoss 定义的 POU（名称以 DD_

开头）。DanfossPOU 为轴提供附加功能。

可组合使用由 PLCopenÆ 定义的 POU 和由 Danfoss 定义的 POU。

面向伺服驱动器的 POU 的名称全都以 _DDS 结尾。

DDS_PSM

包含由 Danfoss 定义的 POU（名称以 DD_ 开头），为电源模块 (PSM) 提供功能。

面向 PSM 的 POU 的名称全都以 _PSM 结尾。

DDS_DAM

包含由 Danfoss 定义的 POU（名称以 DD_ 开头），为分布式访问模块 (DAM) 提供功能。

面向 DAM 的 POU 的名称全都以 _DAM 结尾。

DDS_ACM
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包含由 Danfoss 定义的 POU（名称以 DD_ 开头），为辅助电容器模块 (ACM) 提供功能。

面向 ACM 的 POU 的名称全都以 _ACM 结尾。

DDS_BasCam

包含用于创建基本 CAM 的 POU。

DDS_LabCam

包含用于创建标记 CAM 的 POU。

DDS_Intern

包含使用库时内部需要的 POU。

请不要在应用程序中使用这些 POU。

集成 DDS_Drive 文件包时，将自动集成一些标准库，除非这些库已是项目的组成部分。

e
3

0
b

g
3

3
7

.1
0

图解 56: 标准库

注 意

请勿删除这些库，否则，Danfoss 伺服运动库将无法使用。

6.10.4 DDS_Drive 库内的常量
在该库内，定义了以下列出的常量：

Danfoss_VLT_ServoMotion

包含库的版本信息。

DDS_AxisErrorCodes

轴的错误代码的常量。

可使用功能块 MC_ReadAxisError_DDS 和/或 DD_ReadAxisWarning_DDS 读取错误代码。

DDS_AxisTraceSignals

轴的轨迹信号的常量。

适合与功能块 DD_Trace_DDS 一起使用。

DDS_BasCam

用于创建基本 CAM 的常量。

DDS_CamParsingErrors

分析 CAM 问题的常量。

错误原因由功率块 MC_CamTableSelect_DDS 返回。

DDS_FB_ErrorConstants
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POU 内错误的常量。

原因在所有 POU 中都可用的输出 ErrorInfo.ErrorID 中提供。

DDS_Intern

库在系统内部需要的常量。

它们不适合在应用中使用。

DDS_LabCam

用于创建标记 CAM 的常量。

DDS_SdoAbortCodes

有关读取和写入参数的错误的常量。

原因在多个 POU 中可用的输出 AbortCode 中提供。

PSM_ErrorCodes

电源模块 (PSM 510) 的错误代码的常量。

可使用功能块 DD_ReadPsmError_PSM 和/或 DD_ReadPsmWarning_PSM 读取错误代码。

PSM_TraceSignals

电源模块 (PSM 510) 的轨迹信号的常量。

适合与功能块 DD_Trace_PSM 一起使用。

DAM_ErrorCodes

分布式访问模块 (DAM 510) 的错误代码的常量。

可使用功能块 DD_ReadDamError_DAM 和/或 DD_ReadDamWarning_DAM 读取错误代码。

DAM_TraceSignals

分布式访问模块 (DAM 510) 的轨迹信号的常量。

适合与功能块 DD_Trace_DAM 一起使用。

ACM_ErrorCodes

辅助电容器模块 (ACM 510) 的错误代码的常量。

可使用功能块 DD_ReadAcmError_ACM 和/或 DD_ReadAcmWarning_ACM 读取错误代码。

ACM_TraceSignals

辅助电容器模块 (ACM 510) 的轨迹信号的常量。

适合与功能块 DD_Trace_ACM 一起使用。

6.10.5 在 Automation Studio™ 中实例化 AXIS_REF_DDS
步骤

为必须控制或监测的每个伺服驱动器创建功能块 AXIS_REF_DDS（位于文件夹 DDS_Drive 中）的一个实例。 

要创建指向物理伺服驱动器的链接，将 AXIS_REF_DDS 的每个实例链接到 1 个物理伺服驱动器。这将使它成为一个物

理伺服驱动器的逻辑表示。

打开 Logical View（逻辑视图）。

使用其节点编号和所连接到的插槽的名称（如，IF3）初始化每个实例。

使用 DriveType 初始化每个驱动器实例。
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示例

图解 57: AXIS_REF_DDS 的实例化和初始值的设置

6.10.6 在 Automation Studio™ 中实例化 PSM_REF
步骤

为每个必须控制或监测的电源模块 (PSM) 创建功能块 PSM_REF（位于文件夹 DDS_PSM 中）的一个实例。 

要创建指向物理 PSM 的链接，将 PSM_REF 的每个实例都链接到一个物理 PSM。这将使它成为一个物理 PSM 的逻辑表

示。

打开 Logical View（逻辑视图）。

使用其节点编号和所连接到的插槽的名称（如，IF3）初始化每个实例。

6.10.7 在 Automation Studio™ 中实例化 DAM_REF
步骤

为每个必须控制或监测的分布式访问模块 (DAM) 创建功能块 DAM_REF（位于文件夹 DDS_DAM 中）的一个实例。 

要创建指向物理 DAM 的链接，将 DAM_REF 的每个实例都链接到一个物理 DAM。这将使它成为一个物理 DAM 的逻辑表

示。

打开 Logical View（逻辑视图）。

使用其节点编号和所连接到的插槽的名称（如，IF3）初始化每个实例。

6.10.8 在 Automation Studio™ 中实例化 ACM_REF
步骤

为每个必须控制或监测的辅助电容器模块 (ACM) 创建功能块 ACM_REF（位于文件夹 DDS_ACM 中）的一个实例。 

要创建指向物理 ACM 的链接，将 ACM_REF 的每个实例都链接到一个物理 ACM。这将使它成为一个物理 ACM 的逻辑表

示。

打开 Logical View（逻辑视图）。

使用其节点编号和所连接到的插槽的名称（如，IF3）初始化每个实例。

6.10.9 将伺服驱动器导入到 Automation Studio™ 中

注 意

对于每个物理伺服驱动器，在 Automation Studioô  的 Physical View（物理视图）中添加一个条目。

6.10.9.1 版本 V3.0.90
操作步骤
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选择菜单项 [Tools → Import Fieldbus Device...]（工具 → 导入现场总线设备...）。

从硬盘上的相应位置选择 XDD 文件（例如，0x0300008D_ISD510_S.xdd 或 0x0300008D_ISD510_A.xdd）。对于每个项

目，仅需执行一次此导入。然后，Automation Studioô  将能识别该设备。

现在，在 Physical View（物理视图）中，为控制器的以太网 POWERLINKÆ 接口添加伺服驱动器：

在 Physical View（物理视图）中，右键单击相应控制器，然后选择 [Open POWERLINK]（打开 POWERLINK）。

右键单击该接口然后选择 Insert..（插入..）。

在 Select controller module（选择控制器模块）窗口中，在组 POWERLINK Devices（POWERLINK 设备）中选择

伺服驱动器。

单击 Next（下一步）。

在下一窗口中，输入伺服驱动器的节点数量。

e3
0b

h5
13

.1
0

图解 58: 在 V3.0.90 中为项目添加伺服驱动器

6.10.9.2 版本 V4.x
操作步骤

选择菜单项 [Tools → Import Fieldbus Device...]（工具 → 导入现场总线设备...）。

从硬盘上的相应位置选择 XDD 文件（例如，0x0300008D_ISD510_S.xdd 或 0x0300008D_ISD510_A.xdd）。然后，Au‐

tomation Studioô  将能识别该设备。

现在，在 Physical View（物理视图）中，为控制器的以太网 POWERLINKÆ 接口添加伺服驱动器：

选择菜单项 [Open → System Designer]（打开 → 系统设计器）以打开 System Designer（系统设计器）。

要在 Physical View（物理视图）或 System Designer（系统设计器）中添加硬件模块，在 Hardware Catalog（硬

件目录）工具箱中的组 POWERLINK 中选择伺服驱动器。

将选定模块拖到目标位置以将它连接到所选硬件模块、网络接口或插槽。

要更改节点编号，右键单击相应设备然后选择 [Node Number → Change Node Number]（节点编号 → 更改节点编
号）。
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图解 59: 在 V4.x 中为项目添加伺服驱动器

6.10.10 将 PSM 510、DAM 510 和 ACM 510 导入到 Automation Studio™ 中

注 意

对于每个物理电源模块 (PSM 510)、分布式访问模块 (DAM 510) 和辅助电容器模块 (ACM 510)，在 Automation Studioô

的 Physical View（物理视图）中添加一个条目。

6.10.10.1 版本 V3.0.90
步骤

选择菜单项 [Tools → Import Fieldbus Device...]（工具 → 导入现场总线设备...）。

从硬盘上的相应位置选择 PSM 510、DAM 510 或 ACM 510 的 XDD 文件。对于每个项目，仅需执行一次此导入。然后，
Automation Studioô  将能识别该设备。

电源模块 (PSM 510)： 0x0300008D_PSM.xdd

分布式访问模块 (DAM 510)： 0x0300008D_DAM.xdd

辅助电容器模块 (ACM 510)： 0x0300008D_ACM.xdd

现在，在 Physical View（物理视图）中，为控制器的以太网 POWERLINKÆ 接口添加 PSM 510、DAM 510 或 ACM 510：

在 Physical View（物理视图）中，右键单击相应控制器，然后选择 [Open POWERLINK]（打开 POWERLINK）。

右键单击该接口然后选择 Insert...（插入..）。

在 Select controller module（选择控制器模块）窗口中，在组 POWERLINK Devices（POWERLINK 设备）中选择

PSM 510、DAM 510 或 ACM 510。

单击 Next（下一步）。

在下一窗口中，输入 PSM 510、DAM 510 或 ACM 510 的节点数量。
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0

图解 60: 在 V3.0.90 中，为以太网 POWERLINKÆ 接口添加了 1 个 PSM 510、1 个 DAM 510 和 2 个 ISD 510 伺服驱动器

6.10.10.2 版本 V4.x
步骤

选择菜单项 [Tools → Import Fieldbus Device...]（工具 → 导入现场总线设备...）。
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从硬盘上的相应位置选择 PSM 510、DAM 510 或 ACM 510 的 XDD 文件。然后，Automation Studioô  将能识别该设备。

电源模块 (PSM 510)： 0x0300008D_PSM.xdd

分布式访问模块 (DAM 510)： 0x0300008D_DAM.xdd

辅助电容器模块 (ACM 510)： 0x0300008D_ACM.xdd

现在，在 Physical View（物理视图）中，为控制器的以太网 POWERLINKÆ 接口添加 PSM 510、DAM 510 或 ACM 510：

选择菜单项 [Open → System Designer]（打开 → 系统设计器）以打开 System Designer（系统设计器）。

要在 Physical View（物理视图）或 System Designer（系统设计器）中添加硬件模块，在 Hardware Catalog（硬

件目录）工具箱中的组 POWERLINK 中选择 PSM 510、DAM 510 或 ACM 510。

将选定模块拖到目标位置以将它连接到所选硬件模块、网络接口或插槽。

要更改节点编号，右键单击相应设备然后选择 [Node Number → Change Node Number]（节点编号 → 更改节点编
号）。

PSM： Danfoss _VLT_R_PSM

DAM： Danfoss _VLT_R_DAM

ACM： Danfoss _VLT_R_ACM
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图解 61: 在 V4.x 中，为以太网 POWERLINKÆ 接口添加了 1 个 PSM 510、1 个 DAM 510 和 2 个 ISD 510 伺服驱动器

6.10.11 I/O 配置和 I/O 映射
步骤

对 ISD 510/DSD 510 伺服驱动器的 I/O 配置进行参数化，以便库有权访问所有必需对象。

右键单击 ISD 510/DSD 510 伺服驱动器的条目，然后，在 V3.0.90 中，选择 Open I/O Configuration（打开

I/O 配置），在 V4.x 中， 选择 Configuration（配置）。

在 Channels（通道）部分，更改以下对象的 Cyclic transmission（循环传输）：

将对象 0x5050 (Lib pdo rx_I5050 ARRAY[]) 的所有子索引更改为 Write（写入）。

将对象 0x5051 (Lib pdo tx_I5051 ARRAY[]) 的所有子索引更改为 Read（读取）。

对电源模块 (PSM 510)、分布式访问模块 (DAM 510) 和辅助电容器模块 (ACM 510) 的 I/O 配置进行参数化，以便库
有权访问所有必需对象。

右键单击 PSM/DAM/ACM 的条目，然后，在 V3.0.90 中，选择 Open I/O Configuration（打开 I/O 配置），在

V4.x 中， 选择 Configuration（配置）。

在 Channels（通道）部分，更改以下对象的 Cyclic transmission（循环传输）：

将对象 0x5050 (Lib pdo rx_I5050 ARRAY[]) 的所有子索引更改为 Write（写入）。

将对象 0x5051 (Lib pdo tx_I5051 ARRAY[]) 的所有子索引更改为 Read（读取）。

这些设置用于配置与设备的循环通信。要使库正常工作，必须对这些参数进行设置。

注 意

可使用复制和粘贴功能向同一类型的多个设备应用同一 I/O 配置。
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对于伺服驱动器和 PSM/DAM/ACM，将 Module supervised（监督的模块）设置为 off（关闭）。可在设备的 I/O 配置

中找到该参数。
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图解 62: ISD 510 设备的 I/O 配置
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图解 63: 成功配置后的 I/O 配置
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映射 AXIS_REF_DDS 功能块的实例的输入和输出以及 ISD 510 伺服驱动器的物理数据点（其中，myAxis 是 AX‐

IS_REF_DDS 的一个实例）：
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图解 64: ISD 510 伺服驱动器的 I/O 映射

分别映射 PSM_REF、DAM_REF 和 ACM_REF 功能块的实例的输入和输出以及 PSM/DAM/ACM 的物理数据点。

6.10.12 设置 PLC 周期时间
昀短周期时间为 400 µs。伺服系统设备运行以太网 POWERLINKÆ 的周期时间可以为 400 µs 和 500 µs 的倍数。这些设备在

启动时由 PLC 自动参数化，具体取决于物理接口的 POWERLINKÆ 配置。要访问以太网 POWERLINKÆ 配置：对于 V3.0.90，在

Physical View（物理视 图）中，右键单击 [CPU → Open IF3 POWERLINK Configuration]（CPU → 打开 IF3 POWERLINK 配

置）；对于 V4.x，右键单击 [PLK → Configuration]（PLK → 配置）。

注 意

确保 PLC 程序的任务周期时间与以太网 POWERLINKÆ 周期时间相同。否则，数据可能会丢失，性能将降低。
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图解 65: 用于参数化以太网 POWERLINKÆ 周期时间的以太网 POWERLINK<Æ 配置窗口

在 Automation Studio 中设置 PLC 时间的操作步骤晳

在 Physical View（物理视图）中，对于 V3.0.90，右键单击 [CPU → Open Software Configuration]（CPU → 打

开软件配置），对于 V4.x，右键单击 [CPU → Configuration → Timing]（CPU → 配置 → 定时）。

确保 PLC 周期时间与以太网 POWERLINKÆ 周期时间相同。

6.10.13 连接到 PLC
有关如何连接到 PLC 的详细信息，请参阅 Automation Studioô  帮助。

版本 V3.0.90：

打开 B&R Help Explorer（B&R 帮助管理器）然后转到 [Automation Software → Getting Started → Creating programs

with Automation Studio → First project with X20 CPU → Configure online connection]（自动化软件 → 入门 → 使
用 Automation Studio 创建程序 → 使用 X20 CPU 的第一个项目 → 配置联机连接）。

版本 V4.x：
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打开 B&R Help Explorer（B&R 帮助管理器）然后转到 [Automation Software → Getting Started → Creating programs

in Automation Studio → Example project for a target system with CompactFlash]（自动化软件 → 入门 → 在 Au‐
tomation Studio 中创建程序 → 使用 CompactFlash 的目标系统的示例项目）。

6.11 使用 TwinCAT® 编程

6.11.1 使用 TwinCAT® 编程的要求
要将 ISD 510/DSD 510 伺服驱动器和 PSM 510、DAM 510 或 ACM 510 集成到 TwinCATÆ 项目中，需要使用以下文件：

用于 ISD 510 伺服系统的库： Danfoss_VLT_ServoMotion_V_x_y_z.lib

用于标准型 ISD 510 伺服驱动器的 ESI 文件（EtherCATÆ Slave Information，从站设备描述）： Danfoss_ISD510_S.xml

用于高级 ISD 510 伺服驱动器的 ESI 文件（EtherCATÆ Slave Information，从站设备描述）： Danfoss_ISD510_A.xml

用于标准型 DSD 510 伺服驱动器的 ESI 文件（EtherCATÆ Slave Information，从站设备描述）： Danfoss_DSD510_S.xml

用于高级 DSD 510 伺服驱动器的 ESI 文件（EtherCATÆ Slave Information，从站设备描述）： Danfoss_DSD510_A.xml

用于电源模块的 ESI 文件（EtherCATÆ Slave Information，从站设备描述）： Danfoss_PSM510.xml

用于分布式访问模块的 ESI 文件（EtherCATÆ Slave Information，从站设备描述）： Danfoss_DAM510.xml

用于辅助电容器模块的 ESI 文件（EtherCATÆ Slave Information，从站设备描述）： Danfoss_ACM510.xml

6.11.2 创建 TwinCAT® 项目
有关如何安装 TwinCATÆ 的详细信息，请访问 Beckhoff 信息系统 (https://infosys.beckhoff.com/)。打开该信息系统，然

后选择 [TwinCAT 2 → TwinCAT Quick Start → Installation]（TwinCAT 2 → TwinCAT 快速入门 → 安装）。

有关如何在 TwinCATÆ 中创建项目的详细信息，请访问 Beckhoff 信息系统 (https://infosys.beckhoff.com/)。打开该信息

系统，然后选择 [TwinCAT 2 → TwinCAT Quick Start or TwinCAT 2 → TX1200 TwinCAT PLC → TwinCAT PLC Control]
（TwinCAT 2 → TwinCAT 快速入门或 TwinCAT 2 → TX1200 TwinCAT PLC → TwinCAT PLC Control）。

6.11.3 在 TwinCAT® 项目中包括 TwinCAT® 库
操作步骤

在 TwinCATÆ PLC Control 的 Resources（资源）选项卡中，打开 Library Manager（库管理器）。

在 Library Manager（库管理器）窗口的左上区域中，右键单击然后选择 Additional Library...（附加库...）。

选择 Danfoss_VLT_ServoMotion_V_x_y_z 文件（根据在硬盘上的位置）。

单击 Open（打开）。现在，库已被集成到 TwinCATÆ PLC Control 项目中。
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图解 66: 包括 ServoMotion 库后的库管理器
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在库内，POU 以文件夹形式来组织：

DDS_Drive

包含由 PLCopenÆ 定义的程序组织单元 (POU)（名称以 MC_ 开头）和由 Danfoss 定义的 POU（名称以 DD_

开头）。DanfossPOU 为轴提供附加功能。

可组合使用由 PLCopenÆ 定义的 POU 和由 Danfoss 定义的 POU。

面向伺服驱动器的 POU 的名称全都以 _DDS 结尾。

DDS_PSM

包含由 Danfoss 定义的 POU（名称以 DD_ 开头），为电源模块 (PSM 510) 提供功能。

面向 PSM 510 的 POU 的名称全都以 _PSM 结尾。

DDS_DAM

包含由 Danfoss 定义的 POU（名称以 DD_ 开头），为分布式访问模块 (DAM 510) 提供功能。

面向 DAM 510 的 POU 的名称全都以 _DAM 结尾。

DDS_ACM

包含由 Danfoss 定义的 POU（名称以 DD_ 开头），为辅助电容器模块 (ACM 510) 提供功能。

面向 ACM 510 的 POU 的名称全都以 _ACM 结尾。

DDS_BasCam

包含用于创建基本 CAM 的 POU。

DDS_LabCam

包含用于创建标记 CAM 的 POU。

DDS_Intern

包含使用库时内部需要的 POU。

请不要在应用程序中使用这些 POU。

集成 VLT® Integrated Servo Drive 库时，将自动集成一些标准库，除非这些库已是项目的组成部分。

注 意

请勿删除这些库，否则，DDS 库将无法使用。

6.11.4 DDS_Drive 库内的常量
在该库内，定义了以下列出的常量：

Danfoss_VLT_ServoMotion

包含库的版本信息。

DDS_AxisErrorCodes

轴的错误代码的常量。

可使用功能块 MC_ReadAxisError_DDS 和/或 DD_ReadAxisWarning_DDS 读取错误代码。

DDS_AxisTraceSignals

轴的轨迹信号的常量。

适合与功能块 DD_Trace_DDS 一起使用。

DDS_BasCam

用于创建基本 CAM 的常量。

DDS_CamParsingErrors

分析 CAM 问题的常量。

错误原因由功率块 MC_CamTableSelect_DDS 返回。

DDS_FB_ErrorConstants
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POU 内错误的常量。

原因在所有 POU 中都可用的输出 ErrorInfo.ErrorID 中提供。

DDS_Intern

库在系统内部需要的常量。

它们不适合在应用中使用。

DDS_LabCam

用于创建标记 CAM 的常量。

DDS_SdoAbortCodes

有关读取和写入参数的错误的常量。

原因在多个 POU 中可用的输出 AbortCode 中提供。

PSM_ErrorCodes

电源模块 (PSM 510) 的错误代码的常量。

可使用功能块 DD_ReadPsmError_PSM 和/或 DD_ReadPsmWarning_PSM 读取错误代码。

PSM_TraceSignals

电源模块 (PSM 510) 的轨迹信号的常量。

适合与功能块 DD_Trace_PSM 一起使用。

DAM_ErrorCodes

分布式访问模块 (DAM 510) 的错误代码的常量。

可使用功能块 DD_ReadDamError_DAM 和/或 DD_ReadDamWarning_DAM 读取错误代码。

DAM_TraceSignals

分布式访问模块 (DAM 510) 的轨迹信号的常量。

适合与功能块 DD_Trace_DAM 一起使用。

ACM_ErrorCodes

辅助电容器模块 (ACM 510) 的错误代码的常量。

可使用功能块 DD_ReadAcmError_ACM 和/或 DD_ReadAcmWarning_ACM 读取错误代码。

ACM_TraceSignals

辅助电容器模块 (ACM 510) 的轨迹信号的常量。

适合与功能块 DD_Trace_ACM 一起使用。

6.11.5 在 TwinCAT® 中实例化 AXIS_REF_DDS
步骤

为必须控制或监测的 ISD 510 伺服驱动器创建功能块 AXIS_REF_DDS（位于文件夹 DDS_Drive 中）的一个实例。
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对每个其他伺服驱动器重复步骤 1。

示例
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图解 67: AXIS_REF_DDS 的实例化

6.11.6 在 TwinCAT® 中实例化 PSM_REF
步骤

为每个必须控制或监测的电源模块创建功能块 PSM_REF（位于文件夹 DDS_PSM 中）的一个实例。

对其他每个其他 PSM 510 重复步骤 1。

6.11.7 在 TwinCAT® 中实例化 DAM_REF
步骤

为每个必须控制或监测的分布式访问模块创建功能块 DAM_REF（位于文件夹 DDS_DAM 中）的一个实例。

对其他每个其他 DAM 510 重复步骤 1。

6.11.8 在 TwinCAT® 中实例化 ACM_REF
步骤

为每个必须控制或监测的辅助电容器创建功能块 ACM_REF（位于文件夹 DDS_ACM 中）的一个实例。

对其他每个 ACM 510 重复步骤 1。

6.11.9 在 TwinCAT® System Manager 中添加 PLC 项目
要在 TwinCATÆ PLC Control 项目和 TwinCATÆ System Manager 之间创建链接，将保存的项目连接到 TwinCATÆ System

Manager，尤其是输入和输出：
步骤

要在 TwinCATÆ System Manager 中添加项目信息，右键单击 PLC-Configuration（PLC 配置）然后选择 Append PLC

project...（添加 PLC 项目...）。

在 Insert IEC 1131 Project（插入 IEC 1131 项目）窗口中，根据硬盘上的位置选择项目信息文件。该文件与 PLC

项目具有相同名称，但文件扩展名为 .tpy。

单击 Open（打开）。

6.11.10 将设备导入 TwinCAT®
以下操作步骤是如何将 ISD 510 伺服驱动器导入到 TwinCATÆ 中的示例。

步骤

将 ESI 文件 Danfoss ISD 510 S.xml 复制到硬盘上的文件夹 TwinCAT Installation Folder\Io\EtherCAT 中。对

于每个项目，仅需执行一次此操作。TwinCATÆ System Manager 自动在启动过程中在硬盘上的此位置搜索 ESI 文件。

要添加一个 EtherCATÆ 主站，右键单击 [I/O-Configuration → I/O Devices]（I/O 配置 → I/O 设备）然后选择

Append Device...（附加设备...）。
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在以下窗口中，选择 [EtherCAT → EtherCAT] 然后单击 OK（确定）。
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图解 68: 在项目中添加 EtherCAT 主站

选择 Device 1 (EtherCAT)（设备 1 (EtherCAT)）然后在 Adapter（适配器）选项卡中的窗口右侧选择正确的 Network

Adapter（网络适配器）。

要添加一个电源模块，右键单击 Device1 (EtherCAT)（设备 1 (EtherCAT)）然后选择 Append Box...（附加框...）。

在 Insert EtherCAT Device（插入 EtherCAT 设备）窗口中，选择 [Danfoss GmbH → VLTÆ FlexMotion → VLTÆ

Power Supply Module PSM 510] 然后单击 OK（确定）。

要添加一个分布式访问模块，右键单击 Device1 (EtherCAT)（设备 1 (EtherCAT)）然后选择 Append Box...（附加

框...）。

在 Insert EtherCAT Device（插入 EtherCAT 设备）窗口中，选择 [Danfoss GmbH → VLTÆ FlexMotion → VLTÆ

Decentral Access Module] 然后单击 OK（确定）。

要添加一个辅助电容器模块，右键单击 Device1 (EtherCAT)（设备 1 (EtherCAT)）然后选择 Append Box...（附加

框...）。

在 Insert EtherCAT Device（插入 EtherCAT 设备）窗口中，选择 [Danfoss GmbH → VLTÆ FlexMotion → VLTÆ

Auxiliary Capacitors Module] 然后单击 OK（确定）。

要在分布式访问模块 DAM 510 中添加伺服驱动器，右键单击 Box 1 (VLT® Decentral Access Module)（框 1 (VLT®

Decentral Access Module)）然后选择 Append Box...（附加框...）。
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

在 Insert EtherCAT Device（插入 EtherCAT 设备）窗口中，选择 [Danfoss GmbH → VLTÆ FlexMotion → VLTÆISD

510 Integrated Servo Drive Standard] 然后单击 OK（确定）。
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0

图解 69: 为项目添加伺服驱动器
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图解 70: 附加 PLC 项目并添加分布式访问模块和 2 个 ISD 510 伺服驱动器后的 TwinCAT System Manager

如果将伺服驱动器用作 NC 轴，则对问题回答 No（否）。如果要将伺服驱动器用作 NC 轴，则请参阅 6.11.15 配置为

TwinCAT® NC 轴。

注 意

对于每个物理伺服驱动器、PSM 510、DAM 510 和 ACM 510，在 TwinCAT System Manager 的 EtherCATÆ 主站中

添加一个条目。将伺服驱动器添加到正确的 DAM 510 线路。

6.11.11 I/O 配置和 I/O 映射
连接多个 ISD 510/DSD 510 伺服驱动器时，将上一伺服驱动器的端口 C (X2) 连接到下一伺服驱动器的端口 A (X1)。此外，
为分布式访问模块 (DAM 510) 执行端口分配。

如果已显示出硬件设置选项，则可使用 TwinCATÆ System Manager Scan devices（扫描设备）功能按正确顺序自动将连接的

设备添加到配置。

使用 TwinCATÆ System Manager，配置 ISD 510/DSD 510 伺服驱动器，以便 PDO 映射与库的要求相匹配。

操作步骤（以 ISD 510 伺服驱动器为例）
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6.



1.

2.



3.

-

-

单击 ISD 510 伺服驱动器项。

在右侧窗口中选择 Slots（插槽）选项卡。

通过选择 Slot（插槽）框中的 Module 1 (CSV PDO)（ 模块 1 (CSV PDO)）条目，删除当前 PDO 配置。

单击 X。

在 Module（模块）框中选择 Library PDO（库 PDO）。

单击 <。

e3
0b

g3
53

.1
1

图解 71: 具有正确 I/O 配置的 ISD 510 伺服驱动器

6.11.12 将输入和输出变量与物理数据点相关联
使用 TwinCATÆ System Manager，可将 PLC 程序的输入和输出变量与设备的物理输入和输出相关联。这可确保库能够访问所

有必需的对象。

警 告

对 Box 1 (VLTÆ Power Supply Module)（框 1 (VLT Power Supply Module)）和实例 myPSM 重复步骤 2–22。

对 Box 2 (VLTÆ Decentral Access Module)（框 2 (VLT Decentral Access Module)）和实例 myDAM 重复步骤 2–

22。

操作步骤

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCAT) → Box 1 (VLT Decentral
Access Module) → Drive 1 (VLT ISD 510 Integrated Servo Drive) → Module 1 (Library PDO) → Library
TxPDO]（I/O 配置 → I/O 设备 → 设备 1 (EtherCAT) → 框 1 (VLT Decentral Access Module) → 驱动器 1
(VLT ISD 510 Integrated Servo Drive) → 模块 1（库 PDO）→ 库 TxPDO），然后选择 Library TxPDO（库 TxPDO）。

选择窗口右侧从 Lib pdo tx1 至 Lib pdo tx9 的所有条目。

e3
0b

h5
19

.1
0

图解 72: 将输入和输出与物理数据点相关联

右键单击然后选择 Change Multi Link...（更改多链路...）。
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5.
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8.

9.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

在 Attach Variable 36.0 Byte(s) (Input)（关联变量 36.0 字节（输入））窗口中，选择 [PLC-Configuration →

MyFirstFlexMotionProject → Standard → .myAxis.TPDO]（PLC 配置 → MyFirstFlexMotionProject → 标准
→ .myAxis.TPDO）。确保在 Attach Variable（关联变量）窗口中选中 Matching Size（匹配大小）选项。

单击 OK（确定）。

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCATô ) → Box1 (VLTô  Decentral

Access Module) → Drive2 (VLTô  ISD 510 Integrated Servo Drive) → Module1 (Library PDO) → Library

RxPDO]（I/O 配置 → I/O 设备 → 设备 1 (EtherCAT) → 框 1 (VLT Decentral Access Module) → 驱动器 2
(VLT ISD 510 Integrated Servo Drive) → 模块 1（库 PDO）→ 库 RxPDO），然后单击库 RxPDO。

选择窗口右侧从 Lib pdo rx1 至 Lib pdo rx9 的所有条目。

右键单击然后选择 Change Multi Link...（更改多链路...）。

在 Attach Variable 36.0 Byte(s) (Output)（关联变量 36.0 字节（输出））窗口中，选择 [PLC-Configuration →

MyFirstIsd510Project → Standard → .myAxis.RPDO]（PLC 配置 → MyFirstIsd510Project → 标准 → .myAx‐
is.RPDO）。

单击 OK（确定）。

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCATô ) → Box1 (VLTô  Decentral

Access Module) → Drive2 (VLTô  ISD 510 Integrated Servo Drive) → WcState]（I/O 配置 → I/O 设备 → 设

备 1 (EtherCAT) → 框 1 (VLT Decentral Access Module) → 驱动器 2 (VLT ISD 510 Integrated Servo Drive)
→ WcState），右键单击 WcState，然后选择 Change Link...（更改链路...）。

在 Attach Variable State (Input)（关联变量状态（输入））窗口中，选择 [PLC-Configuration → MyFirst‐

Isd510Project → Standard → .myAxis.WcState]（PLC 配置 → MyFirstIsd510Project → 标准 → .myAx‐
is.WcState）。

单击 OK（确定）。

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCATô ) → Box1 (VLTô  Decentral

Access Module) → Drive2 (VLTô  ISD 510 Integrated Servo Drive) → InfoData]（I/O 配置 → I/O 设备 →

设备 1 (EtherCAT) → 框 1 (VLT Decentral Access Module) → 驱动器 2 (VLT ISD 510 Integrated Servo
Drive) → InfoData），右键单击 State（状态），然后选择 Change Link...（更改链路...）。

在 Attach Variable State (Input)（关联变量状态（输入））窗口中，选择 [PLC-Configuration → MyFirst‐

Isd510Project → Standard → .myAxis.State]（PLC 配置 → MyFirstIsd510Project → 标准 → .myAx‐
is.State）。

单击 OK（确定）。

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCAT→) → Box1 (VLTÆ Decentral

Access Module) → Drive2 (VLT ISD 510 Integrated Servo Drive) → InfoData → AdsAddr]（I/O 配置 → I/O
设备 → 设备 1 (EtherCAT) → 框 1 (VLT Decentral Access Module) → 驱动器 2 (VLT ISD 510 Integrated
Servo Drive) → InfoData → AdsAddr），右键单击 netId，然后选择 Change Link...（更改链路...）。

在 Attach Variable netId (Input)（关联变量 netId（输入））窗口中，选择 [PLC-Configuration → MyFirst‐

Isd510Project → Standard → .myAxis.AmsNetId]（PLC 配置 → MyFirstIsd510Project → 标准 → .myAx‐
is.AmsNetId）。

单击 OK（确定）。

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCAT→) → Box1 (VLT Decentral
Access Module) → Drive2 (VLT ISD 510 Integrated Servo Drive) → InfoData → AdsAddr]（I/O 配置 → I/O
设备 → 设备 1 (EtherCAT) → 框 1 (VLT Decentral Access Module) → 驱动器 2 (VLT ISD 510 Integrated
Servo Drive) → InfoData → AdsAddr），右键单击 Port（端口），然后选择 Change Link...（更改链路...）。

在 Attach Variable port (Input)（关联变量端口（输入））窗口中，选择 [PLC-Configuration → MyFirst‐

Isd510Project → Standard → .myAxis.NodeNumber]（PLC 配置 → MyFirstIsd510Project → 标准 → .myAx‐
is.NodeNumber）。

单击 OK（确定）。

6.11.13 将映射传回 PLC 程序
要将映射传回 PLC 程序，在菜单项 Actions（操作）中选择 Activate Configuration...（激活配置...）。

在 TwinCATÆ PLC Control 中重建后，TwinCATÆ 配置如图解 73 所示（其中，myAxis 和 mySecondAxis 是 AXIS_REF_DDS 的

实例，myPSM 是 PSM_REF 的实例，myDAM 是 DAM_REF 的实例）。具体地址可能不同。
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图解 73: TwinCATÆ 配置： 2 个伺服驱动器、1 个 PSM 510 和 1 个 DAM 510 的 I/O 映射

注 意

将 PSM 510、DAM 510 和 ACM 510 连接到一个同步单元，将 ISD 510/DSD 510 伺服驱动器连接到另一个单元。如果由于
错误而关闭了伺服驱动器的 UAUX 电源，则可防止与 PSM 510 和 DAM 510 的通信中断。

6.11.14 在 TwinCAT® PLC Control 中设置 PLC 周期时间
昀短周期时间为 400 µs。ISD 510 设备运行的 EtherCATÆ 周期时间为 400 µs 或 500 µs 的倍数。这些设备在启动时由

PLC 自动参数化，具体取决于物理接口的 EtherCATÆ 配置。要访问系统基础时间，在 TwinCATÆ System Manager 中选择

[SYSTEM-Configuration → Real-Time Settings]（系统配置 → 实时设置）。然后，即可使用此基础时间的倍数来作为
EtherCATÆ 周期时间。

注 意

将 PLC 程序的任务周期时间设置为与 EtherCATÆ 周期时间相同。否则，数据可能会丢失，性能将降低。

步骤

在 Resources（资源）选项卡中双击 Task configuration（任务配置）。

确保 PLC 周期时间与 EtherCATÆ 周期时间相同。

e
3

0
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g
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5
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0

图解 74: 用于参数化 PLC 周期时间的任务配置
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注 意

在 TwinCAT® PLC Control 中更改任务周期时间后，在 TwinCAT® System Manager 内执行 PLC 配置的

ReScan 以更新设置。然后，激活 PLC 中的配置。

6.11.15 配置为 TwinCAT® NC 轴
伺服驱动器可与 TwinCATÆ 的内置 NC 功能一起使用。 与 PSM 510 和 DAM 510 相关的一切都必须按 6.11.2 创建 TwinCAT®

项目中所述执行。
步骤

除 Danfoss_VLT_ServoMotion_V_x_y_z.lib 文件外，包括 TcMC2.lib 文件。

为每个用作 NC 轴的 ISD 510/DSD 510 伺服驱动器创建一个 AXIS_REF（而不是 AXIS_REF_DDS）实例。

在 TwinCATÆ System Manager 中附加 PLC 项目，导入设备然后将它们添加到 TwinCATÆ 中，但是，在昀后一步，如

果将伺服驱动器用作 NC 轴，则对问题回答 Yes（是）。然后，将自动创建 NC 任务。

6.11.15.1 用作 NC 轴的伺服驱动器的 I/O 配置
在 TwinCATÆ System Manager 中，为用作 NC 轴的伺服驱动器选择一个不同 I/O 配置。

操作步骤

根据要使用的运行模式，选择插槽 CSP PDO 或 CSV PDO。默认情况下，已映射并预先选定 CSV PDO。如果需要使用

VLT® Integrated Servo Drive 伺服驱动器来与 CSP PDO 一起使用，则映射以下变量：

在 NC 轴的 Settings（设置）选项卡中，选择 [NC-Configuration → NC-Task 1 SAF → Axes → Axis 1]（NC

配置 → NC 任务 1 SAF → 轴 → 轴 1）。单击 Link To (all Types)...（链接到（所有类型）...）按钮，然后

选择目标伺服驱动器。

在同一选项卡中，选择首选 Unit（单位）。

根据所选单位，通过 Parameter（参数）选项卡中的菜单 [NC-Configuration → NC-Task 1 SAF → Axes → Axis 1

→ Axis 1_Enc]（NC 配置 → NC 任务 1 SAF → 轴 → 轴 1 → 轴 1_Enc）为轴编码器调整 Scaling Factor（标定

因数）。示例： 当选中单位 Degrees（度）时，标定因数为 360°/220 = 0.00034332275390625。

在菜单项中依次选择 [NC-Configuration → NC-Task 1 SAF → Axes → Axis 1 → Axis 1_Enc]（NC 配置 → NC
任务 1 SAF → 轴 → 轴 1 → 轴 1_Enc），然后在 Parameter（参数）选项卡中设置 Reference Velocity（参考速

度）。

将 Output Scaling Factor（输出标定因数）（速度）设置为 125。

在轴的 Online（联机）选项卡中，测试功能和配置。

6.11.16 连接到 PLC
有关如何连接到 PLC 的详细信息，请访问 Beckhoff Information System 。

打开信息系统然后转到 [TwinCAT 2 → TwinCAT System Manager → Operation → Controls → Choose Target System]
（TwinCAT 2 → TwinCAT System Manager → 操作 → 控制 → 选择目标系统）。

6.12 Automation Studio™ 和 TwinCAT® 编程指南
实施建议：

初始化通常不会在程序开始时只更改一次的参数。在 Automation Studioô  中，使用 _INIT 部分。

在程序开始时使用 Enable（启用）输入调用提供状态或错误信息的功能块。

对每个轴使用功能块 MC_Power_DDS 的一个实例来控制其功率级。在每个 PLC 循环中调用此功能块。

对于每个 PSM 510 使用功能块 DD_Power_PSM 的一个实例，以控制输出上的直流回路电压。在每个 PLC 循环中调用此功

能块。

对于每个 DAM 510 使用功能块 DD_Power_DAM 的一个实例，以控制输出上的直流回路电压。在每个 PLC 循环中调用此功

能块。

对于每个 ACM 510 使用功能块 DD_Power_ACM 的一个实例，以控制直流回路和 ACM 510 之间的连接。在每个 PLC 循环中

调用此功能块。

调用在程序结束时执行（运动）命令的功能块。

请勿使用任何来自库（文件夹）DDS_Intern 的 POU。

请勿在一个功能块正忙时更改对其轴的引用。
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注 意

完整参数列表可在 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) 编程指南中找到。

6.13 使用 SIMOTION SCOUT® 编程

6.13.1 使用 SIMOTION SCOUT® 编程的要求
要将伺服系统模块集成到 SIMOTION SCOUTÆ 项目中，需要使用以下文件： 在文件名中，2.xx 表示版本号，yyyymmdd 表示日

期。

表 26: 需要的文件

系统模块 需要的文件

整个伺服系统 用于 ISD 510 伺服系统的库文件包： Danfoss_VLT_ServoMotion_V_x_y_z.zip

联机帮助文件 (.chm)： 使用 SIMOTION SCOUT 编程Æ

伺服驱动器模块 SDM 511/SDM 512 GSDML 文件（通用站描述）：

GSDML-V2.xx-Danfoss-SDM-yyyymmdd.xml

集成伺服驱动器 ISD 510 GSDML 文件（通用站描述）：

GSDML-V2.xx-Danfoss-ISD-yyyymmdd.xml

分布式伺服驱动器 DSD 510 GSDML 文件（通用站描述）：

GSDML-V2.xx-Danfoss-DSD-yyyymmdd.xml

电源模块 PSM 510 GSDML 文件（通用站描述）：

GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

分布式访问模块 DAM 510 GSDML 文件（通用站描述）：

GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

辅助电容器模块 ACM 510 GSDML 文件（通用站描述）：

GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml

6.13.2 连接到 PLC
有关如何连接到 PLC 的详细信息，请参阅 SIMOTION SCOUTÆ 帮助。

打开 SIMOTION SCOUT®，转到 [Help → Help Topics → Getting Started with SIMOTION SCOUT → Download the project

to the target system → Connect to selected target devices → Go online]（帮助 → 帮助主题 → SIMOTION SCOUT
入门 → 将项目下载到目标系统 → 连接到所选目标设备 → 联机 ）。

6.13.3 创建 SIMOTION SCOUT® 项目
有关如何安装 SIMOTION SCOUT®Æ 的详细信息，请参阅 SIMOTION SCOUTÆ 配置手册。

注 意

必须安装带有 HF11 的 SIMATIC STEP 7 V5.5 或更高版本才能创建项目。

有关如何在 SIMOTION SCOUTÆ 中创建项目的详细信息，请参阅 SIMOTION SCOUTÆ 联机帮助。打开 SIMOTION SCOUTÆ 然后转至

[Help → Help Topics → Getting started with SIMOTION SCOUT → Create SIMOTION device and configure PG/PC
communication connection]（帮助 → 帮助主题 → SIMOTION SCOUT 入门 → 创建 SIMOTION 设备和配置 PG/PC 通信连
接）。
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6.13.4 在 SIMOTION SCOUT® 项目中包括伺服运动库
Project（项目）选项卡中的文件夹 LIBRARIES 包含以下库：

DDS_Drive

包含由 PLCopenÆ 定义的程序组织单元 (POU)（名称以 MC_ 开头）和由 Danfoss 定义的 POU（名称以 DD_ 开头）。

DanfossPOU 为伺服驱动器提供附加功能。

可组合使用由 PLCopenÆ 定义的 POU 和由 Danfoss 定义的 POU。

面向伺服驱动器的 POU 的名称全都以 _DDS 结尾。

DDS_PSM

包含由 Danfoss 定义的 POU（名称以 DD_ 开头），为电源模块 (PSM 510) 提供功能。

面向 PSM 510 的 POU 的名称全都以 _PSM 结尾。

DDS_DAM

包含由 Danfoss 定义的 POU（名称以 DD_ 开头），为分布式访问模块 (DAM 510) 提供功能。

面向 DAM 510 的 POU 的名称全都以 _DAM 结尾。

DDS_ACM

包含由 Danfoss 定义的 POU（名称以 DD_ 开头），为辅助电容器模块 (ACM 510) 提供功能。

面向 ACM 510 的 POU 的名称全都以 _ACM 结尾。

DDS_BasCam

包含用于创建基本 CAM 的 POU。

DDS_LabCam

包含用于创建标记 CAM 的 POU。

DDS_Intern

包含使用库时内部需要的 POU。

请不要在应用程序中使用这些 POU。

集成 DDS_Drive 文件包时，将自动集成一些标准库，除非这些库已是项目的组成部分。
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图解 75: 包括丹佛斯伺服运动库后的项目树

注 意

请勿删除或重命名这些库。

操作步骤

从 Danfoss_VLT_ServoMotion_V_x_y_z.zip 文件（根据在硬盘上的位置）解压文件。

必须将 DDS_Xxxx.xml 文件和 XML_DDS_Xxxx 文件夹置于同一文件夹下以导入库。
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2.



3.

4.

5.

1.

2.

3.

-

-

4.

-

-

-

-

在 Project（项目）选项卡中，右键单击 LIBRARIES（库），然后选择 [Export/import → Import folders/objects]

（导出/导入 → 导入文件夹/对象）。

e
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b

g
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5
8

.1
0

图解 76: 导入库

根据在硬盘上的位置选择文件 DDS_Intern.xml。

单击 OK（确定）。现在，库已被集成到 SIMOTION SCOUTÆ 项目中。

对 DDS_BasCam.xml、DDS_Drive.xml、DDS_LabCam.xml、DDS_PSM.xml、DDS_DAM.xml 和 DDS_ACM.xml 重复步骤 2–

4。

6.13.5 将设备导入 SIMOTION SCOUT®

注 意

对于每个物理伺服驱动器、PSM 510、DAM 510 或 ACM 510，在 HW Config（硬件配置）工具中的 PROFINETÆ 以太网中添

加一项。

步骤

打开 HW Config（硬件配置）工具。

选择 [Options → Install GSD File...]（选项 → 安装 GSD 文件...）。

要添加伺服驱动器，选择 xml 文件（根据在硬盘上的位置）然后单击 Install（安装）。在文件名中，2.xx 表示版本

号，yyyymmdd 表示日期。

GSDML-V2.xx-Danfoss-ISD-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DSD-yyyymmdd.xml

对以下模块重复步骤 2 和 3：

电源模块 (PSM 510)： GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

分布式访问模块 (DAM 510)：

GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

辅助电容器模块 (ACM 510)： GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml
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5.



6.



7.

8.

9.

10.

-

-

-

1.

-

-

将设备 Danfoss Drive Servo IRT 拖到现有 PROFINETÆ 以太网中。

在屏幕右侧的硬件目录中展开 PROFINET IO 条目然后选择 [Additional Field Devices → Drives → VLTÆ

FlexMotion]（附加现场设备 → 驱动器 → VLT FlexMotion），查找名为 Danfoss Drive Servo IRT 的伺服

驱动器设备。如果看不到该设备，则选择 [Options → Update catalog]（选项 → 更新目录）以更新硬件目
录。

在屏幕右侧的硬件目录中展开 Drive Object 1（驱动器对象 1）和文件夹 Profile，然后将 Danfoss Telegram（丹

佛斯报文）拖到屏幕底部的 Drive Object 1（驱动器对象 1）的可用插槽中。

e3
0b

h5
21

.1
0

图解 77: 将丹佛斯报文拖到可用插槽

要设置通信参数，在显示出以太网的主窗口中双击表示伺服驱动器的图标。

在 General（常规）选项卡中，在字段 Device name（设备名称）中输入一个名称。

在 General（常规）选项卡中，单击 Ethernet...（以太网...）按钮以设置伺服驱动器的 IP 地址，然后单击 OK（确

定）。

对以下模块重复步骤 6–9：

电源模块 (PSM 510)： VLT PSM IRT

分布式访问模块 (DAM 510)： VLT DAM IRT

辅助电容器模块 (ACM 510)： VLT ACM IRT

6.13.6 分配 IP 配置和设备名

注 意

如果在同一 PROFINETÆ 网络中使用了多个伺服驱动器，则每个伺服驱动器都必须具有不同名称和 IP 地址。

通过 VLTÆ Servo Toolbox 软件使用间接通信时，也需要进行 IP 地址分配（请参阅 VLT® Servo Drive System

ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) 编程指南了解更多信息）。

步骤

打开菜单 [PLC → Ethernet → Edit Ethernet Node]（PLC → 以太网 → 编辑以太网代码）。
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2.



3.



4.

在下一窗口中，单击 Browse（浏览）。
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h5
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.1
0

图解 78: 编辑以太网节点

此窗口中显示出所有可访问的以太网节点。

ISD 510 伺服驱动器在设备类型 VLT® ISD 510 下列出。

DSD 510 伺服驱动器在设备类型 VLT® DSD 510 下列出。

选择所需的伺服驱动器然后单击 OK（确定）（使用 Flash（快闪）按钮来识别特定伺服驱动器）。

e3
0b

h5
23

.1
0

图解 79: 选择伺服驱动器

在 Edit Ethernet Node（编辑以太网节点）窗口中，选择选项 Use IP parameters（使用 IP 参数）。
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5.



输入 IP address（IP 地址）和 Subnet mask（子网掩码）然后单击 Assign IP configuration（分配 IP 配置）。

e3
0b

h5
24

.1
0

图解 80: 输入 IP 地址和分配 IP 配置
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6.



1.

2.

3.

-

输入以前选择的设备名称，然后单击 Assign Name（分配名称），然后选择 Close（关闭）。

e3
0b

h5
25

.1
0

图解 81: 分配设备名称

6.13.7 创建同步域
同步域是一组同步到共用周期时钟的 PROFINETÆ 设备。一个设备的角色是同步主站（时钟发生器）。所有其他设备是同步从

站。

注 意

通过同步实时 (IRT) 交换数据的所有设备都必须属于同一同步域。

操作步骤

打开 HW Config（硬件配置）工具。

选择包含要参与 IRT 通信的 PROFINETÆ 设备的站点。

在 Station/IO system（站点/IO 系统）部分中选择 PROFINETÆ I/O 接口。
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4.



5.

6.

7.



8.

9.

选择菜单 [Edit → PROFINET IO → Domain management]（编辑 → PROFINET IO → 域管理）。

e3
0b

h5
26

.1
0

图解 82: 域管理

在 Sync Domain（同步域）选项卡中，在 Nodes（节点）区域的上部字段中选择站点。

在 Nodes（节点）区域的下部字段中，双击应配置为同步主站的设备。

出现 Device properties（设备属性）窗口后，为 Synchronization role（同步角色） 选择 Sync master（同步主

站），然后单击 OK（确定）。
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0b

h5
27
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0

图解 83: 设备属性： 同步主站

在 Domain management（域管理）窗口中，在 Nodes（节点）区域选中要配置为同步从站的所有设备（按住 CTRL 键

可选择多个设备）。

单击 Device Properties（设备属性）按钮。
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10.



11.

12.

13.

14.



15.

16.

在 Device Properties（设备属性）窗口中，为 Synchronization role（同步角色）选择 Sync slave（同步从站）

然后单击 OK（确定）。
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0

图解 84: 设备属性： 同步从站

在 Domain management（域管理）窗口中，单击 OK（确定）。

选择包含 PROFINETÆ 设备的站点。

选择菜单 [Edit → Object properties]（编辑 → 对象属性）。

在下一窗口中，打开 Isochronous Tasks（同步任务）选项卡，为 I/O 数据更改选择同步模式，然后单击 OK（确定）。
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0

图解 85: 使用与伺服同步的 I/O 数据

单击 VLT® ISD 510 IRT 设备。

在 Module（模块）中双击 PN-IRT-Inteface（PN-IRT 接口）。
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17.



1.

2.

3.

4.



5.

6.

在下一窗口中，打开 IO Cycle（IO 循环）选项卡，将字段 Assign IO device in isochronous mode（在同步模式下

分配 IO 设备）设置为 Servo（伺服）。
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0

图解 86: 在同步模式下分配 IO 设备

6.13.8 配置拓扑结构
必须配置拓扑结构并进行参数化。
操作步骤

打开 HW Config（硬件配置）工具。

为 PROFINETÆ I/O 系统或 PROFINETÆ 模块选择路径，比如 DanfossISD 510 系列。

选择菜单 [Edit → PROFINET IO → Topology]（编辑 → PROFINET IO → 拓扑结构）。

在下一窗口中，选择 Graphic view（图形视图）选项卡。
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0

图解 87: 拓扑结构编辑器中的“图形视图”选项卡

将 PROFINETÆ 设备与站点相连。按住鼠标左键，在两个端口之间绘制一条线，可在端口之间建立连接。

完成所有连接后，单击 OK（确定）。
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1.

2.

3.

4.



1.

2.

3.

4.

5.

6.13.9 定义发送时钟和更新时间

6.13.9.1 配置发送时钟时间
操作步骤

打开 HW Config（硬件配置）工具。

选择包含要参与 IRT 通信的 PROFINETÆ 设备的站点，比如 PNxIO。

选择菜单 [Edit → PROFINET IO → Domain management]（编辑 → PROFINET IO → 域管理）。

在下一窗口中，打开 Sync Domain（同步域）选项卡，在 Send clock time [ms]（发送时钟时间 [ms]）字段中，为

该过程选择一个适合的时间，例如 1.000 ms，然后单击 OK（确定）。
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图解 88: 为 PROFINETÆ IRT 配置发送时钟

6.13.9.2 配置更新时间
操作步骤

打开 HW Config（硬件配置）工具。

为 PROFINETÆ I/O 系统选择路径。

选择菜单 [Edit → Object properties]（编辑 → 对象属性）。

在下一窗口中，打开 Update Time（更新时间）选项卡，突出显示 I/O 设备，然后单击 Edit（编辑）按钮。

在下一窗口（Edit Update Time/Mode（编辑更新时间/模式））中，选择 Update Time（更新时间）然后单击 OK（确

定）。
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图解 89: 设置更新时间
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1.



2.



3.

-

-

-

-

-

-

-
-

注 意

PLC 程序的系统循环时钟必须与 PROFINETÆ 发送时钟相同，否则，可能会导致数据丢失、性能降低。

6.13.10 访问输入和输出
SIMOTION SCOUTÆ 通过使用 I/O 变量的循环任务的过程映像，提供对 SIMOTION 设备的输入和输出的访问权限。

操作步骤

打开 Project（项目）选项卡，双击设备子树中的 ADDRESS LIST（地址列表）元素，例如 C240 [C240 PN]。
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图解 90: 项目导航器中的地址列表

在下一窗口（详细视图）中，为每个设备的进出 PPO 数据创建一个变量。
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图解 91: 地址列表详细视图

为每个变量设置以下属性：

Name（名称）（I/O 变量的名称）

I/O address（I/O 地址）

Data type（数据类型）： ARRAY OF BYTE（字节数组）

Array length（数组长度）： 36

Process image（过程映像）： IPOsynchronousTask

注 意

I/O 地址必须适合 HW Config（硬件配置）工具中的设备配置。

I/O 变量只能在脱机模式下创建。

6.13.11 使用丹佛斯 VLT® Servo Motion Library 编程
使用库中的数据类型、功能或功能块之前，必须在接口部分使用以下构造：

USELIB DDS_BasCam、DDS_Drive、DDS_LabCam、DDS_PSM, DDS_DAM、DDS_ACM；
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-
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有关如何使用库中的数据类型、功能和功能块的详细信息，请参阅 SIMOTION SCOUTÆ 联机帮助。打开 SIMOTION SCOUT® 然后

转到 [Help → Help Topics → Programming → Integration of ST in SIMOTION → Using libraries → Using data
types, functions and function blocks from libraries]（帮助 → 帮助主题 → 编程 → 在 SIMOTION 中集成 ST → 使
用库 → 使用库中的数据类型、功能和功能块）。

注 意

请勿在应用程序中使用以 iDD_ 开头的 POU、常量和用户定义的数据类型 (UDT)。

6.13.12 在 SIMOTION SCOUT® 中实例化 AXIS_REF_DDS
为必须控制或监测的每个伺服驱动器创建 AXIS_REF_DDS（位于文件夹 DDS_Drive 中）的一个实例。每个 AXIS_REF_DDS 实例

都是一个物理伺服驱动器的逻辑表示。

注 意

必须将 AXIS_REF_DDS 结构的实例创建为一个全局变量（使用 VAR_GLOBAL 声明的单元的接口部分中的变量）。

在 AXIS_REF_DDS 结构中，仅在应用程序开始时为每个轴分配一次变量 InputLogAddress。这是指定 HW Config（硬件配置）

中的 I/O 模块的输入逻辑基础地址。对于此初始化，使用系统函数 _getLogicalAddressOfIoVariable()。仅在第一个 PLC

循环中分配一次变量 InputLogAddress 以进行初始化。

在 AXIS_REF_DDS 结构中，在应用程序开始时为每个循环中的每个轴分配变量 Quality。使用系统函数 _quality.<I/Ovari‐

able>，其中，<I/Ovariable> 是包含在 ADDRESS LIST（地址列表）中分配的循环数据的变量。在每个 PLC 循环中执行此分

配。

在应用程序开始时为每个循环中的每个设备调用函数 DD_UpdateProcessInput_DDS。在应用程序结束时为每个循环中的每个

设备调用函数 DD_UpdateProcessOutput_DDS。

注 意

在调用 DD_UpdateProcessInput 和 DD_UpdateProcessOutput 之间，仅创建操作说明和其他程序部分。

6.13.13 在 SIMOTION SCOUT® 中实例化 PSM_REF
为每个必须控制或监测的电源模块 (PSM 510) 创建 PSM_REF（位于文件夹 DDS_PSM 中）的一个实例。每个 PSM_REF 实例都是

一个物理 PSM 的逻辑表示。

注 意

必须将 PSM_REF 结构的实例创建为一个全局变量（使用 VAR_GLOBAL 声明的单元的接口部分中的变量）。

在 PSM_REF 结构中，在应用程序开始时为每个循环中的每个电源模块分配变量 Quality。使用系统函数 _quality.<I/

Ovariable>，其中，<I/Ovariable> 是包含在 ADDRESS LIST（地址列表）中分配的循环数据的变量。在每个 PLC 循环中执行

此分配。

在应用程序开始时为每个循环中的每个设备调用函数 DD_UpdateProcessInput_PSM。在应用程序结束时为每个循环中的每个

设备调用函数 DD_UpdateProcessOutput_PSM。

注 意

在调用 DD_UpdateProcessInput 和 DD_UpdateProcessOutput 之间，仅创建操作说明和其他程序部分。

6.13.14 在 SIMOTION SCOUT® 中实例化 DAM_REF
为每个必须控制或监测的分布式访问模块 (DAM 510) 创建 DAM_REF（位于文件夹 DDS_DAM 中）的一个实例。每个 DAM_REF 实

例都是一个物理 DAM 的逻辑表示。
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注 意

必须将 DAM_REF 结构的实例创建为一个全局变量（使用 VAR_GLOBAL 声明的单元的接口部分中的变量）。

在 DAM_REF 结构中，在应用程序开始时为每个循环中的每个分布式访问模块分配变量 Quality。使用系统函数 _quality.<I/

Ovariable>，其中，<I/Ovariable> 是包含在 ADDRESS LIST（地址列表）中分配的循环数据的变量。在每个 PLC 循环中执行

此分配。

在应用程序开始时为每个循环中的每个设备调用函数 DD_UpdateProcessInput_DAM。在应用程序结束时为每个循环中的每个

设备调用函数 DD_UpdateProcessOutput_DAM。

注 意

在调用 DD_UpdateProcessInput 和 DD_UpdateProcessOutput 之间，仅创建操作说明和其他程序部分。

6.13.15 在 SIMOTION SCOUT® 中实例化 ACM_REF
为每个必须控制或监测的辅助电容器模块 (ACM 510) 创建 ACM_REF（位于文件夹 DDS_ACM 中）的一个实例。每个 ACM_REF 实

例都是一个物理 ACM 的逻辑表示。

注 意

必须将 ACM_REF 结构的实例创建为一个全局变量（使用 VAR_GLOBAL 声明的单元的接口部分中的变量）。

在 ACM_REF 结构中，在应用程序开始时为每个循环中的每个辅助电容器模块分配变量 Quality。使用系统函数 _quality.<I/

Ovariable>，其中，<I/Ovariable> 是包含在 ADDRESS LIST（地址列表）中分配的循环数据的变量。在每个 PLC 循环中执行

此分配。

在应用程序开始时为每个循环中的每个设备调用函数 DD_UpdateProcessInput_ACM。在应用程序结束时为每个循环中的每个

设备调用函数 DD_UpdateProcessOutput_ACM。

注 意

在调用 DD_UpdateProcessInput 和 DD_UpdateProcessOutput 之间，仅创建操作说明和其他程序部分。

6.13.16 全局编译器设置
激活全局编译器设置 Permit language extensions（允许语言扩展）。
操作步骤

打开菜单 [Options → Settings]（选项 → 设置）。

在下一窗口中，选择 Compiler（编译器）选项卡。
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3.



1.

2.



3.

4.

5.

选中复选框 Permit language extensions（允许语言扩展）然后单击 OK（确定）。
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图解 92: 全局编译器设置

6.13.17 分配任务
要保证同步操作，应用程序必须使用 Synchronous Task（同步任务）和 Peripheral Fault Task（外设故障任务）来评估警

报。
操作步骤

打开 Project（项目）选项卡。

双击设备子树中的 EXECUTION SYSTEM（执行系统）。

e
3

0
b

g
3

7
0

.1
0

图解 93: 项目导航器中的执行系统

在下一窗口中，展开 Execution levels（执行级别）条目，然后在树结构中依次选择 OperationLevels（操作级别）

和 SynchronousTask（同步任务）。

在 SynchronousTask（同步任务）窗口中，选中复选框 Use task in execution system（使用执行系统中的任务）。

在树结构中单击新条目 IPOsynchronousTask（IPO 同步任务）。

AQ262449648484zh-000201 / 175R1135 | 119Danfoss A/S © 2020.10

调试

VLT® Servo Drive System ISD 510/DSD 510

操作指南



6.



7.



8.

9.

10.

11.

在 Synchronous Task（同步任务）窗口左侧的 Program assignment（程序分配）区域中，通过选择相应程序然后单

击 [>>] 按钮分配该程序。然后，该程序将被移至右侧的 Programs used（所用程序）区域。

e
3

0
b

g
3

7
1

.1
0

图解 94: 执行系统中的 IPOsynchronousTask（IPO 同步任务）

在 Task configuration（任务配置）选项卡中，将 Number of level overflows in the IPO cycle clock（IPO 循

环时钟中的溢出等级数）设置为 1，并将 IPOsynchronousTask / IPO cycle clock（IPO 同步任务/IPO 循环时钟）

设置为 50%。

e
3

0
b

g
3

7
2

.1
0

图解 95: IPO 同步任务配置

展开树结构中的 SystemInterruptTasks（系统中断任务），然后选择新条目 PeripheralFaultTask（外设错误任务）。

在 PeripheralFaultTask（外设错误任务）窗口 中，选中复选框 Use task in execution system（使用执行系统中

的任务）。

在 PeripheralFaultTask（外设错误任务）窗口左侧的 Program assignment（程序分配）区域中，通过选择相应程序

然后单击 [>>] 按钮分配该程序。然后，该程序将被移至右侧的 Programs used（所用程序）区域。

单击 Close（关闭）可保存和编辑设置。

6.14 SIMOTION SCOUT® 编程指南
实施建议：
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•

•

•

•

•

•

•

•

•

•

-

仅需在程序开始时，在 AXIS_REF_DDS 结构中为每个轴分配变量 InputLogAddress 一次。使用系统函数 _getLogica‐

lAddressOfIoVariable 从地址列表的 I/O 变量获取此地址。使用模块的输入地址作为 I/O 变量。仅在第一个 PLC 循环

中分配此变量以进行初始化。

初始化通常不会在程序开始时只更改一次的参数。

仅需在程序开始时，在 AXIS_REF_DDS 结构中为每个轴分配变量 Quality 一次。使用系统函数 _quality.var-name。为每

个 PLC 循环执行此检查。

为每个轴调用 DD_UpdateProcessInput_DDS 和 DD_UpdateProcessOutput_DDS 以更新输入和输出的过程映像分区。在每

个 PLC 循环中调用这些功能块。

在调用功能块 DD_UpdateProcessInput_DDS 和 DD_UpdateProcessOutput_DDS 之间，仅创建操作说明和其他程序部分。

在程序开始时使用 Enable（启用）输入调用提供状态或错误信息的功能块。

对每个轴使用功能块 MC_Power_DDS 的 1 个实例来控制其功率级。在每个 PLC 循环中调用此功能块。

对于每个 PSM 510 使用功能块 DD_Power_PSM 的 1 个实例，以控制输出线路上的直流回路电压。在每个 PLC 循环中调用

此功能块。

对于每个 DAM 510 使用功能块 DD_Power_DAM 的 1 个实例，以控制输出线路上的直流回路电压。在每个 PLC 循环中调用

此功能块。

对于每个 ACM 510 使用功能块 DD_Power_ACM 的 1 个实例，以控制输出线路上的直流回路电压。在每个 PLC 循环中调用

此功能块。

调用在程序结束时执行（运动）命令的功能块。

请勿使用名称以前縀 iDD_ 开头的任何 UDT、POU、枚举或常量。

请勿在一个功能块正忙时更改对其轴的引用。

6.15 使用 TIA 编程

6.15.1 使用 TIA 编程的要求
要将伺服系统模块集成到 TIA 项目中，需要使用以下文件。在文件名中，2.xx 表示版本号，yyyymmdd 表示日期。

表 27: 需要的文件

系统模块 需要的文件

整个伺服系统 用于 ISD 510 伺服系统的库文件包： Danfoss_VLT_ServoMotion_V_x_y_z.zalxx。

ISD 510 伺服驱动器 GSDML 文件（通用站描述）：

GSDML-V2.xx-Danfoss-ISD-yyyymmdd.xml

DSD 510 伺服驱动器 GSDML 文件（通用站描述）：

GSDML-V2.xx-Danfoss-DSD-yyyymmdd.xml

电源模块 PSM 510 GSDML 文件（通用站描述）：

GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

分布式访问模块 DAM 510 GSDML 文件（通用站描述）：

GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

辅助电容器模块 ACM 510 GSDML 文件（通用站描述）：

GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml

6.15.2 创建 TIA 项目

注 意

必须安装 TIA V15 或更高版本才能创建项目。
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-

-

-

•

-

-

•

-

-

•

-

-

•

-

•

-

•

-

-

1.

-

有关如何在 TIA 中创建项目的详细信息，请参阅 TIA 联机帮助。打开 TIA 然后转至 [Help → Information System →
Editing projects → Creating and managing projects]（帮助 → 信息系统 → 编辑项目 → 创建和管理项目）。

6.15.3 在 TIA 项目中包括伺服运动库
Project（项目）选项卡中的文件夹 LIBRARIES 包含以下库：

DDS_Drive

包含由 PLCopenÆ 定义的程序组织单元 (POU)（名称以 MC_ 开头）和由 Danfoss 定义的 POU（名称以 DD_ 开头）。

DanfossPOU 为伺服驱动器提供附加功能。

可组合使用由 PLCopenÆ 定义的 POU 和由 Danfoss 定义的 POU。

面向伺服驱动器的 POU 的名称全都以 _DDS 结尾。

DDS_PSM

包含由 Danfoss 定义的 POU（名称以 DD_ 开头），为电源模块 (PSM 510) 提供功能。

面向 PSM 510 的 POU 的名称全都以 _PSM 结尾。

DDS_DAM

包含由 Danfoss 定义的 POU（名称以 DD_ 开头），为分布式访问模块 (DAM 510) 提供功能。

面向 DAM 510 的 POU 的名称全都以 _DAM 结尾。

DDS_ACM

包含由 Danfoss 定义的 POU（名称以 DD_ 开头），为辅助电容器模块 (ACM 510) 提供功能。

面向 ACM 510 的 POU 的名称全都以 _ACM 结尾。

DDS_BasCam

包含用于创建基本 CAM 的 POU。

DDS_LabCam

包含用于创建标记 CAM 的 POU。

DDS_Intern

包含使用库时内部需要的 POU。

请不要在应用程序中使用这些 POU。

集成 DDS_Drive 文件包时，将自动集成一些标准库，除非这些库已是项目的组成部分。

注 意

请勿删除或重命名这些库。

1

2

4

3

e3
0b

i2
53

.1
0

图解 96: 包括伺服运动库

步骤

展开 Libraries（库）窗口 [1]，然后选择并展开 Global libraries（全局库）部分 [2]。
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2.

3.

1.

2.

3.

4.

-

-

5.

-

-

-

-

右键单击空区域 [3]，然后选择菜单项 Retrieve library...（检索库）[4]。

选择 Danfoss_VLT_ServoMotion_V_x_y_z.zal1x 文件（根据在硬盘上的位置）。

6.15.4 将设备导入 TIA

注 意

对于每个物理伺服驱动器、PSM 510、DAM 510 或 ACM 510，在 Hardware Catalog（硬件目录）中的 PROFINETÆ 以太网

中添加 1 个条目。

步骤

e3
0b

i2
54

.1
0

1

2

3

打开 Hardware Catalog（硬件目录）。

选择 [Options → Manage general station description files]（选项 → 管理通用站描述文件）

在选项卡 Installed GSDs（安装的 GSD）[1] 中，选择这些文件夹的源路径 [2]。

要添加伺服驱动器，选择一个 xml 文件 [3] 然后单击 Install（安装）。在文件名中，2.xx 表示版本号，yyyymmdd

表示日期。

GSDML-V2.xx-Danfoss-ISD-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DSD-yyyymmdd.xml

对以下模块重复步骤 2 和 3：

电源模块 (PSM 510)： GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

分布式访问模块 (DAM 510)：

GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-yyyymmdd.xml

辅助电容器模块 (ACM 510)： GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml
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1.

2.

3.

-

-

-

-

-

4.

5.

-

6.

-

-

7.

-

-

-

6.15.5 创建网络
步骤

e3
0b

i2
55

.1
0

1
2 3

54

在 Devices（设备）窗口中，选择 Device configuration（设备配置）[1] 然后添加一个 PSM。

将 PLC 图标 [2] 下面中间的方块拖放到 PSM 图标 [3] 左上角的方块上，将该 PSM 分配到 PLC_1。PN/IE_1 网络得
以自动创建。

为该 PSM 分配 PROFINET 设备名称、IP 地址和子网掩码：

右键单击 PSM 图标。

选择选项卡 General（一般）。

选择 PROFINET interface [X1]（PROFINET 接口 [X1]），然后选择 Ethernet addresses（以太网地址）。

输入 IP 地址 192.168.101.1 [4]。

输入子网掩码 255.255.255.0 [5]。

重复步骤 1–3 添加 DAM 510、ACM 510、ISD 510 或 DSD 510。

在 Devices & networks（设备和网络）窗口中，选择 Topology view（拓扑结构视图）[1]，然后拖放这些图标来连

接设备。

e3
0b

i2
56

.1
0

1

2
3 4

删除任何现有的 MAIN [OB1] 操作块：

在 Project Tree（项目树）中，展开 Program blocks（程序块）条目。

右键单击 Main [OB1] [2] 然后在下拉菜单中选择 Delete（删除）。

添加新的 MAIN [OB1] 操作块 [2] 然后为 Startup [OB100]（启动 [OB100]）[3] 和 Synchronous Cycle [OB61]（同

步循环 [OB61]）[4] 创建操作块：

在 Project Tree（项目树）中，展开 Program blocks（程序块）条目。

双击 Add new block（添加新块）。

在 Add new block（添加新块）窗口中，选择 Organization block（组织块）。
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-

-

-

8.

-

-

-

-

-

-

9.

-

-

-

-

-

-

在列表中选择组织块 MAIN [OB1]。

将语言设置为 SCL 并激活单选按钮 Automatic（自动）。

单击 OK（确定）。

对于 Startup [OB100]（启动 [OB100]）[3] 和 Synchronous Cycle [OB61]（同步循环 [OB61]）重复此过程。

验证 SyncDomain：

打开 Network view（网络视图）[1] 然后选择设置同步域所在的以太网子网 [2]。

打开以太网子网属性。

在本地导航 [4] 中，选择条目 [Domain management → Sync domains → Sync-Domain_1]（域管理 → 同步域
→ Sync-Domain_1）。

在字段 Sync Domain（同步域）[5] 中，按照需要更改名称。

在字段 Send clock（发送时钟）[6] 中，从下拉菜单中选择所需值。

激活 Default domain（默认域）复选框 [7]，使得此同步域成为默认域。

e3
0b

i2
57

.1
0

1

2

5
6

4
7

3

验证所有系统组件均具有 Sync slave（同步从站）角色：

e3
0b

i2
58

.1
0

1

2

3

4
5

打开 Network view（网络视图）[1] 然后选择设置同步域所在的以太网子网。

打开以太网子网 [2] 属性。

在本地导航 [3] 中，选择条目 [Domain management → Sync domains → Sync-Domain_1 → Device]（域管理
→ 同步域 → Sync-Domain_1 → 设备）。

选择 IO 设备。

验证所有系统组件均存在且设置为 Sync slave（同步从站）。
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-

-

-

-

-

-

-

11.

-

-

-

-

-

选择每个系统组件的报文属性：

e3
0b

i2
59

.1
0

1

3

6 7
8

9

24

5

打开 Device view（设备视图）[1]。

选择 Danfoss Telegram（丹佛斯报文）[2]。

在 Properties（属性）窗口 [3] 中，选择 General（一般）选项卡 [4] 然后选择条目 I/O addresses（I/O 地

址）[5]。

在 Input addresses（输入地址）部分，激活同步模式复选框 [6] 然后将字段 Organization block（组织块）

[7] 设置为 Synchronous Cycle（同步循环），将字段 Process image（进程图）[8] 设置为 PIP 1。

在 Output addresses（输出地址）部分 [9]，重复这些设置。

对各个系统组件重复这个过程。

对于每个系统组件激活同步模式：
e3

0b
i2
60

.1
0

1

4

6

2
3

5

打开 Device view（设备视图）[1]。

在 Device overview（设备概览）部分 [2]，单击 danfoss-psm-01 [3]。

在 Properties（属性）窗口 [4] 中，选择 General（一般）选项卡 [5]，然后选择菜单项 [PROFINET interface

[X1] → Advanced options → Isochronous mode]（PROFINET 接口 [X1] → 高级选项 → 同步模式）。

激活 Isochronous mode（同步模式）[6] 复选框。

对各个系统组件重复这些设置。
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-

13.

-

-

-

-

14.

-

-

创建全局数据块 FlexMotion_Data，将在其中分配每个系统组件的结构。

e3
0b

i2
61

.1
0

在操作块 Startup [OB100]（启动 [OB100]）中，检查模块访问点是否分配正确：

展开 Devices（设备）选项卡中的 Program blocks（程序块）。

双击 Startup [OB100]（启动 [OB100]）。

键入截屏中的设置，确保模块访问点名称与 TIA 自动分配的名称相同。打开菜单 [PLC tags → Show all tags]
（PLC 标记 → 显示所有标记）菜单，然后选择 System constants（系统常量）选项卡，可以看到这些名称。

e3
0b

i2
62

.1
0

创建一个标记表，为每个系统组件定义输入和输出报文地址。

选择菜单 [PLC tags → FlexMotion]（PLC 标记 → FlexMotion），打开 FlexMotion_Telegram 窗口。

为每个系统组件定义输入和输出报文的地址。

e3
0b

i2
63

.1
0
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在操作块 Synchronous Cycle [OB61]（同步循环 [OB61]）中，按照下面的示例输入报文读取指令。

e3
0b

i2
64

.1
0

在操作块 Synchronous Cycle [OB61]（同步循环 [OB61]）中，按照下面的示例输入报文写入指令。

e3
0b

i2
65

.1
0

6.16 TIA 编程指南
实施建议：

仅在程序开始时，在存在的每个设备的恰当结构中分配 HwIdSubmodule 变量。在菜单 [PLC tags → Show all tags →

System Constants]（PLC 标记 → 显示所有标记 → 系统常量）中，使用 TIA 自动创建的常量，例如 danfoss-

isd-01~Device_object_1~Module_access_point。仅在第一个 PLC 循环中分配此变量以进行初始化。每种设备类型要使

用的结构为：

ISD 510： AXIS_REF_DDS

DSD 510： AXIS_REF_DDS

PSM 510： PSM_REF

DAM 510： DAM_REF

ACM 510： ACM_REF

初始化通常不会在程序开始时只更改一次的参数。

在每个 PLC 循环中为每个存在的设备调用恰当的函数：

ISD 510： DD_UpdateProcessInput_DDS 和 DD_UpdateProcessOutput_DDS

DSD 510： DD_UpdateProcessInput_DDS 和 DD_UpdateProcessOutput_DDS

SDM 511/SDM 512： DD_UpdateProcessInput_DDS 和 DD_UpdateProcessOutput_DDS

PSM 510： DD_UpdateProcessInput_PSM 和 DD_UpdateProcessOutput_PSM

DAM 510： DD_UpdateProcessInput_DAM 和 DD_UpdateProcessOutput_DAM

ACM 510： DD_UpdateProcessInput_ACM 和 DD_UpdateProcessOutput_ACM

在调用功能块 DD_UpdateProcessInput_xxx 和 DD_UpdateProcessOutput_xxx 之间，仅创建操作指令和其他程序部分。
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在程序开始时使用 Enable（启用）输入调用提供状态或错误信息的功能块。

对每个轴使用功能块 MC_Power_DDS 的 1 个实例来控制其功率级。在每个 PLC 循环中调用此功能块。

对于每个 PSM 510 使用功能块 DD_Power_PSM 的 1 个实例，以控制输出线路上的直流回路电压。在每个 PLC 循环中调用

此功能块。

对于每个 DAM 510 使用功能块 DD_Power_DAM 的 1 个实例，以控制输出线路上的直流回路电压。在每个 PLC 循环中调用

此功能块。

对于每个 ACM 510 使用功能块 DD_Power_ACM 的 1 个实例，以控制输出线路上的直流回路电压。在每个 PLC 循环中调用

此功能块。

调用在程序结束时执行（运动）命令的功能块。

请勿使用名称以前縀 iDD_ 开头的任何 UDT、POU、枚举或常量。

请勿在一个功能块正忙时更改对其轴的引用。

6.17 VLT® Servo Toolbox 软件

6.17.1 概述
VLTÆ Servo Toolbox 是一个独立的由 Danfoss 设计的 PC 软件。它用于对系统模块进行参数化和诊断。此外，还可在非生产

环境中操作设备。

注 意

必须对于每个防火墙概要文件（私有/公共/域）允许 VLT® Servo Toolbox 软件。

VLTÆ Servo Toolbox 包含多个子工具，提供各种功能。

表 28: 重要子工具

子工具 说明

示波器 用于展示伺服驱动器、电源模块 (PSM 510)、分布式访问模块 (DAM 510) 和辅助电容器模块 (ACM 510) 的跟
踪功能的结果。

参数列表 用于读取/写入参数。

固件更新 用于更新设备上的固件。

驱动器控制 用于因测试目的而操作伺服驱动器。

PSM 控制 用于因测试目的而操作电源模块 (PSM 510)。

DAM 控制 用于因测试目的而操作分布式访问模块 (DAM 510)。

ACM 控制 用于因测试目的而操作辅助电容器模块 (ACM 510)。

CAM 编辑器 用于设计伺服驱动器的 CAM 轨迹。

配置参数 用于设置电机和反馈参数以及 PID 设置。

驱动器调试 用于电机反馈调整和惯量测量。

有关 VLTÆ Servo Toolbox 功能的详细介绍以及完整参数列表，请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510

(VLT® Flexmotionô ) 编程指南。

6.17.2 系统要求
要安装 VLTÆ Servo Toolbox 软件，计算机必须满足以下要求：

支持的硬件平台： 32 位、64 位。

支持的操作系统： Windows 7、Windows 8.1、Windows 10。
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.NET Framework 版本： 4.7.

昀低硬件要求： 512 MB RAM，主频为 2.6 GHz 的 Intel Pentium 4 或同等产品，20 MB 硬盘空间。

推荐的硬件要求： 昀小 1 GB RAM，Intel Core i5/i7 或兼容产品。

6.17.3 安装 VLT® Servo Toolbox 软件
如果使用 Windows 操作系统，则需要具有管理员权限才能安装软件。如果需要，与系统管理员联系。
步骤

检查系统是否符合 6.17.2 系统要求 中指定的系统要求。

从 Danfoss 网站下载 VLTÆ Servo Toolbox 安装文件。

右键单击 .exe 文件，然后选择 Run as administrator（以管理员身份运行）。

按照屏幕上的操作说明完成安装过程。

6.17.4 VLT® Servo Toolbox 通信

6.17.4.1 概述
本章介绍了 VLTÆ Servo Toolbox 所需的特定于以太网的网络接口设置。共有两种基本通信方法： 直接通信和间接通信。与

它们相关的特定网络设置在相应分章节中介绍。

仔细阅读并严格执行步骤。错误的网络配置可导致网络接口的连接断开。

6.17.4.2 防火墙
根据所用的防火墙设置和现场总线，由 VLTÆ Servo Toolbox 发送和接收的消息可能会被 VLTÆ Servo Toolbox 主机系统上的

防火墙拦截。这可能导致通信断开，无法与现场总线上的设备通信。因此，确保允许 VLTÆ Servo Toolbox 通过 VLTÆ Servo

Toolbox 主机系统上的防火墙进行通信。对防火墙设置的更改不当可能会导致安全问题。

注 意

使用专用网络接口时，必须允许 VLTÆ Servo Toolbox 通过此网络接口进行通信。

6.17.4.3 间接通信

6.17.4.3.1 概述
ISD 510/DSD 510 设备与 VLTÆ Servo Toolbox 之间通过 PLC 进行通信称为间接通信。基于以太网的现场总线通信（在图中

标记为 A）在 PLC 与 ISD 510/DSD 510 设备之间进行。但是，PLC 与 VLTÆ Servo Toolbox 主机系统之间无现场总线通信。

在所示情况下，PLC 具有主站功能，与设备之间使用循环通信。因此，并非 VLTÆ Servo Toolbox 的所有功能都可使用，比如

驱动器控制。

有关使用间接通信时的限制的详细信息，请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô )

编程指南。
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图解 97: 间接基于以太网的现场总线通信（通过 PLC 通信）的逻辑视图

A 现场总线

B VLTÆ Servo Toolbox 主机系统

注 意

该逻辑视图仅显示出从高层次软件视角看到的连接，不反映网络的实际物理拓扑结构。

6.17.4.3.2 用于间接通信的网络设置
任何网络接口都可用于通过 PLC 通信。无需使用专用网络接口。

通过 PLC 建立通信后，VLTÆ Servo Toolbox 使用所选的网络地址转换 (NAT) 配置一个路由表。在 Windows 路由表中添加一

个路由需要管理员权限。因此，初始化连接时可能要求提供管理员凭据。

6.17.4.3.3 启用间接通信
执行以下步骤以启用间接通信。

注 意
通过 WiresharkÆ 监测网络封包时，校验和卸载通常会导致混乱，因为要传输的网络封包在校验和被计算出之前被转交给

WiresharkÆ。WiresharkÆ 将这些空校验和标记为无效，即使相应封包在后面离开网络硬件时包含有效的校验和也是如此。

使用这两种方法之一可避免此校验和卸载问题：

如果可能，在网络驱动程序中关闭校验和卸载。

在 WiresharkÆ 首选项中关闭特定协议的校验和验证。

禁用在 PC 上通信时所使用的网络接口上的 IPv6：
操作步骤

打开 Network and Sharing Center（网络和共享中心）。

选择 Change adapter settings（更改适配器设置）。

右键单击用于现场总线通信的网络接口，然后选择 Properties（属性）。

如果网络接口可使用 TCP/IPv6，则禁用它。

6.17.4.3.4 使用 EtherCAT® 进行间接通信的附加设置
设置 EtherCATÆ 主站的 IP 地址：

操作步骤

打开 TwinCATÆ System Manager。
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选择 [I/O-Configuration → I/O Devices → Device1 (EtherCATÆ)]（I/O 配置 → I/O 设备 → 设备 1 (Ether‐

CAT)）然后在 Adapter（适配器）选项卡中检查 IP 地址。PLC 网络适配器的 IP 地址可能不是链路本地地址（因此，

不在 169.254.0.1 至 169.254.255.254 范围内）。

如果需要，根据给定操作系统更改 IPv4 协议属性内的 IP 地址。这可在本地控制器上或通过 Remote Desktop（远程

桌面）完成。

6.17.4.3.5 在 EtherCAT® 主站中激活 IP 路由功能
此处所述的操作步骤可能因 PLC 的类型和所安装的操作系统的不同而异。
操作步骤

打开 TwinCATÆ System Manager。

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCAT)]（I/O 配置 → I/O 设备 → 设
备 1 (EtherCAT)）打开 EtherCAT 选项卡，在其中单击 Advanced Settings...（高级设置...）。

在 Advanced Settings（高级设置）窗口中选择 EoE Support（EoE 支持）。

在 Windows Network（Windows 网络）部分中，启用 Connect to TCP/IP Stack（连接到 TCP/IP 堆栈）。

在 Windows IP Routing（Windows IP 路由）部分中，启用 IP Enable Router（IP 启用路由器）。

重启 PLC 以便更改生效。

6.17.4.3.6 设置 EtherCAT® 从站的 IP 地址
用于设置 EtherCATÆ 从站的 IP 地址的操作步骤适用于：

ISD 510/DSD 510 伺服驱动器

电源模块 (PSM 510)

分布式访问模块 (DAM 510)

辅助电容器模块 (ACM 510)

注 意

IP 地址的昀后一个数字是 VLTÆ Servo Toolbox 软件中使用的用来识别该设备的 ID。

步骤

打开 TwinCATÆ System Manager。

在 EtherCATÆ 选项卡中的 [I/O-Configuration → I/O Devices → Device1 (EtherCAT) → Box 1 (VLTÆ Decen‐

tral Access Module → Drive 2 (VLTÆ Integrated Servo Drive ISD 510)]（I/O 配置 → I/O 设备 → 设备 1

(EtherCAT) → 框 1（VLT Decentral Access Module → 驱动器 2 (VLT Integrated Servo Drive ISD 510））下，单
击 Advanced Settings...（高级设置...）。

在 Advanced Settings（高级设置）窗口中选择 [Mailbox → EoE]（邮箱 → EoE）。

启用 Virtual Ethernet Port（虚拟以太网端口）并输入一个有效的 IP 地址。

配置中的每个从站都需要一个 IP 地址。当从站状态机的状态每次从 INIT 转换到 Pre-Operational（运行前）时，

此地址将被重新分配。默认情况下，从站的 IP 通信将被停用。

6.17.4.3.7 使用 PROFINET® 进行间接通信的附加设置

6.17.4.3.7.1 概述
每个 PROFINET℠ 设备都需要一个设备名称和 IP 地址。建立与 I/O 设备的连接后，IP 地址和设备名称将由 I/O 控制器分

配。

要通过 PG/PC 接口使用 TCP/IP 自动检测可访问的节点，将这些节点连接到 PG/PC 所在的物理以太网子网。如果一个节点位
于其他物理以太网子网中，则可指定要寻找的节点的 IP 地址。

要与更多节点通信，通过可访问的节点，能够对 PG/PC 接口添加 IP 地址和子网。然后，新的 IP 地址和子网将被添加到 PG/
PC 的以太网接口。

6.17.4.3.7.2 添加 IP 地地和子网掩码
步骤

打开 SIMOTION SCOUTÆ。

选择菜单 [Project → Accessible nodes]（项目 → 可访问的节点）。
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如果可访问的节点位于另一子网中，则将出现 Add IP addresses / subnet masks（添加 IP 地址 / 子网掩码）窗

口，其中显示出这些节点。
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0

图解 98: 可访问的节点

单击 Yes（是）接受地址。

现在，IP 地址/子网掩码已添加。

注 意

如果在同一 PROFINETÆ 网络中使用了多个 Danfoss 伺服驱动器，则每个伺服驱动器都必须具有不同名称和 IP 地址。

IP 地址的昀后一个数字是 VLTÆ Servo Toolbox 软件中使用的用来识别该设备的 ID。

Accessible nodes（可访问的节点）选项卡关闭后，地址将保留。仅当 SIMOTION SCOUTÆ 关闭后才会丢弃新添加的地

址。

注 意

IP 地址和子网也可使用 PRONETA 进行添加。

6.17.4.4 直接通信

6.17.4.4.1 概述
对于基于以太网的现场总线通信（直接通信），VLTÆ Servo Toolbox 必须使用 VLTÆ Servo Toolbox 主机系统上的专用网络接

口。请勿同时将此网络接口用于任何其他通信。

AQ262449648484zh-000201 / 175R1135 | 133Danfoss A/S © 2020.10

调试

VLT® Servo Drive System ISD 510/DSD 510

操作指南



1.

2.

3.

4.

-

A

2 n1

B

. . .

e3
0b

e3
10

.1
0

PSM
510 

DAM
510 

DAM
510 

 
 

 
 

STATUS PSM

LINK/ACT

DEV

STO

NET ST

X1

LCP LCP LCP

X2

STATUS DAM

LINK/ACT

DEV

STO

NET ST

AUX

X1

X2

X3

STATUS DAM

LINK/ACT

DEV

STO

NET ST

AUX

X1

X2

X3

图解 99: 直接基于以太网的现场总线通信的逻辑视图

A 基于以太网的现场总线通信

B VLTÆ Servo Toolbox 主机系统

警 告

该逻辑视图仅显示出从高层次软件视角看到的连接，不反映网络的实际物理拓扑结构。

6.17.4.4.2 与以太网 POWERLINK® 直接通信的网络设置
在用于直接以太网 POWERLINKÆ 通信的网络接口上，禁用除 TCP/IPv4 以外的所有网络协议。这可防止其他计算机软件或操作

系统使用此网络接口来执行其他任务，比如文件和打印机共享以及网络发现。禁用这些协议可减少通过网络接口发送的非相关
数据包的数量，从而降低整个网络负载。

6.17.4.4.3 在 PC 上禁用网络接口上的未用协议
步骤

打开 Network and Sharing Center（网络和共享中心）。

单击左侧的 Change adapter settings（更改适配器设置）。

右键单击用于现场总线通信的网络接口，然后选择 Properties（属性）。

取消选中 Internet Protocol Version 4 (TCP/IPv4)（Internet 协议版本 4 (TCP/IPv4)）以外的所有复选框。
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按 6.17.4.3.3 启用间接通信 中所述禁用网络接口上的 IPv4 Checksum offload（IPv4 校验和卸载）。
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图解 100: 局域连接 2 属性

6.17.4.4.4 设置正确的以太网 POWERLINK® 主站 IP 地址
步骤

打开 Network and Sharing Center（网络和共享中心）。

单击左侧的 Change adapter settings（更改适配器设置）。

右键单击用于现场总线通信的网络接口，然后选择 Properties（属性）。

单击 Internet Protocol Version 4 (TCP/IPv4)（Internet 协议版本 4 (TCP/IPv4)）（必须选中该复选框），然后单

击 Properties（属性）。

选择 Use the following IP address（使用以下 IP 地址）然后将 192.168.100.240 用作 IP 地址，将

255.255.255.0 用作子网掩码。保留所有其他字段为空。
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图解 101: Internet 协议版本 4 (TCP/IPv4) 属性
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6.17.4.4.5 与 EtherCAT® 直接通信的网络设置
在用于直接 EtherCAT® 通信的网络接口上，禁用除 TCP/IPv4 以外的所有网络协议。这可防止其他计算机软件或操作系统使
用此网络接口来执行其他任务，比如文件和打印机共享以及网络发现。禁用这些协议可减少通过网络接口发送的非相关数据包
的数量，从而降低整个网络负载。

6.17.5 VLT® Servo Toolbox 调试

6.17.5.1 步骤 1： 打开主窗口
主窗口 是所有 VLTÆ Servo Toolbox 功能的基础。其中包含以下组件：
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9

6

图解 102: 主窗口

表 29: 主窗口说明

图
例
编
号

名称 说明

1 菜单栏 包含用于保存和加载项目、管理连接、显示和更改设置、管理打开的子工具以及显示帮助目录的常规功
能。

2 工具栏 包含用于保护和加载项目、连接到网络和从网络断开、自动搜索联机设备以及手动添加设备的快捷方式。

3 联机状态
和状态信
息

联机设备由设备 ID 旁边发光的灯泡指示。

联机设备是 VLTÆ Servo Toolbox 所连接到的实际存在的物理设备的逻辑设备。

颜色指示设备状态，是特定于设备的。
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图
例
编
号

名称 说明

脱机状态
和状态信
息

脱机设备由设备 ID 旁边的灰色灯泡指示。

脱机设备是无对应物理设备的逻辑设备。脱机设备可表示已保存的设备配置或状态，比如用于脱机
分析或故障排查。此外，它还包含要写入物理设备的预配置的参数值。

4 可用子工
具

要打开一个子工具，可在 Device Environment（设备环境）中用鼠标左键双击其名称，或选择相应条目

然后按键盘上的 Enter 键。

5 设备环境 主窗口 的 Device Environment（设备环境）部分列出了由 VLTÆ Servo Toolbox 管理的所有逻辑设备，

显示它们的状态并用作用户界面来访问设备功能。

Device Environment（设备环境）窗口列出了添加的每个设备的所有可用子工具。

请参阅 VLT Servo Drive System ISD 510、DSD 510、MSD 510 (VLT® Flexmotionô ) 编程指南，了解有

关子工具的更多信息。

6 工作区 这是用于托管子工具的空间，其大小取决于主窗口 的大小。可将这些子工具昀大化、昀小化、水平或垂

直对齐或层叠显示。

7 监视列表
窗口

通过从设备循环读取一个或多个设备的参数值来评估它们。允许将参数值记录并保存到文本文件中。此
外，还可在监视列表中修改/写入值。

8 输出窗口 显示操作信息、警告和错误。根据用户设置，昀多显示 3 个不同日志级别（高、中和低）的消息。用于
显示高级错误和警告信息。

9 状态栏 显示 VLTÆ Servo Toolbox 的通信状态。如果连接到网络，则将显示出所用的硬件接口（例如，网络适

配器）和网络名称。

6.17.5.2 步骤 2： 连接到网络
预先配置相应通信设置以连接到网络（请参阅 6.17.4.1 概述）。
操作步骤

在主窗口 工具栏中，单击连接到总线 图标以打开 Connect to Network（连接到网络）窗口。

选择要连接到的现场总线类型和网络接口。

单击 OK（确定）以连接。

查看主窗口 底部的状态栏确定连接是否成功。

e3
0b

h5
31

.1
0

图解 103: “连接到网络”窗口（以太网 POWERLINKÆ）
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6.17.5.3 步骤 3： 扫描设备
步骤

注 意

如果在循环模式下连接到以太网 POWERLINKÆ 网络，则在下一窗口中选择扫描范围（昀小和昀大 ID）来缩短扫描所需

的时间。在所有其他条件下，将扫描整个 ID 范围。

确认 VLTÆ Servo Toolbox 连接到所选网络后，单击工具栏中的 Scan for Devices（扫描设备）图标以触发设备扫描

过程。

完成扫描后，Select Devices（扫描设备）窗口中将显示出可用设备的列表。选择要添加到 Device Environment（设

备环境）中的设备然后单击 OK（确定）。

所有选中的设备都将出现在 Device Environment（设备环境）窗口中并自动联机（由每个设备名称旁边闪烁的灯泡指

示）。

6.18 运动库

6.18.1 功能块
PLC 库提供了支持伺服系统的功能的功能块并符合以下标准：

PLCopenÆ 技术规格 - 运动控制功能块（以前称为第 1 部分和第 2 部分），版本 2.0，2011 年 3 月 17 日。

除 PLCopenÆ 功能外，Danfoss 还为伺服系统提供更多功能。

以下 PLCopenÆ 特征适用于所有功能块：

命令（使用输入端）

发送信号（输出端的行为）

一般调用约定

注 意

请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) 编程指南，了解有关可用功能块及

其行为的更多信息。

6.18.2 简单编程模板
TwinCATÆ：

用于启动带有 1 个电源模块 (PSM 510)、1 个分布式访问模块 (DAM 510) 和 2 个轴的伺服系统的基本示例 PLC 应用。项目
DDS_ServoMotion_SampleProject 可从 Danfoss 网站下载。

Automation Studioô ：

有关如何在 Automation Studioô  中打开 ISD 包内的示例项目的详细信息，请参阅 Automation Studioô  帮助。打开 B&R

Help Explorer（B&R 帮助管理器），转到 [Programming → Examples → Adding sample programs]（编程 → 示例 → 添加
示例项目），然后按照库示例的说明进行操作。

PROFINETÆ

项目 DDS_ServoMotion_SampleProject 是一个基本示例 PLC (C240PN) 应用，用于启动带有 1 个电源模块 (PSM 510)、1 个

分布式访问模块 (DAM 510) 和 2 个轴的伺服系统。
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7 运行

7.1 运行模式
ISD 510/DSD 510 伺服驱动器实施了多种运行模式。伺服驱动器的行为取决于激活的运行模式。可在启用伺服驱动器后在各
模式间切换。支持的运行模式遵循 CANopenÆ CiA DS 402，还存在特定于 ISD 的运行模式。所有支持的运行模式都对

EtherCATÆ、以太网 POWERLINKÆ 和 PROFINETÆ 可用。各种运行模式在 VLT® Servo Drive System ISD 510, DSD 510, MSD 510

(VLT® Flexmotionô ) 编程指南中详细介绍。

惯量测量模
式

此模式测量轴的惯量。它用于测量伺服驱动器和外部负载的惯量，优化控制环路设置。摩擦效应将被自动清
除。

轨迹速度模
式

在轨迹速度模式下，伺服驱动器在速度控制下运行，并以恒定速度进行运动。其他参数也可进行参数化，比
如加速和减速。

轨迹位置模
式

在轨迹位置模式下，伺服驱动器在位置控制下运行，并执行绝对和相对运动。其他参数也可进行参数化，比
如速度、加速和减速。

轨迹转矩模
式

在轨迹转矩模式下，伺服驱动器在转矩控制下运行，并以恒定转矩进行运动。使用线性斜坡。其他参数也可
进行参数化，比如转矩斜坡和昀大速度。

归位模式 在归位模式下，可设置伺服驱动器的应用参考位置。可使用多种归位方法，比如在实际位置归位、在功能块
归位、限位开关或归位开关。

CAM 模式 在 CAM 模式下，伺服驱动器将根据主轴执行同步运动。同步通过 CAM 轨迹方式进行，其中包含与主位置相
对应的从站位置。可使用 DDS Toolbox 软件以图形方式设计 CAM，也可通过 PLC 进行参数化。指导值可由
外部编码器、虚拟轴或另一轴的位置提供。

齿轮模式 在齿轮模式下，伺服驱动器将使用主站和从站位置之间的传动比，根据主轴执行同步运动。指导值可由外部
编码器、虚拟轴或另一轴的位置提供。

周期同步位
置模式

在周期同步位置模式下，位置的轨迹发生器位于控制设备而不是伺服驱动器内。

周期同步速
度模式

在周期同步速度模式下，速度的轨迹发生器位于控制设备而不是伺服驱动器内。

AC1 在应用等级 1 (AC1) 模式下，主设置点（例如速度设置点）用于在 PROFINETÆ IO 中控制伺服驱动器。速

度控制完全在伺服驱动器中处理。

AC4 应用等级 4 (AC4) 在速度设置点接口和实际位置值接口之间定义一个接口，其中在伺服驱动器上执行速度
控制，在控制器上执行位置控制。多轴的运动控制集中进行，例如通过编号控制 (NC)。位置控制环路通过
现场总线闭合。要将控制器中位置控制的时钟与驱动器中速度控制的时钟进行同步，需要进行时钟同步（带
IRT 的 PROFINETÆ）。

7.1.1 运动功能

功能 说明

数字 CAM 开关 此功能控制数字输出是启用还是禁用，具体取决于轴位置。它执行的功能与电机主轴上的开关相当。允许
向前和向后移动轴位置。开关补偿和迟滞可通过参数进行设置。

接触探针 此功能在配置的数字输入中的上升沿或下降沿存储位置实际值。

指导值 指导值用于所有同步操作模式（CAM 模式和齿轮模式）。它用作同步模式中的主位置。

7.2 运行状态指示灯
ISD 510/DSD 510 伺服驱动器、PSM 510、DAM 510 和 ACM 510 的运行状态通过每个设备上的 LED 来指示。
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7.2.1 ISD 510/DSD 510 伺服驱动器上的运行 LED

DEV STAT X1

X2

X3

NET STAT

LINK/ACT

Advanced

e3
0b

e6
77

.1
1

图解 104: ISD 510/DSD 510 伺服驱动器上的运行 LED

表 30: ISD 510/DSD 510 伺服驱动器上的运行 LED

LED 颜色 闪烁状态 说明

DEV STAT 绿色 On（开） 伺服驱动器状态为 Operation enabled（允许运行）

闪烁 应用辅助电压。

红色 On（开） 伺服驱动器状态为 Fault（故障）或 Fault reaction active（故障反应激

活）。

闪烁 未应用直流回路电压。

NET STAT 绿色/红色 取决于现场总线 设备的网络状态（请参阅对应的现场总线标准）。

Link/ACT X1 绿色 – Hybrid In（混合输入）(X1) 的链路/活动状态

On（开） 已建立以太网链路。

闪烁 已建立以太网链路并激活。

Off（关） 无链路。

Link/ACT X2 绿色 – Hybrid Out（混合输出）(X2) 的链路/活动状态

On（开） 已建立以太网链路。

闪烁 已建立以太网链路并激活。

Off（关） 无链路。

Link/ACT X3 绿色 – 以太网端口 (X3) 的链路/活动状态.

On（开） 已建立以太网链路。
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LED 颜色 闪烁状态 说明

(1)

闪烁 已建立以太网链路并激活。

Off（关） 无链路。

1 仅用于带 POWERLINKÆ 或 EtherCATÆ 的高级伺服驱动器。

7.2.2 PSM 510 上的工作指示 LED

STATUS PSM

LINK/ACT

DEV

SVS ST

NET ST

X1

X2

e3
0b

g5
76

.1
1

图解 105: PSM 510 上的工作指示 LED

表 31: PSM 510 上的工作指示 LED

LED 颜色 闪烁状态 说明

DEV 绿色 On（开） 设备状态为 Operation enabled（允许运行）。

闪烁 设备状态为 Standby（待机）或 Power-up（加电）。

红色 On（开） 设备状态为 Fault（故障）或 Fault reaction active（故障反应

激活）。

闪烁 未应用输入电源。

SVS ST 绿色 On（开） 应用 24 V 安全电源。

Off（关） 未应用 24 V 安全电源。

NET ST 绿色 On（开） 已连接。

橙色 On（开） 联机。

红色 闪烁 初始化。

On（开） 初始化失败或出现其他错误。

LINK/ACT X1

（In（输入端）的链路/活动状态）

绿色 On（开） 已建立以太网链路。

闪烁 已建立以太网链路并激活。

Off（关） 无链路。
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LED 颜色 闪烁状态 说明

LINK/ACT X2

（Out（输出端）的链路/活动状态）

绿色 On（开） 已建立以太网链路。

闪烁 已建立以太网链路并激活。

Off（关） 无链路。

7.2.3 DAM 510 上的工作指示 LED

STATUS DAM

LINK/ACT

DEV

SVS ST

NET ST

AUX

X1

X2

X3

e3
0b

g5
77

.1
1

图解 106: DAM 510 上的工作指示 LED

表 32: DAM 510 上的工作指示 LED

LED 颜色 闪烁状态 说明

DEV 绿色 On（开） 设备状态为 Operation enabled（允许运行）。

闪烁 设备状态为 Standby（待机）或 Power-up（加电）。

红色 On（开） 设备状态为 Fault（故障）或 Fault reaction active

（故障反应激活）。

闪烁 输入端未应用直流回路。

SVS ST 绿色 On（开） 应用 24 V 安全电源。

Off（关） 未应用 24 V 安全电源。

NET ST 绿色 On（开） 已连接。

橙色 On（开） 联机。

红色 闪烁 初始化。

On（开） 初始化失败或出现其他错误。

AUX

（辅助电压的状态）

绿色 On（开） 对输出连接器应用辅助电压。

Off（关） 未对输出连接器应用辅助电压。

红色 On（开） 在硬件中检测到辅助电压欠压。
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LED 颜色 闪烁状态 说明

LINK/ACT X1

（In 的链路/活动）

绿色 On（开） 已建立以太网链路。

闪烁 已建立以太网链路并激活。

Off（关） 无链路。

LINK/ACT X2

（Hybrid Out（混合输出）的链路/活动状态）

绿色 On（开） 已建立以太网链路。

闪烁 已建立以太网链路并激活。

Off（关） 无链路。

LINK/ACT X3

（Out（输出端）的链路/活动状态）

绿色 On（开） 已建立以太网链路。

闪烁 已建立以太网链路并激活。

Off（关） 无链路。

7.2.4 ACM 510 上的工作指示 LED

STATUS ACM

LINK/ACT

DEV

CAP ST

NET ST

X1

X2

e
3

0
b

g
5

7
8

.1
0

图解 107: ACM 510 上的工作指示 LED

表 33: ACM 510 上的工作指示 LED

LED 颜色 闪烁状态 说明

DEV 绿色 On（开） 设备状态为 Operation enabled（允许运行）。

闪烁 设备状态为 Standby（待机）或 Power-up（加电）。

红色 On（开） 设备状态为 Fault（故障）或 Fault reaction active（故障反应

激活）。

闪烁 输入端未应用直流回路。

CAP ST 绿色 On（开） 电容器完全充电。

闪烁 电容器正在充电/放电。

Off（关） 电容器已放电。
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LED 颜色 闪烁状态 说明

NET ST 绿色 On（开） 已连接。

橙色 On（开） 联机。

红色 闪烁 初始化。

On（开） 初始化失败或出现其他错误。

LINK/ACT X1

（In 的链路/活动）

绿色 On（开） 已建立以太网链路。

闪烁 已建立以太网链路并激活。

Off（关） 无链路。

LINK/ACT X2

（Out（输出端）的链路/活动状态）

绿色 On（开） 已建立以太网链路。

闪烁 已建立以太网链路并激活。

Off（关） 无链路。
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8 功能安全概念

8.1 功能说明
该伺服系统集成有安全功能 Safe Torque Off (STO)。该安全功能在菊花链形式的连接中可用，除 ACM 510（不含电缆）以外
的所有系统组件之间都可通过菊花链形式连接。混合电缆将 STO 信号从分布式访问模块 (DAM 510) 传送到链中的所有
ISD 510/DSD 510 伺服驱动器上。激活 STO 后（安全状态），ISD 510 伺服驱动器或连接到 DSD 510 的任何电机上不会产生转
矩。复位安全功能后可通过 PLC 执行诊断。

注 意

在伺服系统或在受影响的机器部位执行机械作业时，使用 STO 功能可避免机械危害。但是，STO 功能不提供电气安全。

8.2 安全事项

警 告
不受控的移动

电机上的外力会导致不受控制且危险的移动，继而导致严重伤亡。

对电机采取额外措施，防止不受控制且危险的移动，比如机械制动。

警 告
电击危险

STO 功能不会切断伺服系统或辅助电路的主电源电压。如果不切断设备的主电源供电并等待规定的放电时间，则会导致严重

伤亡。

只能在切断主电源供电并等待放电时间过后，才能在伺服系统或 ISD 510/DSD 510 伺服驱动器的电气部件上进行操作。

警 告
残余旋转的风险

由于驱动器的功率半导体出现故障，因某一故障引发的残余旋转可能会导致严重伤亡。旋转度可以按下述方式计算：角度 =

360°/(极数)。

考虑此残余旋转并确保不会引发安全风险。

警 告
LED 状态可靠性

对于安全功能来说，状态指示灯 (LED) 并不可靠。

只能使用状态指示灯在调试和故障排查过程中进行一般诊断。

注 意

安装 STO 功能后，执行启用测试。若要符合安全标准，则在昀初安装和每次做出改动后，系统都必须通过启用测试（请
参阅 8.8 启用测试）。

注 意

如果需要，按照 EN ISO 13849-1 执行手动复位功能。要在无手动复位的情况下自动重启，请遵守 EN ISO 12100:2010 段
落 6.3.3.2.5 或同等标准中详细规定的要求。
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注 意

执行风险评估，以按照 EN 60204-1 为每个停止功能选择正确的停止类别。

设计机器应用时，应考虑采用定时和距离来实现惯性停车（停止类别 0 或 STO）。有关详细信息，请参阅 EN 60204-1。

连接到 STO 的所有信号都必须由 PELV 电源供电。

8.3 由具备资质的人员处理功能安全
只能由具备相应资质的人员对 STO 功能进行安装、设置、调试、维护和退役处置。功能安全方面具备资质的人员是指有资质
的电气工程师，或者是经有资质的电气工程师培训过的人员，具有相应经验，能够按照安全技术的一般标准和规范来操作装
置、系统、设备和机械装置。

此外，他们还必须：

熟悉有关健康和安全/事故预防的基本法规。

已阅读并理解本手册中提供的安全指导原则。

熟悉与特定应用有关的一般标准和专门标准。

动力驱动系统（安全相关）(PDS(SR)) 的用户负责：

对应用进行危险和风险分析。

应用的总体安全。

确定所需的安全功能并为每个功能分配 SIL 或 PL，并确定其他子系统以及来自这些子系统的信号和命令的有效性。

设计适合的安全相关控制系统，比如硬件、软件和参数化等。

8.4 适用标准和合规性
使用 STO 功能时，需符合所有安全规定，包括相关法律、法规和准则的要求。

集成的 STO 功能符合下述标准：

IEC 60204-1： 2016 停止类别 0 – 不受控停止

EN 60204-1： 2018 停止类别 0 – 不受控停止

IEC/EN 61508： 2010 SIL 2

IEC 61800-5-2： 2016 SIL 2

EN 61800-5-2： 2017 SIL 2

IEC 62061： 2005、A1: 2012 和 A2: 2015

EN 62061： 2005、Cor.:2010、A1: 2013 和 A2: 2015

IEC/EN 62061： 2015 SIL CL2

EN ISO 13849-1： 2015 类别 3，PL d

EN ISO 13849-2： 2014

8.5 缩略语与约定

表 34: 安全相关缩略语与约定

缩略语 参考值 说明

Cat. EN ISO 13849-1 B 类，1–4

DC – 诊断覆盖率

FIT – 失效时间

失效率： 1E-9/小时

HFT EN IEC 61508 硬件故障承受力

HFT = n，即 n + 1 次故障可能造成安全功能丧失。

MTTFD EN ISO 13849-1 平均无危险故障时间
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缩略语 参考值 说明

单位： 年

PFH EN IEC 61508 单位小时的危险故障几率

这个值应在下述情况中测得：安全设备在高需求或持续工作模式下工作，与安全有关的系统
的使用需求频率每年超过一次。

PL EN ISO 13849-1 性能等级

用于规定系统的安全相关部件在可预见情况下执行安全功能的能力的离散等级。级别： a–
e。

SFF EN IEC 61508 安全故障率 [%]

安全功能或子系统所发生的安全故障和检测到的危险故障在所有可能故障中的占比。

SIL EN IEC 61508

EN IEC 62061

安全完整性级别

STO EN IEC 61800-5-2 Safe Torque Off

8.6 安装
只能使用 Danfoss 电缆来安装伺服系统，但是，用户可使用其他供应商提供的电缆来连接分布式访问模块 (DAM 510) 上的 STO
端子 STO DAM（引脚 1 和 2）。

注 意

如果应用程序无需 Safe Torque Off (STO) 功能，则可通过以下方式连接 +24 V 电源来搭建桥：从连接器 STO 1 IN:

+24 V 至 STO 1 IN: +STO，以及从 STO 1 IN: –24 V 至 STO 1 IN: –STO。

带有加减开关输出信号的安全继电器可直接连接到伺服系统以激活 STO。

图解 108 中的示例为使用 STO 功能应进行的基本连接。Danfoss 不提供用于关闭该功能的适合的安全装置。通过打开 STO+
和 STO– 可激活 STO。

表 35: 激活 STO 功能

STO+ STO– STO 功能

24 V GND 禁用 STO

打开 GND 激活 STO

24 V 打开 激活 STO

打开 打开 激活 STO

注 意

STO 输入端的电压不得超过 30 V。

如果正输入介于 –3 V 至 +3 V 之间，则激活 STO。

如果正输入介于 +21.6 V 至 +26.4 V 之间，则禁用 STO。
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图解 108: 带有正切换输出和负切换输出的安全继电器

带有测试脉冲的信号不得具有超过 1 ms 的测试脉冲。时间更长的脉冲可能会导致伺服系统的可用性降低。

8.6.1 保护措施

在符合 IEC 60529 标准的 IP54 机柜或同等环境中安装防护等级小于 IP54 的 ISD 510/DSD 510 系统组件。在特殊应用
中，可能要求更高的 IP 防护等级。

如果电机轴受到外力的影响（比如悬挂负载），则须采取额外措施（比如安全夹持制动）来避免危险。

8.7 应用示例
图解 109 中示出了一个可通过安全电路置于 Safe Torque Off 模式的应用的例子。

安全电路可相互远离，且不由 VLTÆ Servo Drive System ISD 510/DSD 510 供电。

按照应用要求选择安全开关装置。

+24 VDC

GND

e
3

0
b

g
2

7
3

.1
0

8a

8b

53

42

1

X1

X2

X1

X2

9

7

6

图解 109: 应用示例： Safe Torque Off 功能

1 24 V 直流电源

2 安全装置

3 紧急停止按钮

4 安全装置触点

5 分布式访问模块 (DAM 510)

6 混合电缆

7 馈电电缆

8a 伺服驱动器

8b 伺服驱动器

9 环路电缆

8.8 启用测试

注 意

安装 STO 功能后、每次对安装的功能进行更改后或出现安全故障后，对整个伺服系统执行启用测试。

可通过两种方法实施启用测试，具体取决于用于对 PLC 进行编程的方法，但是，测试步骤是相同的：

使用 Danfoss 库或 TwinCATÆ 库。

状态的位读数。
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8.8.1 使用库进行启用测试
根据具体应用，需要使用以下库的一个或两个来设置启用测试：

Danfoss 库

MC_ReadAxisInfo_DDS

MC_ReadStatus_DDS

MC_ReadAxisError_DDS

MC_Reset_DDS

TwinCATÆ 库

MC_ReadStatus

MC_ReadAxisError

MC_Reset

表 36: 使用库进行启用测试

测试步骤 执行该测试步骤
的原因

Danfoss 库的预期结果 TwinCATÆ 库的预期结果

1 运行应用程序（所有伺服
驱动器都已启用）。

检查应用程序能
否运行。

应用程序按预期运行。 应用程序按预期运行。

2 停止应用程序。 – 所有伺服驱动器的速度都达到 0 RPM。 所有伺服驱动器的速度都达
到 0 RPM。

3 禁用所有伺服驱动器。 – 所有伺服驱动器都将被禁用。 所有伺服驱动器都将被禁
用。

4 启用 STO。 检查能否在不出
现错误的情况下
激活 STO。

对于对应线路上的所有伺服驱动器，
MC_ReadAxisInfo_DDS 输出 SafeTor‐

queOff = True（真）。

–

5 禁用 STO。 检查能否在不出
现错误的情况下
禁用 STO。无需
复位。

对于对应线路上的所有伺服驱动器，
MC_ReadAxisInfo_DDS 输出 SafeTor‐

queOff = False（假）。

–

6 运行应用程序（所有伺服
驱动器都已启用）。

– 应用程序按预期运行。 应用程序按预期运行。

7 启用 STO。 检查能否在伺服
驱动器运行过程
中激活 STO 时正
确生成错误。

电机无转矩。电机在一段时间后惯性停
止。

MC_ReadAxisInfo_DDS 输出 SafeTor‐

queOff = True（真）

且

MC_ReadStatus_DDS 输出 ErrorStop =

True（真）

且

在所有启用的伺服驱动器上，MC_Read‐

AxisError_DDS 输出 AxisErrorID =

0xFF80。

电机无转矩。电机在一段时
间后惯性停止。

对于启用的电机：

MC_ReadStatus output

ErrorStop = True（真）

且

在所有启用的伺服驱动器
上，MC_ReadAxisError

output AxisErrorID =

0xFF80。

8 尝试运行应用程序（启用
1 个或多个伺服驱动
器）。

检查 STO 功能的
运行是否正常。

应用程序未运行。 应用程序未运行。

9 禁用 STO。 检查错误信号是
否仍禁止 STO 启
动。

MC_ReadAxisInfo_DDS 输出 SafeTor‐

queOff = False（假）

且

MC_ReadStatus output

ErrorStop = True（真）
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测试步骤 执行该测试步骤
的原因

Danfoss 库的预期结果 TwinCATÆ 库的预期结果

MC_ReadStatus_DDS 输出 ErrorStop =

True（真）

10 尝试运行应用程序（启用
1 个或多个伺服驱动
器）。

检查是否需要复
位。

应用程序未运行。 应用程序未运行。

11 通过 MC_Reset(_DDS)

发送复位信号。

– MC_ReadAxisInfo_DDS 输出 SafeTor‐

queOff = False（假）

且

MC_ReadStatus_DDS 输出 ErrorStop =

False（假）

MC_ReadStatus output

ErrorStop = False（假）

12 尝试运行应用程序（所有
伺服驱动器都已启用）。

– 应用程序按预期运行。 应用程序按预期运行。

8.8.2 使用 PROFINET® 设备执行启用测试

表 37: 使用 PROFINET® 设备执行启用测试

测试步骤 执行该测试步骤的原因 预期结果

1 运行应用程序（所有伺服驱动器都
已启用）。

检查应用程序能否运行。 应用程序按预期运行。

2 停止应用程序。 – 所有伺服驱动器的速度都达到 0 RPM。

3 禁用所有伺服驱动器。 – 所有伺服驱动器都将被禁用。

4 启用 STO。 检查能否在不出现错误的情况
下激活 STO。

未出现错误。成功激活 STO 可通过检查设备上
的 LED 来确认。

5 禁用 STO。 检查能否在不出现错误的情况
下禁用 STO。无需复位。

未出现错误。STO 状态可通过检查设备上的 LED
来确认。

6 运行应用程序（所有伺服驱动器都
已启用）。

– 应用程序按预期运行。

7 启用 STO。 检查能否在伺服驱动器运行过
程中激活 STO 时正确生成错
误。

电机无转矩。电机在一段时间后惯性停止。

所有伺服驱动器上的对象 0x603F 中显示出错误
0x11E。

8 尝试运行应用程序（启用 1 个或
多个伺服驱动器）。

检查 STO 功能的运行是否正
常。

应用程序未运行。

9 禁用 STO。 检查错误信号是否仍禁止 STO
启动。

所有伺服驱动器上的对象 0x603F 中显示出错误
0x11E。
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测试步骤 执行该测试步骤的原因 预期结果

10 尝试运行应用程序（启用 1 个或
多个伺服驱动器）。

检查是否需要复位。 应用程序未运行。

11 通过 PLC 发送复位信号。 – 所有伺服驱动器中的 STO 错误 0x11E 都将被清
除。

12 尝试运行应用程序（所有伺服驱动
器都已启用）。

– 应用程序按预期运行。

8.9 STO 功能的操作
STO 功能无需任何参数化，始终启用。

ISD 510/DSD 510 伺服驱动器通过现场总线提供 STO 状态信号。

通过现场总线传输的所有信号都不是安全功能的一部分，只能用于操作目的。

请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) 编程指南了解：

有关如何访问和映射数据对象的一般信息。

有关为了简化现场总线功能的使用而提供的库的信息。

如果在禁用伺服驱动器后激活 STO，且未尝试在激活 STO 后启用伺服驱动器，则不必在对 STO 端子重新加电后复位 STO 功
能。

如果在启用伺服驱动器后激活 STO，则将发出错误代码。

8.9.1 错误代码
如果设置了状态字的位 3，则表示伺服驱动器上出错。如果由于 STO 电路而出错，则可在对象 0x603F 中找到错误原因。

表 38: 错误代码

错误代码 PROFINETÆ 错误

代码

类别 说明 复位

0xFF80 0x11E 故障 启用伺服驱动器后激活 STO，或尝试在激活 STO 后启用伺服
驱动器。

通过 PLC 复位。

0xFF81 0x11F 安全故障 伺服驱动器内部诊断故障。 执行重启。

0xFF85 0x120 安全故障 功率卡上的内部 STO 电源不在限值内。 执行重启。

错误代码 0xFF80/0x11E 可能是应用的正常状态。在此情况下，伺服驱动器需要从 PLC 获得复位信号。要在需要使用控制防
护的应用中使用 STO 功能（请参阅 ISO 12100 了解详细信息），可由 PLC 自动提供此复位信息。同一线路上的所有伺服驱动
器将同时显示出此错误。在 PLC 上进行检查以比较一条线路上的所有伺服驱动器的错误。

错误代码 0xFF81/0x11F 表示伺服驱动器上出错，只能通过执行重启来复位。重启后将完成启用测试。仅当成功完成测试后，
伺服系统才能继续运行。如果再次报告错误代码 0xFF81/0x11F 或 0xFF85/0x120，则联系 Danfoss 服务部门。

8.9.2 故障复位
要复位故障，将控制字的位 7 从 0 更改为 1。请参阅 VLT Servo Drive System ISD 510、DSD 510、MSD 510 (VLT® Flex‐

motionô ) 编程指南，了解更多信息。

8.10 功能安全特性数据

表 39: 功能安全特性数据

数据 ISD 510/DSD 510 PSM 510 DAM 510

一般信息

响应时间（从打开输入直到转矩生成被禁用） <100 ms
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数据 ISD 510/DSD 510 PSM 510 DAM 510

使用寿命 20 年

EN/ISO 13849-1 的数据

性能等级 (PL) d – –

类别 3 – –

平均无危险故障时间 (MTTFD) >5000 年 – –

诊断覆盖率 (DC) 60% – –

EN/ISO 61508 和 EN/IEC 62061 的数据

安全完整性级别 (SIL) 2 – –

单位小时的危险故障几率 (PFH) <4 x 10-9/h 0 /h 0 /h

安全故障率 (SFF) >95% 100% 100%

子系统类别 类型 A

功能测试间隔 1 年

注 意

PSM 510、DAM 510 和 ACM 510 不会影响 Danfoss 系统的危险故障率，因此，可从与安全相关的计算中排除。

8.11 维护、安全性和用户可访问性
维护： 每年对 STO 安全功能至少执行一次测试，如下所述：

断开 STO 输入电压。

检查电机是否停止运行。

检查是否出现异常错误代码。

安全性： 如果存在安全风险，则采取适当措施来防止。

用户可访问性： 如果对 ISD 510/DSD 510 伺服驱动器和其他系统组件的访问会导致安全风险，则限制对它们的访问。
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9 诊断

9.1 故障
如果在 ISD 510/DSD 510 系统操作过程中出现故障，则检查：

伺服驱动器上的 LED 用于指示与通信或设备状态相关的一般问题。

PSM 510 和 DAM 510 上的 LED 用于指示与通信、辅助电源或 STO 电压相关的一般性问题。

错误代码。

可使用 VLTÆ Servo Toolbox 软件、LCP 或 PLC 读取错误代码。LCP 仅显示出与它所连接的设备相关的故障。

注 意

如果无法使用故障排查表中列出的措施之一清除故障，则通知 Danfoss 服务部门。

准备好以下信息，以便 Danfoss 快速有效地提供帮助：

型号

错误代码

固件版本

系统设置（例如，伺服驱动器、系统模块和线路的数量）。

出现故障时的系统状态。

环境条件。

9.2 故障排查

9.2.1 ISD 510/DSD 510 伺服驱动器故障排查

9.2.1.1 驱动器不运行/启动慢
可能原因

轴承磨损。

参数设置不正确。

控制环路参数错误

转矩设置不正确。

故障排查

检查轴承和主轴。

检查参数设置。

9.2.1.2 驱动器发出嗡嗡声且消耗高电流
可能原因

驱动器故障。

故障排查

联系 Danfoss。

9.2.1.3 驱动器突然停机，无法重启。
可能原因

与驱动器之间无通讯。

伺服驱动器处于错误模式。

故障排查

检查伺服驱动器的现场总线连接及 LED 指示灯。
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9.2.1.4 电机旋转方向错误
可能原因

镜像模式已激活。

故障排查

检查参数设置。

9.2.1.5 电机无法产生期望的转矩
可能原因

驱动器故障。

参数错误。

故障排查

检查参数设置。

联系 Danfoss。

9.2.1.6 驱动器发出尖啸声
可能原因

校准不正确。

电流测量故障。

控制环路参数错误

故障排查

检查参数设置。

联系 Danfoss。

9.2.1.7 运行不平稳
可能原因

轴承失灵。

故障排查

检查主轴。

9.2.1.8 振动
可能原因

轴承失灵。

控制环路参数错误

故障排查

检查主轴。

检查参数设置。

9.2.1.9 异常运行噪音
可能原因

轴承失灵。

连接的机械装置有故障。

控制环路参数错误

故障排查

检查主轴。

检查连接的机械装置中是否有机械部件松脱。

检查参数设置。
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9.2.1.10 驱动器速度突降至欠载状态
可能原因

驱动器在极限电流情况下运行。

驱动器在参数不正确的情况下运行。

故障排查

检查应用程序。

检查参数设置。

9.2.1.11 制动不松开
可能原因

制动控制有故障。

机械制动参数不正确。

故障排查

检查参数设置。

联系 Danfoss。

9.2.1.12 夹持制动而不夹持伺服驱动器
可能原因

机械制动故障。

主载负载超出制动的保持转矩。

故障排查

联系 Danfoss。

9.2.1.13 制动接合延迟
可能原因

软件错误。

故障排查

联系 Danfoss。

9.2.1.14 断电制动接合时发出噪音
可能原因

机械制动已坏。

故障排查

联系 Danfoss。

9.2.1.15 LED 指示灯不亮
可能原因

无电源。

故障排查

检查电源。

9.2.1.16 驱动器立即出现保护跳闸
可能原因

电路。

控制环路参数错误

故障排查

检查接线。

联系 Danfoss。
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•

•

•

•

•

•

•

•

•

•

•

•

9.2.2 伺服系统故障排查

9.2.2.1 LCP 黑屏/无法使用
ISD 510/DSD 510 伺服驱动器、PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

可能原因

无输入电源。

熔断器缺失或开路，或者断路器跳闸。

LCP 无电。

对比度设置错误。

显示屏存在缺陷。

故障排查

表 40: 错误, LCP 黑屏/无法使用

可能原因 可能解决方案

无输入电源。 检查输入电源。

熔断器缺失或开路，或者断路器跳闸。 检查熔断器和断路器。

LCP 无电。 检查 LCP 电缆是否正确连接或是否损坏。

更换有问题的 LCP 电缆或连接电缆。

对比度设置错误。 按 [Status]（状态）+ [▵]/[▿] 可调整对比度。

显示屏存在缺陷。 更换有问题的 LCP 电缆或连接电缆。

9.2.2.2 电源熔断器开路或断路器跳闸
PSM 510 和 DAM 510 可能会出现此错误。

可能原因

相到相短路。

背部链路出现短路。

混合电缆短路。

EXM 510 连接器或电缆短路。

ISD 510/DSD 510 连接器短路。

故障排查

检查接线

检查有无松脱的连接。

9.2.2.3 直流回路电压过低（错误 0x3220/0x104）
所有系统模块都可能会出现此错误。

可能原因

主电源的输入电源错误。

故障排查

检查电源电压是否符合允许的规格。

9.2.2.4 电流过载跳闸（错误 0x2396/0x15C）
PSM 510 和 DAM 510 可能会出现此错误。

可能原因

伺服驱动器电流总和超过 DAM 510 的昀大额定值。

系统模块的电流总和超过 PSM 510 的昀大额定值。

背部链路出现短路。
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故障排查

检查伺服驱动器电流消耗。

避免所有伺服驱动器同时加速。

降低加速值。

9.2.2.5 高连续 功率过载（错误 0x2313/0x161）
PSM 510 可能会出现此错误。

可能原因

PSM 510 在超过额定功率 140% 的情况下工作了太长时间。

故障排查

检查电流消耗情况。

9.2.2.6 连续功率过载（错误 0x2314/0x162）
PSM 510 可能会出现此错误。

可能原因

PSM 510 在功率达到额定值的 100–140% 的情况下工作了太长时间。

故障排查

检查电流消耗情况。

9.2.2.7 辅助线路过电流（错误 0x2391/0x125）
DAM 510 可能会出现此错误。

可能原因

伺服驱动器在 UAUX 线路上消耗的功率超过允许的值。

故障排查

参考 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) 设计指南中的壳层图，查看连接的伺服

驱动器的数量。

避免同时起吊伺服驱动器制动器。

9.2.2.8 辅助线路过电压（错误 0x3292/0x133）
DAM 510 可能会出现此错误。

可能原因

UAUX 电源错误。

故障排查

检查电源是否符合辅助电源要求。

9.2.2.9 辅助线路欠压（错误 0x3294/0x135）
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

可能原因

UAUX 电源错误。

电源设备的电流大小错误。

故障排查

检查电源是否符合辅助电源要求。

检查电源的输出功率是否足够。

9.2.2.10 主电源缺相（错误 0x3130/0x12F）
PSM 510 可能会出现此错误。

可能原因

供电侧存在相位丢失现象。

电压严重失衡。
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故障排查

检查设备的供电电压和电流。

9.2.2.11 一般应用错误（错误 0x1000 / 0x100）
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误。

可能原因

应用中发生一个一般错误。

故障排查

联系 Danfoss。

9.2.2.12 接地故障
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

可能原因

接地故障。

并联安装 2 个 PSM510 模块时，超过加电的昀长延迟时间（请参阅 6.6 加电时间）。

故障排查

检查是否正确接地并且接地线路是否松脱。

检查混合电缆是否发生短路或存在泄漏电流。

检查 EXM 510 连接和电缆。

9.2.2.13 制动电阻器出错
PSM 510 可能会出现此错误。

可能原因

制动电阻器出现故障。

未连接内部/外部制动电阻器。

故障排查

切断设备电源，等待放电时间过去，然后更换制动电阻器。

9.2.2.14 制动斩波器出错
PSM 510 可能会出现此错误。

可能原因

制动斩波器出错。

制动斩波器的功率超过功率循环限制。

参数化错误。

故障排查

检查制动斩波器的参数化。

检查制动斩波器连接。

测量制动斩波器的电阻并将它与参数设置进行比较。

9.2.2.15 内部风扇出错
PSM 510 可能会出现此错误。

可能原因

未安装风扇。

风扇堵塞。

故障排查

检查风扇是否堵塞。

检查风扇电缆是否正确连接或是否损坏。

AQ262449648484zh-000201 / 175R1135158 | Danfoss A/S © 2020.10

诊断

VLT® Servo Drive System ISD 510/DSD 510

操作指南



9.3 ISD 510/DSD 510 伺服系统的错误代码

9.3.1 无错误 (0x0000 / 0x0)
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误代码。

表 41: 无错误 (0x0000 / 0x0)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x0000 0x0 无错误 错误 无错误。 –

9.3.2 一般应用错误 (0x1000 / 0x100)
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 42: 一般性错误 (0x1000 / 0x100)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x1000 0x100 一般性应用错误 错误 一般性应用错误。 generic err

9.3.3 过电流跳闸 (0x2310 / 0x101)
ISD 510/DSD 510 可能会出现此错误。

表 43: Overcurr out (0x2310 / 0x101)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2310 0x101 过电流跳闸 错误 输出过电流跳闸。 overcurr trip

9.3.4 高连续电流过载 (0x2311 / 0x15F)
DAM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 44: 高电流过载 (0x2311 / 0x15F)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2311 0x15F 高连续电流过载 错误 高连续电流过载错误。 High curr ovld

9.3.5 连续电流过载 (0x2312 / 0x160)
DAM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 45: 连续电流过载 (0x2312 / 0x160)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2312 0x160 连续电流过载 错误 连续电流过载错误。 cont curr ovld

9.3.6 高连续功率过载 (0x2313 / 0x161)
PSM 510 可能会出现此错误。

表 46: 高连续功率过载 (0x2313 / 0x161)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2313 0x161 高连续功率过载 警告, 错误 高连续功率过载错误。 high pwr ovld

9.3.7 连续功率过载 (0x2314 / 0x162)
PSM 510 可能会出现此错误。
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表 47: 连续功率过载 (0x2314 / 0x162)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2314 0x162 连续功率过载 警告, 错误 连续功率过载错误。 cont pwr ovld

9.3.8 过电流短路 (0x2320 / 0x163)
PSM 510 和 ACM 510 可能会出现此错误。

表 48: 过电流短路 (0x2320 / 0x163)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2320 0x163 过电流短路 跳闸锁定 过电流短路错误。 over curr short

9.3.9 接地故障 (0x2330 / 0x151)
PSM 510、DAM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 49: 接地故障 (0x2330 / 0x151)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2330 0x151 接地故障 警告, 错误 输出相向大地放电。 ground fault

9.3.10 辅助线路过电流 (0x2391 / 0x125)
DAM 510 可能会出现此错误。

表 50: 辅助线路过电流 (0x2391 / 0x125)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x2391 0x125 辅助线路过电流 错误 辅助线路上的电流已达到过电流
极限。

AUX overcurr

9.3.11 辅助线路用户限制电流 (0x2393 / 0x127)
DAM 510 可能会出现此错误。

表 51: 辅助线路用户限制电流 (0x2393 / 0x127)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x2393 0x127 辅助线路用户限制
电流

错误 辅助线路上的电流已达到用户定
义的故障极限。

AUX curr
limit

9.3.12 辅助线路用户限制电流警告 (0x2394 / 0x128)
PSM 510 和 ACM 510 可能会出现此错误。

表 52: 辅助线路用户限制电流警告 (0x2394 / 0x128)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x2394 0x128 辅助线路用户限制电
流警告

警告 辅助线路上的电流已达到用户定
义的警告极限。

AUX curr
warn

9.3.13 辅助电源故障 (0x2395 / 0x129)
DAM 510 可能会出现此错误。
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表 53: 辅助电源故障 (0x2395 / 0x129)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x2395 0x129 辅助电源故障 错误 硬件回路指示的辅助电源故
障。

AUX supply fail

9.3.14 电流过载跳闸 (0x2396 / 0x15C)
DAM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 54: 电流过载跳闸 (0x2396 / 0x15C)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2396 0x15C 电流过载跳闸 错误 电流过载跳闸错误。 curr ovld trip

9.3.15 功率过载跳闸 (0x2397 / 0x12B)
PSM 510 可能会出现此错误。

表 55: 功率过载跳闸 (0x2397 / 0x12B)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2397 0x12B 功率过载跳闸 错误 功率过载跳闸错误。 pwr ovld trip

9.3.16 电机热过载 (0x239B / 0x102)
ISD 510/DSD 510 可能会出现此错误。

表 56: 电机热过载 (0x239B / 0x102)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x239B 0x102 电机热过载 警告, 错误 电机热过载错误。 therm ovld motor

9.3.17 主电源缺相 (0x3130 / 0x12F)
PSM 510 可能会出现此错误。

表 57: 主电源缺相 (0x3130 / 0x12F)

代码 PROFINETô  代
码

名称 严重程度（警告/错
误/跳闸锁定）

说明 LCP 名称

0x3130 0x12F 主电源缺
相

错误 检测到主电源缺相。

当主电源上的相位缺失或主电源不平衡时，会
出现此情况。

phase loss

9.3.18 直流回路过电压 (0x3210 / 0x103)
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 58: 直流回路过电压 (0x3210 / 0x103)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x3210 0x103 直流回路过电压 错误 直流回路电压超过极限。 UDC overvolt

9.3.19 直流回路欠压 (0x3220 / 0x104)
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误。
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表 59: 直流回路欠压 (0x3220 / 0x104)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x3220 0x104 直流回路欠
压

错误 低于限值的直流回路电压处于 Operation

enabled（允许运行）状态。

UDC 欠压

9.3.20 直流回路充电错误 (0x3230 / 0x152)
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 60: 直流回路充电错误 (0x3230 / 0x152)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x3230 0x152 直流回路充电
错误

错误 直流回路充电错误。已超过为直流回
路充电的昀长时间限制。

直流回路充电

9.3.21 直流回路不平衡 (0x3280 / 0x153)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 61: 直流回路不平衡 (0x3280 / 0x153)

代码 PROFINETô  代
码

名称 严重程度（警告/错误/跳
闸锁定）

说明 LCP 名称

0x3280 0x153 直流回路不平
衡

跳闸锁定 直流回路不平衡。此故障表示直
流回路的内部故障。

直流回路不平衡

9.3.22 UAUX 电压过高 (0x3291 / 0x132)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 62: UAUX 电压过高 (0x3291 / 0x132)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x3291 0x132 UAUX 电压过高 警告 UAUX 超过警告极限。 UAUX high volt

9.3.23 UAUX 过电压 (0x3292 / 0x133)
DAM 510 可能会出现此错误。

表 63: UAUX 过电压 (0x3292 / 0x133)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x3292 0x133 UAUX 过电压 错误 UAUX 超过过电压极限。 UAUX overvolt

9.3.24 UAUX 电压过低 (0x3293 / 0x134)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 64: UAUX 电压过低 (0x3293 / 0x134)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x3293 0x134 UAUX 电压过低 警告 UAUX 低于警告极限。 UAUX low volt

9.3.25 UAUX 欠压 (0x3294 / 0x135)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。
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表 65: UAUX 欠压 (0x3294 / 0x135)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x3294 0x135 UAUX 欠压 错误 UAUX 低于欠压极限。 UAUX undervolt

9.3.26 直流回路电压高 (0x3295 / 0x136)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 66: 直流回路电压高 (0x3295 / 0x136)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x3295 0x136 直流回路电压高 警告 直流回路电压高于高压警告极
限。

UDC high
volt

9.3.27 直流回路电压高 (0x3296 / 0x137)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 67: UDC 电压过低 (0x3296 / 0x137)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x3296 0x137 直流回路电压低 警告 直流回路电压低于低压警告极
限。

UDC low volt

9.3.28 UAUX 充电错误 (0x3297 / 0x154)
DAM 510 可能会出现此错误。

表 68: UAUX 充电错误 (0x3297 / 0x154)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错
误/跳闸锁定）

说明 LCP 名称

0x3297 0x154 UAUX 充电错

误

错误 当 UAUX 正在充电时出现加载错误。已超过

为辅助线路充电的昀长时间限制。

UAUX charg
err

9.3.29 直流回路关闭错误 (0x3298 / 0x165)
DAM 510 可能会出现此错误。

表 69: 直流回路关闭错误 (0x3298 / 0x165)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x3298 0x165 直流回路关闭错误 错误 当 UDC 处于关闭阶段时
出错。

UDC shutdwn err

9.3.30 UAUX 关闭错误 (0x3299 / 0x155)
DAM 510 可能会出现此错误。

表 70: UAUX 关闭错误 (0x3299 / 0x155)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x3299 0x155 UAUX 关闭错误 错误 当 UAUX 处于关闭阶段时出

错。

UAUX shtdwn err
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9.3.31 UAUX 欠压硬件 (0x329A / 0x156)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 71: UAUX 欠压硬件 (0x329A / 0x156)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x329A 0x156 UAUX 欠压硬件 错误 硬件电路检测到 UAUX 欠

压。

AUX undervol HW

9.3.32 设备温度过高 (0x4210 / 0x157)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 72: 设备温度过高 (0x4210 / 0x157)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x4210 0x157 设备温度过
高

警告, 错误 超过主设备组件的昀高温度时触发。

PSM： 可控硅整流器模块。

DAM： 高侧和低侧 IGBT 的昀高温度。

overtemp de‐
vice

9.3.33 设备温度过低 (0x4220 / 0x138)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 73: 设备温度过低 (0x4220 / 0x138)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x4220 0x138 设备温度过低 错误 设备温度过低，无法运行。 undertemp device

9.3.34 温度过高： 控制卡 (0x4291 / 0x106)
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 74: 温度过高： 控制卡 (0x4291 / 0x106)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x4291 0x106 温度过高： 控制卡 错误 超过控制卡的昀高温度。 overtemp CC

9.3.35 温度过高： 功率卡 (0x4292 / 0x107)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 75: 温度过高： 功率卡 (0x4292 / 0x107)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x4292 0x107 温度过高： 功率卡 警告, 错误 超过功率卡的昀高温度。 overtemp PC

9.3.36 直流回路浪涌温度过高 (0x4293 / 013C)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。
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表 76: 直流回路浪涌温度过高 (0x4293 / 0x13C)

代码 PROFINETÆ

代码

名称 严重程度（警告/错
误/跳闸锁定）

说明 LCP 名称

0x4293 0x13C 浪涌导致温度过高：
直流回路

错误 浪涌电流冲击故障。

短时间内太多次转换到状态 Operation

enabled（允许运行）。

UDC in‐
rush

9.3.37 AUX 线路浪涌导致温度过高 (0x4294 / 0x13D)
DAM 510 可能会出现此错误。

表 77: AUX 线路浪涌导致温度过高 (0x4294 / 0x13D)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x4294 0x13D AUX 线路浪涌导致
温度过高

错误 浪涌电流冲击故障。

短时间内 AUX 电压的上电次数太
多。

UAUX 浪涌

9.3.38 温度过高： 电机 (0x4310 / 0x108)
ISD 510/DSD 510 可能会出现此错误。

表 78: 温度过高： 电机 (0x4310 / 0x108)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x4310 0x108 温度过高： 电机 错误 电机温度过高。 overtemp motor

9.3.39 充电开关故障电压 (0x5121 /0x158)
PSM 510 可能会出现此错误。

表 79: 充电开关故障电压 (0x5121 / 0x158)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x5121 0x158 充电开关故障电
压

跳闸锁定 指示内部充电电路出现故
障。

Chg switch
fail

9.3.40 EE 校验和错误（参数缺失）(0x5530 / 0x10A)
ISD 510/DSD 510 可能会出现此错误。

表 80: EE 校验和错误（参数缺失）(0x5530 / 0x10A)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x5530 0x10A EE 校验和错误（参数
缺失）

跳闸锁定 EEPROM 校验和错误或设备
参数缺失。

eeprom err

9.3.41 参数错误 (0x6320 / 0x10B)
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误。
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表 81: 参数错误 (0x6320 / 0x10B)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x6320 0x10B 参数错误 跳闸锁定 参数值无效。 param err

9.3.42 配置参数版本错误 (0x6382 / 0x15D)
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 82: 配置参数版本错误 (0x6382 / 0x15D)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/跳
闸锁定）

说明 LCP 名称

0x6382 0x15D 配置参数版本
错误

跳闸锁定 配置参数集版本不匹配： 参数集
对此设备无效。

conf par
ver

9.3.43 配置参数限值错误 (0x6383 / 0x164)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 83: 配置参数限值错误 (0x6383 / 0x164)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x6383 0x164 配置参数限值
错误

跳闸锁定 配置参数集中的 1 个或多个参数超出极
限： 该参数集对此设备无效。

conf par
lim

9.3.44 功率 EEprom 配置错误 (0x6384 / 0x166)
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 84: 功率 EEprom 配置错误 (0x6384 / 0x166)

代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x6384 0x166 功率 EEprom 配置
错误

跳闸锁定 功率设备 Eeprom 损坏或与此控
制板不兼容。

conf par EE‐
PROM

9.3.45 制动斩波器出错 (0x7111 / 0x141)
PSM 510 可能会出现此错误。

表 85: 制动斩波器出错 (0x7111 / 0x141)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x7111 0x141 制动斩波器出
错

警告, 错误 运行过程中监测制动斩波器。

制动检查功能已检测到制动错误。

brake ch
fail

9.3.46 制动斩波器过电流 (0x7112 / 0x167)
PSM 510 可能会出现此错误。

表 86: 制动斩波器过电流 (0x7112 / 0x167)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x7112 0x167 制动斩波器过电
流

跳闸锁定 制动斩波器电流超过极
限。

brake ch over‐
curr
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9.3.47 制动斩波器模块过载 (0x7181 / 0x142)
PSM 510 可能会出现此错误。

表 87: 制动电阻器昀大功率极限 (0x7181 / 0x142)

代码 PROFINETÆ

代码

名称 严重程度（警告/错
误/跳闸锁定）

说明 LCP 名称

0x7181 0x142 制动斩波器模
块过载

警告, 错误 运行过程中监测制动斩波器的功率负载。达到
制动斩波器的昀大功率限值时，出现此错误。

mod ovl

9.3.48 外部制动斩波器过载 (0x7182 / 0x143)
PSM 510 可能会出现此错误。

表 88: 外部制动斩波器过载 (0x7182 / 0x143)

代码 PROFINETÆ

代码

名称 严重程度（警告/

错误/跳闸锁定）
说明 LCP 名称

0x7182 0x143 外部制动
斩波器过
载

警告, 错误 运行过程中监测制动斩波器的功率负载。

根据外部制动斩波器功率监测的配置，达到配置的标

称外部制动斩波器功率时，出现此警告或故障。

ext brake
ch ovl

9.3.49 制动电压过高 (0x7183 / 0x159)
PSM 510 可能会出现此错误。

表 89: 制动电压过高 (0x7183 / 0x159)

代码 PROFINETÆ

代码

名称 严重程度（警告/错
误/跳闸锁定）

说明 LCP 名称

0x7183 0x159 制动电压
过高

警告 主电源电压过高。因此，可能会根据制动斩波器

启动水平参数中输入的值连续激活制动斩波器。

brake ch
high volt

9.3.50 内部位置传感器错误 (0x7320 / 0x10C)
ISD 510/DSD 510 可能会出现此错误。

表 90: 内部位置传感器错误 (0x7320 / 0x10C)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x7320 0x10C 内部位置传感器错
误

跳闸锁定 绝对位置传感器错
误。

int sensor err

9.3.51 外部位置传感器错误 (0x7380 / 0x10D)
DAM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 91: 外部位置传感器错误 (0x7380 / 0x10D)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x7380 0x10D 外部位置传感器错
误

错误 无法读取外部编码器数
据。

ext sensor err

9.3.52 跟随性错误 (0x8611 / 0x10E)
ISD 510/DSD 510 可能会出现此错误。

AQ262449648484zh-000201 / 175R1135 | 167Danfoss A/S © 2020.10

诊断

VLT® Servo Drive System ISD 510/DSD 510

操作指南



表 92: 跟随性错误 (0x8611 / 0x10E)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x8611 0x10E 跟随性错误 警告, 错误 出现跟随性错误。 following err

9.3.53 进入归位模式时出现归位错误 (0x8693 / 0x10F)
ISD 510/DSD 510 可能会出现此错误。

表 93: 进入归位模式时出现归位错误 (0x8693 / 0x10F)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x8693 0x10F 进入归位模式时出现归
位错误

警告 无法进入归位模式（例如，
速度不为 0）。

Homing mode
fail

9.3.54 启动归位方法时出现归位错误 (0x8694 / 0x110)
ISD 510/DSD 510 可能会出现此错误。

表 94: 启动归位方法时出现归位错误 (0x8694 / 0x110)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错
误/跳闸锁定）

说明 LCP 名称

0x8694 0x110 启动归位方法时出
现归位错误

警告 无法启动归位方法（例如，驱动
器未处于静止状态）。

Homing method
fail

9.3.55 归位错误距离 (0x8695 / 0x111)
ISD 510/DSD 510 可能会出现此错误。

表 95: 归位错误距离 (0x8695 / 0x111)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x8695 0x111 归位错误距离 警告 已达到归位距离。 Homing distance

9.3.56 机械制动故障 (0xFF01 / 0x112)
ISD 510/DSD 510 可能会出现此错误。

表 96: 机械制动故障 (0xFF01 / 0x112)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF01 0x112 机械制动故障 跳闸锁定 无制动或线缆故障。 brake mech fail

9.3.57 机械制动控制中出现短路 (0xFF02 / 0x113)
ISD 510/DSD 510 可能会出现此错误。

表 97: 机械制动控制中出现短路 (0xFF02 / 0x113)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0xFF02 0x113 机械制动控制中出现
短路

跳闸锁定 制动控制中出现短
路。

brake mech
short

9.3.58 外部接口电源故障 (0xFF0A / 0x114)
ISD 510/DSD 510 可能会出现此错误。
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表 98: 外部接口电源故障 (0xFF0A / 0x114)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF0A 0x114 外部接口电源故障 错误 外部接口电源故障。 ext IF pwr fail

9.3.59 风扇反馈不一致 (0xFF21 / 0x145)
PSM 510 可能会出现此错误。

表 99: 风扇反馈不一致 (0xFF21 / 0x145)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF21 0x145 风扇反馈不一致 警告 内部风扇故障。

内部风扇未在运行或未安装。

风扇反馈

9.3.60 风扇使用寿命到期 (0xFF22 / 0x15A)
PSM 510 可能会出现此错误。

表 100: 风扇使用寿命到期 (0xFF22 / 0x15A)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0xFF22 0x15A 风扇使用寿命到期 警告 已超过风扇的理论使用寿
命。

fan lifetime

9.3.61 定时违规 1 (0xFF60 / 0x115)
ISD 510/DSD 510 可能会出现此错误。

表 101: 定时违规 1 (0xFF60 / 0x115)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF60 0x115 定时违规 1 跳闸锁定 联系 Danfoss。 timing err 1

9.3.62 定时违规 2 (0xFF61 / 0x116)
ISD 510/DSD 510 可能会出现此错误。

表 102: 定时违规 2 (0xFF61 / 0x116)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF61 0x116 定时违规 2 跳闸锁定 联系 Danfoss。 timing err 2

9.3.63 定时违规 3 (0xFF62 / 0x117)
ISD 510/DSD 510 可能会出现此错误。

表 103: 定时违规 3 (0xFF62 / 0x117)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF62 0x117 定时违规 3 跳闸锁定 联系 Danfoss。 timing err 3

9.3.64 定时违规 4 (0xFF63 / 0x118)
ISD 510/DSD 510 可能会出现此错误。
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表 104: 定时违规 4 (0xFF63 / 0x118)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF63 0x118 定时违规 4 跳闸锁定 联系 Danfoss。 timing err 4

9.3.65 定时违规 5 (0xFF64 / 0x119)
ISD 510/DSD 510 可能会出现此错误。

表 105: 定时违规 5 (0xFF64 / 0x119)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF64 0x119 定时违规 5 跳闸锁定 联系 Danfoss。 timing err 5

9.3.66 定时违规 6 (0xFF65 / 0x11A)
ISD 510/DSD 510 可能会出现此错误。

表 106: 定时违规 6 (0xFF65 / 0x11A)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF65 0x11A 定时违规 6 跳闸锁定 联系 Danfoss。 timing err 6

9.3.67 定时违规 7 (0xFF66 / 0x168)
ISD 510/DSD 510 可能会出现此错误。

表 107: 定时违规 7 (0xFF66 / 0x168)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF66 0x168 定时违规 7 跳闸锁定 联系 Danfoss。 timing err 7

9.3.68 定时违规 8 (0xFF67 / 0x16B)
ISD 510/DSD 510 可能会出现此错误。

表 108: 定时违规 8 (0xFF67 / 0x16B)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF67 0x16B 定时违规 8 跳闸锁定 联系 Danfoss。 timing err 8

9.3.69 定时违规 9 (0xFF68 / 0x16C)
ISD 510/DSD 510 可能会出现此错误。

表 109: 定时违规 9 (0xFF68 / 0x16C)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF68 0x16C 定时违规 9 跳闸锁定 联系 Danfoss。 timing err 9

9.3.70 固件： 程序包描述不匹配 (0xFF70 / 0x11B)
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误。
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表 110: 固件： 程序包描述不匹配 (0xFF70 / 0x11B)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0xFF70 0x11B 固件： 程序包描述不
匹配

跳闸锁定 找到的固件与程序包描述
不匹配。

FW pack err

9.3.71 固件： 需要重启 (0xFF71 / 0x11C)
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 111: 固件： 需要重启 (0xFF71 / 0x11C)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0xFF71 0x11C 固件： 需要重启 警告, 错误 已完成传输固件更新，但需要重启才
能激活新固件。

需要重启

9.3.72 固件： 已开始更新 (0xFF72 / 0x11D)
PSM 510、DAM 510、ACM 510 和 ISD 510/DSD 510 可能会出现此错误。

表 112: 固件： 已开始更新 (0xFF72 / 0x11D)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0xFF72 0x11D 固件： 已开始
更新

警告, 错误 正在进行固件更新。

在此状态下尝试启用设备时，将警告进行更
改会导致错误。

FW update

9.3.73 固件： 更新无效 (0xFF73 / 0x15B)
PSM 510 和 ACM 510 可能会出现此错误。

表 113: 固件： 更新无效 (0xFF73 / 0x15B)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0xFF73 0x15B 固件： 更新无效 错误 固件程序包的更新无效或已损坏。

已加载昀后有效的固件程序包。

FW upd invalid

9.3.74 启用驱动器后激活 STO (0xFF80 / 0x11E)
ISD 510/DSD 510 可能会出现此错误。

表 114: 启用驱动器后激活 STO (0xFF80 / 0x11E)

代码 PROFINETÆ 代

码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0xFF80 0x11E 启用驱动器后激
活 STO

错误 启用驱动器后激活 STO，或尝试在激
活 STO 后启用驱动器。

STO active

9.3.75 STO 不匹配 (0xFF81 / 0x11F)
ISD 510/DSD 510 可能会出现此错误。
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表 115: STO 不匹配 (0xFF81 / 0x11F)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF81 0x11F STO 不匹配 跳闸锁定 STO 电压的双重诊断不可信。 STO 不匹配

9.3.76 P_STO 错误 (0xFF85 / 0x120)
ISD 510/DSD 510 可能会出现此错误。

表 116: P_STO 错误 (0xFF85 / 0x120)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF85 0x120 P_STO 错误 跳闸锁定 功率卡上的 P_STO 电压超过限
值。

P_STO 错误

9.3.77 指导值相反 (0xFF90 / 0x121)
ISD 510/DSD 510 可能会出现此错误。

表 117: 指导值相反 (0xFF90 / 0x121)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳
闸锁定）

说明 LCP 名称

0xFF90 0x121 指导值相反 错误 当伺服驱动器处于 CAM 模式时，位置
指导值与此相反。

guide val
rev

9.3.78 指导值不可信 (0xFF91 / 0x122)
ISD 510/DSD 510 可能会出现此错误。

表 118: 指导值不可信 (0xFF91 / 0x122)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF91 0x122 指导值不可信 错误 后继值之间的增量太大。 guide val impl

9.3.79 运行迹象错误 (0xFF95 / 0x14E)
ISD 510/DSD 510 可能会出现此错误。

表 119: 运行迹象错误 (0xFF95 / 0x14E)

代码 PROFINETÆ 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF95 0x14E 运行迹象错误 错误 PROFINETÆ 运行迹象错误。 PNIO SOL error
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10 维护、报废和处置

10.1 警告

警 告
高电压

连接器上存在可能致命的电压，这可能会导致严重伤亡。

在接触电源或信号连接器（断开或连接电缆）或执行任何维护工作之前，应将电源模块 (PSM 510) 与主电源断开，并等
待放电完毕。

警 告
放电时间

伺服系统包含直流回路电容器，该电容器在电源模块 (PSM 510) 的主电源关闭后保持充电一段时间。如果切断电源后在规定

的时间结束之前就执行维护或修理作业，可能导致死亡或严重伤害。

为避免电击，将电源模块 (PSM 510) 与主电源完全断开，并等待电容器完全放电后，再在伺服系统或其组件上执行任何
维护或维修工作。

昀短等待时间（分钟）

15

10.2 维护任务
ISD 510/DSD 510 伺服驱动器很大程度上不需要维护。只有 ISD 510 上的轴封（如果使用）会发生磨损。维护任务必须由具
备相应资质的人员来完成。不需要执行任何其他任务。

表 120: 维护任务概述

组件 维护任务 维护时间间隔 说明

伺服驱动器 执行目视检查。 每隔 6 个月 检查伺服驱动器表面有无任何异常。

ISD 510 上的轴封 检查状况以及是否存在泄漏。 每 6 个月(1) 如果有损坏，则更换轴封。

ISD 510 上的法兰连接 测量电阻。 每隔 12 个月。 测量 ISD 510 上法兰连接的电阻。

混合电缆 检查损坏和磨损情况。 每隔 6 个月 如果损坏或磨损： 更换混合电缆。

机械夹持制动（可选） 检查制动器。 每隔 6 个月 确保制动器可能达到夹持力矩。

功能安全 执行系统重启并检查 STO 功能。 每隔 12 个月 激活 STO 并检查 PLC 的运行状态。

系统模块 检查风扇。 每隔 12 个月 检查风扇能否转动并擦除所有灰尘或脏物。

执行目视检查 每隔 6 个月 检查模块表面有无任何异常。

1 根据应用，可能需要缩短间隔。请与丹佛斯联系以了解更多信息。

10.3 运行期间的检查

10.3.1 ISD 510/DSD 510 伺服驱动器
在运行期间执行定期检查。每隔一段时间检查 ISD 510/DSD 510 伺服驱动器是否出现异常。

特别注意：

异常噪音（仅 ISD 510/DSD 510）。

过热表面（正常运行期间温度可能达到 100 °C）

运行不平稳（仅 ISD 510/DSD 510）。
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1.

2.

3.

4.

1.

2.

3.

4.

5.

6.

1.

强烈振动。

紧固件松脱。

电气线路和电缆的状况。

散热不良。

10.3.2 系统模块
在运行期间执行定期检查。

检查：

冷却通风管是否阻塞。

风扇有无发出任何异常噪声。

电气线路和电缆的状况。

10.4 维修
务必联系当地的 Danfoss 销售公司，了解有关维修政策的信息。

10.5 ISD 510/DSD 510 伺服驱动器更换

10.5.1 拆除 ISD 510/DSD 510 伺服驱动器
步骤

断开电源，按照放电时间等待一段时间。

断开电气电缆。

拆除伺服驱动器。

使用同类伺服驱动器进行更换。请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô )

设计指南查看部件号。

10.5.2 安装和调试 ISD 510/DSD 510 伺服驱动器
步骤

检查是否需要准备（请参阅 4.6.1 ISD 510/DSD 510 伺服驱动器）。

安装伺服驱动器（参见 4.7.5.2 夹钳 ISD 510 伺服驱动器）。

连接混合电缆（参见 5.9.3 连接混合电缆）。

连接 I/O 和/或编码器电缆（参见 5.9.5.2 将 I/O 和/或编码器电缆连接到端口 X3）。

根据所用现场总线配置伺服驱动器的参数（参见 6.3 EtherCAT® ID 分配 和 6.4 以太网 POWERLINK® ID 分配）。

执行试运行。

10.6 系统模块更换

10.6.1 拆卸系统模块
断开 PSM 510 的主电源和所有辅助电源，等待放电时间过去。
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-

-

-

-

3.

-

-

-

断开系统模块底部的 EMC 板的连接。请勿从 EMC 板上拆除连接器。

1

2

3

4

e
3

0
b

g
8

1
3

.1
0

图解 110: 断开 EMC 板的连接

拔下 RJ45 连接器 [2]（仅限 DAM 510）。

拧下 EMC 板上的螺钉 [4]。

按卡夹 [3] 松开 EMC 板。

拧下 PE 螺钉 [1]。

断开系统模块顶部的 I/O 屏蔽板的连接：

1

3

2

e3
0b

g8
14

.1
0

图解 111: 断开 I/O 屏蔽板的连接

拔下顶部连接器 [1]。

拧下 I/O 屏蔽板 [3] 上的螺钉 [2]。

向上拉动 I/O 屏蔽板以拆除。
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4.



5.



1.

2.

3.

松开模块顶部的固定夹具 [1]。

1

e3
0b

g8
15

.1
0

STATUS PSM

DEV

SVS ST

NET ST

LINK/ACT
X1

X2

STATUS DAM
DEV

SVS ST

NET ST

AUX

LINK/ACT
X1

X2

X3

STATUS DAM
DEV

SVS ST

NET ST

AUX

LINK/ACT
X1

X2

X3

LCP
LCP

LCP

图解 112: 松开固定夹具

将模块向前倾斜，将它从背板上拆除。

X2

e3
0b

g8
16

.1
0

STATUS PSM

DEV

SVS ST

NET ST

LINK/ACT
LIN

S

X2

LCP

STATUS DAM
DEV

SVS ST
NET ST

AUX

LINK/ACT

X1

X1
X

X2

X3

X3

LCP

图解 113: 拆除模块

10.6.2 安装和调试系统模块
检查是否需要准备（请参阅 4.6.2 系统模块）。

安装系统模块（请参阅 4.7.7 系统模块安装说明）。

连接电气电缆（请参阅电气安装一章）。
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4.

5.

6.

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

1.

2.

-

打开系统（请参阅 6.8 打开 ISD 510/DSD 510 系统）。

根据所用现场总线配置系统模块的参数（请参阅 6.3 EtherCAT® ID 分配、6.4 以太网 POWERLINK® ID 分配 和 6.5
PROFINET® ID 分配）。

执行试运行。

10.7 电缆更换

10.7.1 概述
当已达到额定弯曲次数或电缆损坏时，应更换电缆。

注 意

请勿强制连接或安装连接器。错误连接可能会对连接器造成永久损坏。

10.7.2 馈电电缆更换

10.7.2.1 断开馈电电缆的连接
步骤

断开电源模块 (PSM 510) 与电源（电网和所有辅助电源）的连接。

等待必需的放电时间。

断开连接到两个 ISD 510/DSD 510 伺服驱动器上的 X3、X4 或 X5 端口的任何电缆，方便对馈电电缆进行处理。

断开 PE 线缆与分布式访问模块 (DAM 510) 上的 PE 螺钉的连接。

断开以太网连接器的连接。

拆除 DAM 510 上的 EMC 板。

打开固定 STO 电缆的电缆扎带。

打开将馈电电缆固定在 DAM 510 上的电缆扎带。

拧松 DAM 510 上的馈电电缆连接器。

从 DAM 510 上断开馈电电缆的连接。

拧松伺服驱动器上连接器的螺纹环。

从伺服驱动器上断开馈电电缆的连接。

10.7.2.2 更换馈电电缆
使用具有相同类型和长度的电缆更换馈电电缆。请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flex‐

motionô ) 设计指南查看部件号。

10.7.2.3 连接馈电电缆
将馈电电缆的母接头连接到第一个伺服驱动器的公接头。

用手将连接器的螺纹压圈拧紧。

确保电缆上无机械应力。

将馈电电缆插入分布式访问模块 (DAM 510) 底部的 EMC 板上的正确连接器。

使用电缆扎带固定馈电电缆。

使用电缆扎带固定 STO 电缆。

在 DAM 510 上安装 EMC 板。

将以太网连接器连接到 DAM 510。

将 PE 线缆连接到 DAM 510 上的 PE 螺钉。

重新连接以前连接到 X3、X4 或 X5 端口的任何电缆。

10.7.3 环路电缆更换

10.7.3.1 断开环路电缆的连接
步骤

断开电源模块 (PSM 510) 与电源（电网）和所有辅助电源的连接。

等待必需的放电时间。
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3.

4.

5.

1.

2.

3.

4.

5.

6.

1.



断开连接到两个 ISD 510/DSD 510 伺服驱动器上的 X3、X4 或 X5 端口的任何电缆，方便对环路电缆进行处理。

拧松两个伺服驱动器上环路电缆连接器的螺纹压圈。

断开环路电缆与伺服驱动器的连接。

10.7.3.2 更换环路电缆
使用具有相同类型和长度的电缆更换环路电缆。请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flex‐

motionô ) 设计指南查看部件号。

10.7.3.3 连接环路电缆
将环路电缆的公接头连接到伺服驱动器的母接头。

将环路电缆的母接头连接到邻近伺服驱动器的公接头。

用手将两个伺服驱动器上的螺纹压圈拧紧。

确保电缆上无机械应力。

拧紧两个伺服驱动器上的连接器的螺纹压圈。

重新连接两个伺服驱动器上以前连接到 X3、X4 或 X5 端口的任何电缆。

10.8 在分布式访问模块 (DAM 510) 中更换熔断器
如果一个熔断器熔断，则使用同一批次的熔断器更换所有熔断器（熔断器 CAT 编号为 5012006.25，SIBA）。
步骤

拆除螺钉 [1] 然后拆除盖板。

1

e
3

0
b

g
8

0
0

.1
0

图解 114: 打开 DAM 510 上的盖板
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2.



3.

使用螺丝刀拆除熔断器，然后使用相同数量的同一类型的熔断器（请参阅 5.5.1 熔断器）替换它们。

e
3

0
b

g
8

0
1

.1
0

图解 115: 拆除熔断器

重新装回盖板并拧紧螺钉。紧固力矩为 2 Nm。

10.9 更换风扇

e
3

0
b

g
8

1
7

.1
0

图解 116: 更换 50 毫米模块上的风扇
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1.

2.

3.

-

e
3

0
b

g
8

1
8

.1
0

图解 117: 更换 100 毫米模块上的风扇

注 意

请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) 设计指南，了解风扇类型的更多信

息。

步骤

使用螺丝刀作为撬杆，松开风扇支架。

拆下风扇。

使用同类风扇进行更换。

10.10 产品退回
可以将 Danfoss 产品退回来进行免费处置。前提条件是这些产品上不带有影响处置的沉积物，如油、油脂或其他类型污染物。
此外，在退回的产品中不能包括任何异物或第三方组件。

将产品以船上交货形式发运到当地的 Danfoss 销售公司。

10.11 回收
将金属和塑料送至回收站。

伺服驱动器和系统模块被分类为电子废弃物，包装被分类为包装废弃物。

10.12 处置
包含电子元件的设备不能与正常生活垃圾一起处置。

按照适用的地方法规，将伺服驱动器和系统模块作为危险废弃物、电气废弃物、可回收废弃物等进行处置。
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11 规格

11.1 铭牌

11.1.1 ISD 510/DSD 510 伺服驱动器上的铭牌
查看铭牌并将它与订单数据进行比较。使用部件编号作为参考。部件编号用于唯一标识驱动器类型。

确保铭牌清晰可辨。

伺服驱动器在外观上只通过原始 Danfoss 铭牌进行标识。

伺服驱动器铭牌上显示以下数据：

e3
0b

g8
28

.1
0

VLT ISD 510

Input1: 560-680VDC 3.4A             Input2: 24-48VDC 0.3A

Ambient: 5... 40˚C / 41...104˚F
Enclosure: IP54      Class F

PART NO: 136X6382
SERIAL NO: 001301Q170

 00:1B:08:22:D5:E8

136X6382001301Q170
Made in Italy

Danfoss A/S 6430 
Nordborg, Denmark

SCCR: 5kA
Internal Motor Overload Protection 105%
E134261 Power Conversion Equipment

Mnom: 6.0Nm Nnom: 3000rpm Pnom: 1.9kW fout: 0...590Hz

ISD510AT06C0D6E54FM1PNSXXTF108SXN30BKXSX 
1

2

4
3

5
6

7

8
9

Mmax: 29.9Nm I0: 4.9A M0: 8.6Nm

VAI

图解 118: ISD 510 伺服驱动器上的铭牌示例

1 类型代码

2 供电电压

3 额定转矩

4 昀大转矩

5 环境温度范围

6 防护等级

7 辅助输入电压

8 输出频率

9 额定转速

e3
0b

g8
27

.1
0VLT DSD 510

Input1: 560-680VDC 8.3A             Input2: 24-48VDC 1.0A

Ambient: 5˚... 40˚C / 41˚... 104˚F
Enclosure: IP67

PART NO: 136L3447
SERIAL NO: 018601Q050

 00:1B:08:20:E1:BF

136L3447018601Q050
Made in Italy

Danfoss A/S 6430 
Nordborg, Denmark

SSCR: 5kA
Internal Motor Overload Protection 105%
E134261 Power Conversion Equipment

Uout: 3x 0-Input1 VAC Inom: 8.0A Pnom: 4.4kW fout: 0...590Hz

DSD510AC08A8D6E67FRXPLSXXTF2S2XXXXXXXXSX
1

2

4
3

5
6

7

9
8

Umax: 3x 0-Input1 VAC Imax: 21.0A Pmax: 11.5kW

VAI

图解 119: DSD 510 伺服驱动器上的铭牌示例
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1 类型代码

2 供电电压

3 输出电压

4 昀大电压

5 环境温度范围

6 防护等级

7 输出频率

8 峰值功率

9 峰值电流

11.1.2 系统模块上的铭牌

11.1.2.1 系统模块正面的铭牌示例
确保铭牌清晰可辨。

系统模块正面的铭牌上显示出以下数据：

VLT PSM 510

DANGER

PART NO:     175G0166

SERIAL NO:  966001Q368

OUTPUT: Pnom: 30kW

Notes:

MAC PSM
X1 IN:

X2 OUT:

15 MIN

00:1B:08:15:B3:XX
00:1B:08:15:B3:XX

00:1B:08:15:B3:XX

e3
0b

g2
76

.1
01

2

3
4

5

6

7

8

9
Motor over-temperature sensing is required

图解 120: 系统模块正面的铭牌示例

1 丹佛斯徽标

2 系统模块名称

3 部件编号

4 序列号

5 输出

6 二维码

7 注释

8 MAC 地址

9 警告符号

11.1.2.2 系统模块侧面的铭牌示例
系统模块正面的铭牌上显示出以下数据：
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图解 121: PSM 510 的系统模块侧面的铭牌示例

1 类型代码

2 供电电压

3 输出电压

4 昀大功率

5 环境温度范围

6 防护等级： IP20，符合 IEC/EN 60529（连接器除
外，它的防护等级为 IP00）。

7 UAUX 电源

8 短路电流额定值

9 额定功率

11.2 特性数据

11.2.1 不带制动器的 ISD 510 伺服驱动器特性数据

表 121: 不带制动器的伺服驱动器特性数据

规格 单位 规格 1，1.5

Nm

规格 2，2.1

Nm

规格 2，2.9

Nm

规格 2，3.8

Nm

规格 3，5.2

Nm

规格 3，6.0

Nm

规格 4，
11.2 Nm

规格 4，
13.0

Nm(1)

额定转速
nN

RPM 4600 4000 2900 2400 3000 3000 2000 –

额定转矩
MN

Nm 1.5 2.1 2.9 3.8 5.2 6.0 11.2 –

额定电流
IN

A DC 1.4 1.7 1.8 3.6 3.4 4.7 –

额定功率
PN

kW [hp] 0.72
[0.98]

0.88 [1.20] 0.94
[1.28]

1.6
[2.18]

1.9
[2.58]

2.3
[3.13]

–

静止（失
速）转矩
M0

Nm 2.3 2.8 3.6 4.6 6.6 8.6 13.3 –

静止（失
速）电流
I0

A DC 2.1 2.3 2.1 2.2 4.6 4.9 5.6 –
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规格 单位 规格 1，1.5

Nm

规格 2，2.1

Nm

规格 2，2.9

Nm

规格 2，3.8

Nm

规格 3，5.2

Nm

规格 3，6.0

Nm

规格 4，
11.2 Nm

规格 4，
13.0

Nm(1)

峰值转矩
Mmax

Nm 6.1 7.8 10.7 12.7 21.6 29.9 38.6 –

峰值电流
(rms 值)
Imax

A DC 5.7 6.4 17.7 19.8 21.2 –

额定电压 V DC 565–680 ±10%

感应系数
L ph-ph

mH 18.5 26.8 32.6 33.9 11.9 11.4 18.0 –

电阻
R ph-ph

Ω 9.01 7.78 8.61 8.64 2.35 2.10 2.26 –

电压常量
EMK

V/krpm 70.6 80.9 111.0 132.0 92.7 112.0 158.8 –

转矩常数
Kt

Nm/A 1.10 1.26 1.72 2.04 1.22 1.51 1.82 –

惯量 Kgm2 0.000085 0.00015 0.00021 0.00027 0.00062 0.00091 0.0024 –

保护措施 – 过载、短路和接地故障保护。

昀大输出
频率

Hz 590

主轴直径 mm
[inch]

14 [0.55] 19 [0.75] 24 [0.94] 32 [1.26]

极对 – 4 5

法兰规格 mm
[inch]

76 [2.99] 84 [3.31] 108 [4.25] 138 [5.43]

功能安全 – STO

冷却 – 通过法兰

安装方式 – 通过法兰

重量 kg
[lbs]

3.5 [7.7] 4.0 [8.8] 5.0
[11.0]

6.0
[13.2]

8.3
[18.3]

10.0
[22.0]

13.8
[30.4]

–

1 准备中
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11.2.2 带制动器的 ISD 510 伺服驱动器特性数据

表 122: 带制动器的伺服驱动器特性数据

规格 单位 规格 1，1.5 Nm 规格 2，
2.1 Nm

规格 2，
2.9 Nm

规格 2，
3.8 Nm

规格 3，
5.2 Nm

规格 3，
6.0 Nm

规格 4，11.2

Nm

规格 4，
13.0

Nm(1)

制动惯性 Kgm2 0.0000012 0.0000068 0.000021 0.000072 –

制动重量 kg
[lbs]

0.34 [0.75] 0.63 [1.39] 1.1 [2.42] 2.0 [4.41] –

1 准备中

11.2.3 DSD 510 伺服驱动器的特性数据

表 123: DSD 510 的特性数据

规格 单位 DSD 510

输入

直流回路 V DC 565–680 ±10%

直流回路电容 μF 10

UAUX V DC 24/48 ±10%

UAUX 电流消耗（24 V DC 时） A DC 1

UAUX 电流消耗（48 V DC 时） A DC 0.5

输出

输出相数 – 3

输出电压 V AC VIN PSM

额定电流 IN A DC 12.0 带安装板(1)，8.0 单机版

额定功率 PN kW [hp] 4.4 [5.9] 带安装板

峰值电流 (rms 值) Imax A rms 21.0

额定开关频率 kHz 4/5

可能开关频率 kHz 8/10

8 kHz 开关频率下额定电流和峰值电流的降容 % 62.5

10 kHz 开关频率下额定电流和峰值电流的降容 % 55

保护措施 – 过载、短路和接地故障保护。

昀大输出频率 Hz 590

功能安全 – STO

冷却 – 通过安装表面

安装方式 – 通过底座螺丝安装
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规格 单位 DSD 510

电机连接器的数量 – 1

重量 kg [lbs] 2.85 [6.28]

尺寸

(W x H x D)

mm 107.8 x 330.5 x 84

1 尺寸： 470 x 270 x 10 mm [18.5 x 10.6 x 0.4 inch]

11.2.4 电源模块 (PSM 510) 的特性数据

表 124: PSM 510 的特性数据

定义 单位 功率规格 1 功率规格 2 功率规格 3

输入

主电源输入电压 V AC 400–480 ±10%，3 相（请参阅 5.2 电气环境条件）

输入电流（UMIN 时） A 20 34 50

输入电源 VA 12.5 22 32

UAUX 输入电压 V DC 24/48 ±10%

UAUX 电流消耗（24 V DC 时） A DC 2.0

UAUX 电流消耗（48 V DC 时） A DC 1.0

输出

直流回路电压 V DC 565–680 ±10%

直流回路电容 µF 1800

额定电流 IN A 20 40 60

额定功率 PN kW 10 20 30

峰值功率 Pmax t <3.0 s) kW 20 40 60

内部制动电阻器(1)

峰值功率 Pmax kW 8

额定功率 PN W 150

额定电阻 Ω 15

外部制动电阻器

峰值功率 Pmax kW 60

额定功率 PN kW 7.5

昀小电阻 Ω 10

通用

保护措施 – 过载、短路和接地故障保护
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定义 单位 功率规格 1 功率规格 2 功率规格 3

符合 EN 61800-3 标准的线路滤波器 – 类别 C3

冷却 – 集成式风扇

安装方式 – 使用背部链路连接器采用壁挂式安装在背板上

重量 kg 6

尺寸（宽 x 高 x 深） mm 137.3 x 406.3 x 270

1 可连接外部制动电阻器。

11.2.5 分布式访问模块 (DAM 510) 的特性数据

表 125: DAM 510 的特性数据

定义 单位 功率规格 1 功率规格 2

输入

直流回路 V DC 565–680 ±10%

直流回路电容 µF 660

昀大输入电流 A DC 15 24

UAUX V DC 24/48 ±10%

UAUX 电流消耗（24 V DC 时） A DC 0.5

UAUX 电流消耗（48 V DC 时） A DC 0.3

输出

输出电压 V DC VOUT PSM

输出电流直流回路 A DC 15 25

直流回路峰值电流（rms 值）t <1.0 s Arms 30，持续不到 1 秒 48，持续不到 1 秒

输出电流 UAUX A DC 15

通用

保护措施 – 过载、短路和接地故障保护

冷却 – 自然对流

安装方式 – 使用背部链路连接器采用壁挂式安装在背板上

重量 kg 3.05

尺寸（宽 x 高 x 深） mm 84.3 x 471 x 270
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11.2.6 辅助电容器模块 (ACM 510) 特性数据

表 126: ACM 510 的特性数据

定义 单位 值

直流回路 V DC 565–680 ±10%

直流回路电容 µF 2750

UAUX V DC 24/48 ±10%

UAUX 电流消耗（24 V DC 时） A DC 0.5

UAUX 电流消耗（48 V DC 时） A DC 0.3

冷却 – 自然对流

安装方式 – 使用背部链路连接器采用壁挂式安装在背板上

重量 kg 3.54

尺寸（宽 x 高 x 深） mm 84 x 371 x 270

11.3 尺寸

11.3.1 ISD 510 伺服驱动器法兰尺寸

规格 法兰厚度 [mm]

规格 1，1.5 Nm 7

规格 2，2.1 Nm –

规格 2，2.9 Nm 8

规格 2，3.8 Nm 8

规格 3，5.2 Nm 10.8

规格 3，6.0 Nm 10.8

规格 4，11.2 Nm 13.8

规格 4，13.0 Nm(1) –

1 准备中

11.3.2 ISD 510 伺服驱动器尺寸
所有尺寸都以 mm [in] 表示。
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图解 122: ISD 510 规格 1，1.5 Nm 的尺寸
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图解 123: ISD 510 规格 2，2.1 Nm 的尺寸
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图解 124: ISD 510 规格 2，2.9 Nm 的尺寸
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图解 125: ISD 510 规格 2，3.8 Nm 的尺寸
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图解 126: ISD 510 规格 3，5.2 Nm 的尺寸
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图解 127: ISD 510 规格 3，6.0 Nm 的尺寸
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图解 128: ISD 510 规格 4，11.2 Nm 的尺寸

11.3.3 DSD 510 伺服驱动器的尺寸
所有尺寸都以 mm [in] 表示。
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图解 129: DSD 510 伺服驱动器的尺寸

11.3.4 电源模块 (PSM 510) 尺寸
所有尺寸都以 mm [in] 表示。
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图解 130: PSM 510 的尺寸

11.3.5 分布式访问模块 (DAM 510) 的尺寸
所有尺寸都以 mm [in] 表示。
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图解 131: DAM 510 的尺寸

11.3.6 辅助电容器模块 (ACM 510) 的尺寸
所有尺寸都以 mm [in] 表示。
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图解 132: ACM 510 的尺寸

11.3.7 扩展模块 (EXM 510) 的尺寸
所有尺寸都以 mm [in] 表示。
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图解 133: EXM 510 的尺寸
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11.4 电机过载保护

注 意

内部电机过载保护功能以电机满负荷电流的 105% 工作。

指导具有标称电机电流（电机技术标签上的满负荷电流）的 DSD 510 正确使用保护功能。

DSD 510 在实际设置为电流设置的以下倍数的情况下集成了内部过载保护功能：

表 127: 电流设置的倍数

电流设置的倍数 昀长跳闸时间

7.2 20 秒

1.5 8 分钟

1.2 2 小时

11.5 电机温度过高保护
实施的内部电机过载保护功能不具有热存储器保持或速度敏感性。

注 意

DSD 510 中未集成内部电机温度过高保护功能，因此需要电机温度过高感应。DSD 510 具有用于连接电机温度传感器的
输入。

ISD 510 中集成了一个温度传感器。

注 意

在热敏电阻和电机绕组之间使用具有加强绝缘功能的电机（在 4300 V 直流和 8000 Vpeak 脉冲下经过测试）。

11.6 混合电缆保护
辅助 24/48 V 线路具有 3 个保护等级：

软件（秒定时范围）： 如果出现过载 (>15 A)，控制板将打开 24/48 V 辅助线路。

硬件（微秒定时范围）： 如果出现大于 36 A 的短路电流，则自动打开。

硬件： 如果前两个保护措施出现故障，则使用 20 A 不可更换的 SMD（ 表面安装器件）型熔断器。

11.7 ISD 510 伺服驱动器轴上的允许作用力

20
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6

6
2

.1
1

图解 134: 允许作用力

组装电机时，以及对于连接轴的任何机械设备，昀大轴向和径向负载不得超过 表 128 中显示的值。轴必须慢慢以恒定方式加
负载： 避免脉冲负载。
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注 意

如果超过昀大允许作用力，轴承可能会永久损坏。

表 128: 昀大负载额定值

电机尺寸 昀大径向作用力 (Fr)，N 昀大轴向作用力 (Fr)，N

规格 1 450 1050

尺寸 2 900 1700

尺寸 3 830 1740

尺寸 4 1940 2200

昀大径向负载额定值基于以下假设：

伺服驱动器以机架尺寸昀长成员的峰值转矩运行。

昀小直径标准安装轴扩展的端部施加完全相反的负载。

标准 99% 可靠性的无限寿命。

安全系数 = 2

11.8 ISD 510/DSD 510 伺服驱动器上的连接器

11.8.1 X1 和 X2： 混合连接器 (M23)
混合电缆为伺服驱动器的每个线路提供了电源（主电源和辅助电源）、通信线路和安全电源。输入和输出连接器连接在伺服驱
动器内部。
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图解 135: X1 公头混合连接器 (M23) 的引脚分配
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图解 136: X2 母头混合连接器 (M23) 的引脚分配

表 129: X1 和 X2 混合连接器 (M23) 的引脚分配

引脚 说明 注释 额定值/参数

A UDC- 负直流电源 工作电压： 565–680 V DC，昀大 778 V

负直流电源（昀大 -15 A/25 A)

B UDC+ 正直流电源 工作电压： 565–680 V DC，昀大 778 V

正直流电源（昀大 15 A/25 A)

C AUX+ 辅助电源 24-48 V DC±10%，15 A

绝对昀大 55 V DC
D AUX- 辅助电源接地

PE PE PE 连接器 15 A

2 STO+ 安全电源 24 V DC ±10%，1 A

3 STO- 安全电源接地

5 TD+ 正以太网传输 符合标准 100BASE-T

6 RD- 正以太网接收

7 TD- 负以太网传输

8 RD+ 负以太网接收

11.8.2 X3： 第 3 方以太网连接器（M8，4 针）
ISD 510/DSD 510 高级伺服驱动器具有一个附加现场总线端口 (X3)，用于连接通过所选择现场总线进行通信的设备。
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图解 137: X3 第 3 个以太网连接器的引脚分配（M8，4 针）
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表 130: X3 第 3 个以太网连接器的引脚分配（M8，4 针）

引脚 说明 注释 额定值/参数

1 TD+ 正以太网传输 符合标准 100BASE-T

2 RD+ 正以太网接收

3 RD- 负以太网接收

4 TD- 负以太网传输

11.8.3 X4： I/O 和/或编码器连接器（M12，8 针）
ISD 510/DSD 510 高级伺服驱动器上提供 X4 连接器，可配置为：

数字输出

数字输入

模拟输出

24 V 电源

外部编码器接口（SSI 或 BiSS）
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图解 138: X4 M12 I/O 和/或编码器连接器的引脚分配

表 131: X4 M12 I/O 和/或编码器连接器的引脚分配

引脚 说明 注释 额定值/参数

1 数字输出 24 V 切换作为数字输出或电源 (24 V/150 mA) 额定电压： 24 V ±15%

昀大电流： 150 mA

昀大开关频率： 100 Hz

2 接地 接地隔离 -

3 输入 1 模拟/数字输入 数字输入：

额定电压： 0-24 V

带宽： ≦ 100 kHz

模拟输入

额定电压： 0-10 V

输入阻抗： 5.46 kΩ

带宽： ≦ 25 kHz

4 /SSI CLK 负 SSI/BiSS 时钟输出 SSI：

总线速度： 0.5 Mbit，带 25 米电缆

BiSS：

满足 RS485 规范。

昀大电缆长度（SSI 和 BiSS）： 25 m

5 SSI DAT 正 SSI/BiSS 数据输入

6 SSI CLK 正 SSI/BiSS 时钟输出

7 输入 2 模拟/数字输入 数字输入：

额定电压： 0-24 V

带宽： ≦ 100 kHz
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引脚 说明 注释 额定值/参数

模拟输入

额定电压： 0-10 V

输入阻抗： 5.46 kΩ

带宽： ≦ 25 kHz

8 /SSI DAT 负 SSI/BiSS 数据输入 SSI：

总线速度： 0.5 Mbit，带 25 米电缆

BiSS：

满足 RS485 规范。

昀大电缆长度（SSI 和 BiSS）： 25 m

11.8.4 X5： LCP 连接器（M8，6 芯）
X5 连接器用于通过电缆将 LCP 直接连接至 ISD 510/DSD 510 高级伺服驱动器。
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图解 139: X5 LCP 连接器的引脚分配（M8，6 针）

表 132: X5 LCP 连接器的引脚分配

引脚 说明 注释 额定值/参数

1 未连接 – –

2 /LCP RST 复位 ≦0.5 V 时激活

3 LCP RS485 RS485 正电平信号 速度：

38.4 kBd

该级别满足 RS485 规范。
4 /LCP RS485 RS485 负电平信号

5 GND GND –

6 VCC 用于 LCP 的 5 V 电源 120 mA 昀大负载下为 5 V ±10%

11.8.5 X6： 标准/HIPERFACE DSL 电机连接器
标准/HIPERFACE DSL 电机连接器是一个 M23 母接头。
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图解 140: X6 电机连接器的引脚分配
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表 133: X6 电机连接器的引脚分配

引脚 说明 注释 额定值/参数

1 U 电动机 U 相 额定电压： 400–480 V ±10%（参见 11.2.3 DSD 510 伺服驱动器的特性
数据）

导体横截面积： 2.5 mm2
PE PE 保护性接地

3 W 电动机 W 相

4 V 电动机 V 相

A Brake+ 用于连接电机的机械制动（如
果有）。

额定电压： 24 V

昀大（峰值）电压： 48 V ±10%

导体横截面积： 0.75 mm2
B Brake–

C Data–(1) HIPERFACE DSL 负电平线路 –

D Data+(1) HIPERFACE DSL 正电平线路 –

1 Data+/– 信号仅存在于 HIPERFACE DSL 型号上，其他两个不连接。

11.8.6 X7： 电机反馈连接器
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图解 141: X7 电机反馈连接器的引脚分配

表 134: X7 电机反馈连接器的引脚分配

引脚 说明 旋变 BISS B HIPERFACE EnDat 2.1 和 2.2 额定值/参数

1 RESSIN X – X (1) 旋变正电平正弦输入

2 GND – X X X GND

3 RESCOS X – X (1) 旋变正电平余弦输入

4 VEE – X X X +5/11 V(2)

5 RXTX – X X X 编码器正电平数据信号

6 \RESSY X – – – 旋变负电平激励器输出

7 TEMP+ X X X X 电机温度传感器输入

8 ENC_CLK – X – – 编码器正电平时钟信号

9 \RESSIN X – X (1) 旋变负电平正弦输入

10 – – – – – –

11 \RESCOS X – X (1) 旋变负电平余弦输入

12 – – – – – –
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引脚 说明 旋变 BISS B HIPERFACE EnDat 2.1 和 2.2 额定值/参数

13 \RXTX – X X X 编码器负电平数据信号

14 TEMP– X X X X 电机温度传感器输入

15 \ENC_CLK – X – – 编码器负电平时钟信号

16 – – – – – –

17 RESSY X – – – 旋变正电平激励器输出

1 正弦和余弦信号对于 EnDat 是可选的

2 电源自动在 5 V 和 11 V 之间切换，具体取决于所选的反馈类型。

11.9 系统模块上的连接器

11.9.1 背部链路连接器
背部链路连接器位于所有 ISD 510 系统模块的背部顶部。
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图解 142: 背部链路连接器的引脚分配

表 135: 背部链路连接器的引脚分配

引脚 说明

1 24/48 V

2 GND

3 FE： 功能地

4 DC–

5 DC+
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11.9.2 制动连接器
制动连接器位于电源模块 (PSM 510) 上。

11.9.2.1 PSM 510 上的制动电阻器连接器
e

3
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b
g

4
5

0
.1

0

图解 143: PSM 510 上的制动连接器

表 136: PSM 510 上制动连接器的引脚分配

引脚（从左至右） 说明 注释 额定值

1 DC+/R+ 用于连接制动电阻器。 额定电压： 560–800 V DC

昀大制动电流： 80 A

导体横截面积范围： 0.75–16 mm2 (AWG 18–AWG 4)
2 R–

注 意

制动电缆的昀大长度为 30 米（屏蔽）。

11.9.3 以太网连接器
以太网连接器位于所有系统模块上。
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图解 144: 以太网连接器

注 意

只能将 PELV 电势连接到数字输入和输出端。

11.9.3.1 PSM 510 和 ACM 510 上的以太网连接器

表 137: PSM 510 和 ACM 510 上的以太网连接器

连接器名称 说明 引脚 额定值

X1 IN 以太网输入端 1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

符合标准 100BASE-T。

X2 OUT 以太网输出端 1
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11.9.3.2 DAM 510 上的以太网连接器

表 138: DAM 510 上的以太网连接器

连接器名称 说明 引脚 额定值

X1 IN 以太网输入端 1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

符合标准 100BASE-T。

X2 OUT 以太网输出端 1（连接至混合电缆）

X3 OUT 以太网输出端 2

11.9.4 I/O 连接器

11.9.4.1 PSM 510/ACM 510 上的 I/O 连接器

1 2 3 4

e3
0b

g4
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1

图解 145: PSM 510 (I/O PSM) 和 ACM 510 (I/O ACM) 上的 I/O 连接器

表 139: PSM 510/ACM 510 上 I/O 连接器的引脚分配

引脚 说明 注释 额定值/参数

1 DIN1– 数字输入 输入电压： 0–30 V DC

高（逻辑 "1"）电压： 15–30 V DC

低（逻辑 "0"）电压： <5 V DC

昀大输入信号频率： 50 Hz

48 V 时的昀大输入电流： 11 mA

昀大输入电阻： 4.5 KΩ

2 DIN1+

3 DIG_OUT– 数字输出 端子间的昀大电压： 24 V DC 或 AC

昀大电流： 1 A

昀大输出开关频率： 50 Hz
4 DIG_OUT+

导体横截面积范围为 0.2–1.5 mm2 (AWG 24–AWG 16)。

注 意

只能将 PELV 电势连接到数字输入和输出端。

11.9.5 UAUX 连接器
UAUX 连接器位于电源模块 (PSM 510) 上。
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图解 146: UAUX 连接器

表 140: UAUX 连接器的引脚分配

引脚

（从左至
右）

说明 注释 额定值/参数

1 24 V
AUX

用于为电源模块 (PSM 510) 提供
24–48 V 直流输入。

额定输入电压： 24 V/48 V DC ±10%

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 50 A

昀大横截面积： 16 mm2

昀大电缆长度： 3 米

导体横截面积范围为 0.75–16 mm2，实芯或软质 (AWG 18–AWG 4)

2 GND

注 意

只能将 PELV 电势连接到 UAUX 输入端。

11.9.5.1 PSM 510 的 24/48 V 电缆横截面积

符合 CE 标准的昀小电缆横截面积（昀低 70 °C，铜芯） 16 mm2

符合 UL 标准的昀小电缆横截面积（昀低 60 °C，铜芯） 4 AWG

11.9.6 LCP 连接器（M8，6 芯）
LCP 连接器位于系统模块正面。它用于通过电缆直接连接 LCP。
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图解 147: LCP 连接器（M8，6 芯）

表 141: LCP 连接器的引脚分配

引脚 说明 注释 额定值/参数

1 未连接 – –

2 /LCP RST 复位 ≦0.5 V 时激活

3 LCP RS485 RS485 正电平信号 速度：

38.4 kBd
4 /LCP RS485 RS485 负电平信号
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引脚 说明 注释 额定值/参数

该级别满足 RS485 规范。

5 GND GND –

6 VCC 用于 LCP 的 5 V 电源 120 mA 昀大负载下为 5 V ±10%

注 意

只能将 PELV 电势连接到 LCP 输入端。

11.9.7 交流主电源连接器
交流主电源连接器位于电源模块 (PSM 510) 的底部。
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图解 148: 交流主电源连接器

表 142: 交流主电源连接器的引脚分配

引脚

（从左至右）

说明 注释 额定值/参数

1 L3 用于连接 L1/L2/L3 额定电压： 400–480 V AC ±10%

额定功率： 30 kW

昀大横截面积： 16 mm2 (AWG 4)

导体横截面积范围为 0.75–16 mm2，实芯或软质 (AWG 18–AWG 4)

2 L2

3 L1

11.9.7.1 PSM 510 的电源电缆横截面积

表 143: PSM 510 的电源电缆横截面积

PSM 510 (10 kW) PSM 510 (20 kW) PSM 510 (30 kW)

符合 CE 标准的昀小电缆横截面积 4 mm2

（昀低 70 °C，铜芯）

16 mm2

（昀低 70 °C，铜芯）

16 mm2

（昀低 90 °C，铜芯）

符合 UL 标准的昀小电缆横截面积 AWG 10

（昀低 60 °C，铜芯）

AWG 6

（昀低 60 °C，铜芯）

AWG 4

（昀低 75 °C，铜芯）

11.9.8 继电器连接器
继电器连接器用于提供由用户定义的反应，分布情况如下所示：

电源模块 PSM 510： 1 个继电器连接器

辅助电容器模块 ACM 510： 1 个继电器连接器

注 意

只能将 PELV 电势连接到继电器输出端。
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11.9.8.1 PSM 510/ACM 510 上的继电器连接器
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图解 149: PSM 510/ACM 510 上的继电器连接器

表 144: PSM 510 (REL PSM) 和 ACM 510 (REL ACM) 上的继电器连接器的引脚分配

引脚 说明 注释 额定值/参数

11 NC 常闭，24 V DC 额定电流： 2 A

导体横截面积范围： 0.2–1.5 mm2 (AWG 24–AWG 16)
12 NO 常开，24 V DC

13 COM 公用

11.9.9 STO 连接器

11.9.9.1 PSM 510 上的 STO 连接器
电源模块 (PSM 510) 上有一个输入和一个输出 STO 连接器。
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图解 150: PSM 510 上的 STO 输出连接器
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图解 151: PSM 510 上的 STO 输入连接器

表 145: PSM 510 上的 STO 连接器的引脚分配

连接器名
称

引脚 说明 注释 额定值/参数

STO PSM 1 STO– 用于将 STO 输出电压连接到其他系统
模块的输入端。

额定电压： 24 V DC ±10%

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 1 A

导体横截面积范围： 0.2–1.5 mm2 (AWG 24–AWG 16)

2 STO+

3 STO– 用于 STO 输入电压。

4 STO+

注 意

只能将 PELV 电势连接到 STO 输入端。

11.9.9.2 DAM 510 上的 STO 连接器

11.9.9.2.1 DAM 510 顶部的 STO 连接器
分布式访问模块 (DAM 510) 顶部有一个输入和一个输出 STO 连接器。
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图解 152: DAM 510 顶部的 STO 输出连接器
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图解 153: DAM 510 顶部的 STO 输入连接器

表 146: DAM 510 顶部的 STO 连接器的引脚分配

连接器名
称

引脚 说明 注释 额定值/参数

STO DAM 1 STO– 用于将 STO 输出电压连接到其他系统
模块的输入端。

额定电压： 24 V DC ±10%

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 1 A

导体横截面积范围： 0.2–1.5 mm2 (AWG 24–AWG 16)

2 STO+

3 STO– 用于 STO 输入电压。

4 STO+

注 意

只能将 PELV 电势连接到 STO 输入端。

11.9.9.2.2 DAM 510 底部的 STO 连接器
分布式访问模块 (DAM 510) 底部有一个输出 STO 连接器。该输出用于混合电缆。
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图解 154: DAM 510 底部的 STO 连接器

表 147: DAM 510 底部的 STO 连接器的引脚分配

连接器名称 引脚

（从左至右）

说明 注释 额定值/参数

STO DAM 1 STO+ 用于从 DAM 至混合电缆的 STO
输出。

额定电压： 24 V DC ±10%

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 1 A

导体横截面积范围： 0.2–1.5 mm2 (AWG 24–AWG 16)

2 STO–
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连接器名称 引脚

（从左至右）

说明 注释 额定值/参数

插头端子紧固力矩： 0.22–0.25 Nm

11.9.10 UDC 连接器
UDC 连接器位于分布式访问模块 (DAM 510) 底部。
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图解 155: UDC 连接器

表 148: UDC 连接器的引脚分配

引脚

（从左至
右）

说明 注释 额定值/参数

1 UDC+ 用于将直流回路电压从分布式访问模块 (DAM 510)
连接到 ISD 线路的混合电缆。

额定电压： 560–800 V DC

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 25 A

导体横截面积范围： 0.2–6 mm2 (AWG 24–AWG 10)

插头端子紧固力矩： 0.5–0.8 Nm

2 UDC–

11.9.11 AUX 连接器
AUX 连接器位于分布式访问模块 (DAM 510) 底部。
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图解 156: AUX 连接器

表 149: AUX 连接器的引脚分配

引脚

（从左
至右）

说明 注释 额定值/参数

1 AUX+

(24/48 V)

用于将 AUX 输出从分布式访问模块
(DAM 510) 连接到伺服驱动器线路的混合
电缆。

额定电压： 24/48 V DC ±10%

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 15 A

导体横截面积范围： 0.2–2.5 mm2 (AWG 24–AWG 12)

插头端子紧固力矩： 0.5–0.6 Nm

2 AUX– (GND)
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注 意

只能将 PELV 电势连接到 AUX 输出端。

11.9.12 外部编码器连接器
该连接器用于将外部编码器连接到 DAM 510。它为 CAM 模式和齿轮模式提供指导值。外部编码器连接器位于分布式访问模块
(DAM 510) 上，如下所示：

DAM 510： E DAM

5 1

69 e3
0b

g4
61

.1
0

图解 157: 外部编码器连接器

表 150: 外部编码器连接器

连接器名称 说明 引脚 额定值/注释

E DAM 用于将外部编码器连接到 DAM 510。 请参阅 表 151。 额定电压： 24 V DC，隔离（请参阅 表 151）

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 150 mA（请参阅 表 151）

满足以下规格：

BISS/SSI

表 151: 外部编码器连接器 (X1/X2) 的引脚分配

引脚 说明 注释

SSI/BiSS

注释

1 24 V 24 V DC ±10%（用于为编码器供电） 昀大电流： 150 mA

2 – – –

3 – – –

4 RS422 RXD 正值数据 总线速度：

SSI： 时钟频率昀高可达 10 Mhz，带 30 米电缆。

BiSS： 满足 RS485 规范。
5 RS422 TXD 正值数据

6 GX 隔离接地。

如果编码器由外部供电，则必须将外部电源的接地
端连接到 GX。

–

7 – – –

8 /RS422 RXD 负值数据 总线速度：

SSI： 0.5 Mbit，带 25 米电缆。

BiSS： 满足 RS485 规范。
9 /RS422 TXD 负值数据

注 意

只能将 PELV 电势连接到外部编码器。
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11.9.13 扩展模块连接器
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图解 158: 扩展模块连接器

表 152: 扩展模块连接器的引脚分配

引脚

（从左
至右）

说明 附注 额定值/参数

1 DC+ 使用 EXM 510 EMC 板上的电缆
扎带对直流电缆进行屏蔽。

额定电压： 560–800 V DC

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 62 A
(1)

导体横截面积范围： 0.75–16 mm2，实芯或软质 (AWG 18–AWG 4)

只能使用无塑料套筒的箍和 CRIMPFOX 16 S。

对 UDC (DC+, DC–) 使用屏蔽导体。

插头端子紧固力矩： 1.7–1.8 Nm

2

3 DC–

4

5 FE（功能
地）

–

6 GND –

7 24/48 V –

1 1 对 EXM 的昀大额定电流为 62 A。在带有 2 个 PSM 510 模块的系统中，2 对 EXM 510 模块可用于实现昀高 124 A 的额定电流。

11.9.13.1 EXM 510 的电缆横截面积

表 153: EXM 510 电缆的昀小电缆横截面积

电缆 CE UL

DC+/DC– 16 mm2（昀低 70 °C，铜线） 6 AWG（昀低 75 °C，铜线）

24 V，功能 PE 16 mm2（昀低 70 °C，铜线） 6 AWG（昀低 90 °C，铜线）(1)

1 如果电缆上测量的电流小于 45 A，则允许昀低 75 °C。

11.10 一般规格和环境数据

11.10.1 ISD 510/DSD 510 伺服驱动器

表 154: ISD 510/DSD 510 的一般规格和环境条件

规格 值

振动测试 随机振动： 7.54 g（每轴 2 小时，符合 EN 60068-2-64）

正弦振动：0.7 g（每轴 2 小时，符合 EN 60068-2-6）

昀高相对湿度 存放/运输： 5–93%（无冷凝）

固定使用： 15–85%（无冷凝）
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规格 值

环境温度 工作： 5–40 °C 标称，55 °C 带降级

运输： -25 至 +70 °C

存放： -25 至 +55 °C

安装海拔 海拔不超过 1000 米无限制。

海拔昀高 2000 米，带降级。

正常电源，3 相 AC 400 V 时，昀高 2000 米，9% 降级。

辐射和抗扰度的 EMC 标准 EN 61800-3

EMC 抗扰度功能安全 EN 61800-5-2 附录 E

污染等级 2

过压类别 III

IP 额定值 请参阅 11.11.1 ISD 510 伺服驱动器的防护等级 和 11.11.2 DSD 510 伺服驱动器的防护等
级。

11.10.2 系统模块

表 155: 系统模块的一般规格和环境条件

规格 值

防护等级 IP20，符合 IEC/EN 60529（连接器除外，它的防护等级为 IP00）。

警 告
电击危险

如果 PSM 510、DAM 510 和 ACM 510 模块未连接到背板，则无法实现 IP20 防护

等级。这可能会导致严重伤亡。

请勿在从背板上拆除模块后接触背板。

振动测试 随机振动： 1.14 g（每轴 2 小时，符合 EN 60068-2-64）

正弦振动： 1.0 g（每轴 2 小时，符合 EN 60068-2-6）

昀高相对湿度 存放/运输： 5–95%（无冷凝）

固定使用： 5–93%（无冷凝）

环境温度范围 工作： 5–40 °C 标称，昀高 55 °C 带降容（参见图解 159）。

运输： -25 至 +55 °C

存放： -25 至 +55 °C

安装海拔 额定电流，海拔不超过 1000 米。

1000–3000 米时，输出电流降容（1% / 100 米）。

不允许在海拔超过 3000 米的位置操作。

辐射和抗扰度的 EMC 标准 EN 61800-3
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规格 值

功能安全的 EMC 抗扰度 EN 61800-5-2 附录 E

符合 EN 60664-1 的污染度 2

符合 EN/IEC 61800-5-1 的过电压类别 III
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图解 159: 降容

11.11 防护等级

11.11.1 ISD 510 伺服驱动器的防护等级
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图解 160: 安装位置

表 156: ISD 510 伺服驱动器的防护等级

伺服驱动器的安装位置（符合 DIN 42 950） IP 等级（符合 EN 60529）

机箱 所有位置 IP65/IP67

不带轴封的轴 IM B5 和 IM V1 IP54

IM V3 IP50

带轴封的轴 IM B5 和 IM V1 IP65

IM V3 IP60

注 意

按照本手册说明安装和连接 ISD 510 伺服驱动器，以便在昀终应用中达到 表 156 中列出的详细等级。

ISD 510 伺服驱动器被 UL 认证为可识别组件。

11.11.2 DSD 510 伺服驱动器的防护等级
所有 DSD 510 型号的防护等级均为 IP65/IP67。
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注 意

按照本手册说明安装和连接 DSD 510 伺服驱动器，以便在昀终应用中达到 IP65/IP67 防护等级。

DSD 510 伺服驱动器被 UL 认证为可识别组件。

11.12 电缆

注 意

请参阅 VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) 设计指南了解电缆尺寸和图纸。

11.12.1 混合电缆 PE

表 157: 混合电缆 PE

物品 说明 横截面积

混合电缆 PE 用于连接从混合电缆到分布式访问模块 (DAM 510) 上的 PE 螺钉的 PE 线缆。 昀大横截面积：

2.5 mm2/4.0 mm2

11.13 存放
在干燥、无尘且低振动 (veff ≦0.2 mm/s) 的位置存放伺服系统。

存放位置不得有腐蚀气体。

避免温度突变。

长期存放

要对电解电容器进行重整，必须将未使用的伺服驱动器和系统组件每年连接到电源一次，以便电容器充电并放电。否则，电容
器会出现永久损坏。
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VLT Servo Drive 系统术语表

A
A 翼 伺服电机轴侧的 A 侧。

ACM 辅助电容器模块。

Automation Studioô Automation Studioô  是 B&R 的注册商标。它是用于 B&R 控制器的集

成软件开发环境。

B
B 侧 带有接插件连接器的伺服驱动器后侧。

B&R 跨国公司，专业生产工厂和流程自动化软件和系统，适合广泛的工业应
用。

BeckhoffÆ BeckhoffÆ 是德国 Beckhoff Automation GmbH 的注册商标，许可证由该

公司授予。

C
CANopenÆ CANopenÆ 是 CAN in Automation e.V. 的注册社区商标。

CE 欧洲测试和认证标志。

CIA DS 402 用于变频器和运动控制的设备子协议。CIAÆ 是 CAN in Automation

e.V. 的注册社区商标。

D
DAM 分布式访问模块

DSD 分布式伺服驱动器

E
EPSG 以太网 POWERLINKÆ 标准化联盟 (Ethernet POWERLINK Standardiza‐

tion Group)。

ETG EtherCATÆ 技术协会 (EtherCAT Technology Group)

EtherCATÆ EtherCATÆ（用于控制自动化技术的以太网 (Ethernet for Control Au‐

tomation Technology)）是一个开放式高性能基于以太网的现场总线系
统。EtherCATÆ 是德国 Beckhoff Automation GmbH 的注册商标和专利

技术，许可证由该公司授予。

I
IGBT 绝缘栅双极晶体管是一个 3 端点半导体设备，主要用作电子开关，效率

高且切换速度快。

IRT 同步实时。

ISD 集成伺服驱动器

ISD 伺服电机 标示 ISD 伺服电机（无驱动器电子元件）。

L
LCP 本地控制面板 (Local control panel)。

M
M12 连接器 ISD 510/DSD 510 伺服驱动器高级版本 B 侧用于连接 I/O 和/或编码器

的连接器 (X4)。
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M23 连接器 ISD 510/DSD 510 伺服驱动器标准版和高级版 B 侧用于连接混合馈电电
缆和环路电缆的连接器（X1 和 X2）。

M8 连接器 ISD 510/DSD 510 伺服驱动器高级版本 B 侧上的全功能实时以太网端口
(X3)。ISD 510/DSD 510 伺服驱动器高级版本 B 侧用于连接 LCP 的连接
器 (X5)。

MSD 多轴伺服驱动器

P
PELV 保护特低电压是一种导致危险电击的风险较低的电压范围内的电压。

PLC 可编程逻辑器是一个用于自动执行电机过程的数字计算机，比如控制装
配线上的机械。

PLCopenÆ PLCopenÆ 是一个注册商标，连同 PLCopenÆ 徽标都由 PLCopenÆ 协会拥

有。PLCopenÆ 是一个独立于生产商和产品的全球性协会，制定了工业控

制编程标准。

POU 程序组织单元。可以是一个程序、功能块或功能。

PSM 电源模块。

PWM 脉冲宽度调制。

R
RCCB 漏电断路器。

RT 实时。

S
SIL 2 安全集成等级 II。

SSI 同步串行接口。

STO Safe Torque Off 功能。激活 STO 后，ISD 510 伺服驱动器将不再能够
产生电机转矩。

T
TwinCATÆ TwinCATÆ 是德国 Beckhoff Automation GmbH 的注册商标，许可证由该

公司授予。它是用于 Beckhoff 生产的控制器的集成软件开发环境。

U
UAUX 辅助电源，为 ISD 510/DSD 510 伺服驱动器的控制电子组件、电源模块

(PSM 510)、分布式访问模块 (DAM 510) 和辅助电容器模块 (ACM 510) 供
电。

V
VLTÆ Servo Toolbox 用于 VLTÆ Servo Drive 系统的参数设置和诊断的 Danfoss 计算机软件

工具。

W
WiresharkÆ WiresharkÆ 是 GNU 通用公共许可证版本 2 中发布的网络协议分析软

件。
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以
以太网 POWERLINKÆ 以太网 POWERLINKÆ 是标准以太网的确定性实时协议。它是一个由以太

网 POWERLINKÆ 标准化联盟 (EPSG) 管理的开放式协议。由奥地利自动

化公司 B&R 于 2001 引入。

冷
冷却 分布式伺服驱动器通过自然对流（无风扇）冷却。DAM 510、ACM 510 和

EXM 510 以外的所有系统模块都由内部风扇冷却。

制
制动 伺服驱动器上的机械夹持制动。

功
功能块 设备功能可通过工程环境软件来访问。

单
单圈编码器 一种绝对值型编码器，在该编码器中，转动一次后的绝对位置保持已知。

反
反馈系统 反馈系统用于测量转子位置。

固
固件 设备中的软件， 在控制板上运行。

多
多圈编码器 一种绝对值型编码器，在该编码器中，多次转动后绝对位置仍保持已知。

夹
夹具组 一种机械装置，例如可用于将传动装置固定到电机主轴上。

安
安全 (STO) 关闭 IGBT 的驱动器组件电压的伺服驱动器安全电路。

安装海拔 在普通海平面以上的安装高度，通常与降容因数有关。

旋
旋变 一种用于伺服电机的反馈装置，通常带有 2 个模拟轨迹（正弦和余弦）。

环
环境温度 伺服系统或组件邻近位置的温度。

环路电缆 带有两个 M23 连接器的两个分布式伺服驱动器之间的混合连接电缆。

现
现场总线 控制器与伺服轴和系统模块之间的通信总线， 一般位于控制器和现场节

点之间。

电
电机主轴 伺服电机 A 侧的旋转轴，通常不带键槽。
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直
直流回路 每个伺服驱动器都有自己的直流回路，由电容器组成。

直流回路电压 由并联的多个伺服驱动器共享的直流电压。

直流电压 直流恒定电压。

示
示波器 示波器是 DDS Toolbox 软件的组成部分，用于诊断。使用它，可绘制出

内部信号。

系
系统模块 该术语包括电源模块 (PSM 510)、分布式访问模块 (DAM 510) 和可选的

辅助电容器模块 (ACM 510)。

轴
轴向力 在轴方向作用于转子轴的力，单位为牛顿。

轴承 伺服电机的滚珠轴承。

连
连接器 (M23) 伺服驱动器混合连接器。

静
静止（伺服驱动器） 电源打开，轴中无故障，且轴上无活动的运动命令。

馈
馈电电缆 分布式访问模块 (DAM 510) 与 ISD 510/DSD 510 伺服驱动器之间的混合

连接电缆。
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